
ก 

การพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ 
ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม 

 
 
 
 
 
 
 
 
 
 
 

ธัณย์สิตา  ศรีเจริญวิโรฒ 
 
 
 
 
 
 
 
 
 
 
 

วิทยานิพนธ์นี้เป็นส่วนหนึ่งของการศึกษาตามหลักสูตรศิลปศาสตรมหาบัณฑิต 
สาขาวิชาเทคโนโลยีการฝึกอบรมเพื่อการพัฒนาทรัพยากรมนุษย์ 

คณะศึกษาศาสตร์ มหาวิทยาลัยบูรพา 
กุมภาพันธ์  2560 

ลิขสิทธิ์เป็นของมหาวิทยาลัยบูรพา 

 





ค 

กิตติกรรมประกาศ 
 
 วิทยานิพนท์ฉบับนี้ ได้รับความกรุณาอย่างยิ่งจาก ดร.วีระพันธ์  พานิชย์  อาจารย์ 
ที่ปรึกษาหลักวิทยานิพนธ์  รองศาสตรจารย์ ดร.ทิพย์เกษร  บุญอ าไพ  อาจารย์ที่ปรึกษาร่วม 
วิทยานิพนธ์  ดร.ดวงพร  ธรรมะ  รองศาสตรจารย์ ดร.สุทธิพงศ์  หกสุวรรณ  กรรมการสอบ 
วิทยานิพนธ์  ที่ได้กรุณาให้ค าแนะน า ข้อคิดเห็น ช่วยเหลือแก้ไขข้อบกพร่องต่าง ๆ เป็นอย่างดียิ่ง 
มาโดยตลอด ผู้วิจัยขอกราบขอบพระคุณอย่างสูง 
 ขอกราบขอบพระคุณท่านผู้เชี่ยวชาญ  ดร.ภูเบศ  เลื่อมใส  หัวหน้าภาควิชานวัตกรรม 
และเทคโนโลยีการศึกษา  ดร.เอกวิทย์  โทปุรินทร์ ดร.นคร  ละลอกน้ า  ดร.ดวงพร  ธรรมะ  
ดร.ธนะวัฒน์  วรรณประภา  อาจารย์ประจ าภาควิชานวัตกรรมและเทคโนโลยีการศึกษา  ที่ได้กรุณา 
สละเวลาช่วยเหลือ ตรวจสอบแก้ไข ให้ค าแนะน า ทั้งในด้านคุณภาพเนื้อหาสาระ และด้านสื่อการสอน  
ให้มีความถูกต้องเหมาะสมจนเสร็จสมบูรณ์ 
 ขอขอบพระคุณผู้บริหารโรงเรียนอ่างศิลาพิทยาคม และผู้เข้ารับการฝึกอบรมทุกท่าน 
ที่เอ้ือเฟื้อข้อมูล สถานที่และอ านวยความสะดวกตลอดการฝึกอบรมและทดลอง ท าให้การอบรม 
ในครั้งนี้ส าเร็จลุล่วงเป็นอย่างดี 
 ขอขอบพระคุณคณาจารย์ในภาคทุกท่านที่ให้ค าแนะน า ค าปรึกษา ที่เป็นประโยชน์ต่อ 
การจัดท าวิทยานิพนธ์ และขอบคุณ เพื่อน ๆ พี่ ๆ ร่วมรุ่นสาขาวิชาเทคโนโลยีการฝึกอบรม 
เพื่อการพัฒนาทรัพยากรมนุษย์ ที่ให้ความช่วยเหลือและให้ก าลังใจด้วยดีมาตลอด 
 ท้ายนี้ผู้วิจัยใคร่ขอกราบน้อมระลึกถึงพระคุณบิดา มารดา ซึ่งสนับสนุนในด้านการเงิน 
และให้ก าลังใจแก่ผู้วิจัยเสมอมาจนส าเร็จการศึกษา 

 
ธัณย์สิตา  ศรีเจริญวิโรฒ 

 
 
 
 
 
 
 
 

 



ง 

54921099: สาขาวิชาเทคโนโลยีการฝึกอบรมเพื่อการพัฒนาทรัพยากรมนุษย์ 
ค าส าคัญ: บทเรียนอิเล็กทรอนิกส์/ การฝึกอบรม/ การสร้างหนังสืออิเล็กทรอนิกส์/ 
 โรงเรียนอ่างศิลาพิทยาคม 
 ธัณย์สิตา  ศรีเจริญวิโรฒ: การพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม  
เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม (DEVELOPMENT OF 
E-LEARNING FOR TRAINING THE CREATION OF ELECTRONIC BOOKS ANG SILA 
HIGH SCHOOL TEACHERS) คณะกรรมการควบคุมวิทยานิพนธ์: วีระพันธ์  พานิชย์, ปร.ด.,  
ทิพย์เกสร  บุญอ าไพ, ค.ด. 112 หน้า. ปี พ.ศ. 2560. 
 
 การวิจัยครั้งนี้มีวัตถุประสงค์ 1) เพื่อพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง  
การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม ให้มีประสิทธิภาพตามเกณฑ์  
E1/ E2 เท่ากับ 80/ 80  2) เพื่อเปรียบเทียบผลสัมฤทธิ์ก่อนการอบรมและหลังการอบรมจากการอบรม 
บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียน
อ่างศิลาพิทยาคม  และ  3) เพื่อศึกษาความพึงพอใจของครูที่มีต่อบทเรียนอิเล็กทรอนิกส์ 
เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ เพื่อศึกษาความพึงพอใจของครูโรงเรียน 
อ่างศิลาพิทยาคม ที่มีต่อการใช้บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม กลุ่มตัวอย่างที่ใช้ในการวิจัย 
ได้มาจากการเลือกแบบเจาะจงครูโรงเรียนอ่างศิลาพิทยาคม จ านวน 32 คน เคร่ืองมือที่ใช้ในการวิจัย 
ได้แก่ บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม แบบทดสอบ แบบประเมินความพึงพอใจ สถิติที่ใช้ 
ในการวิเคราะห์ข้อมูล ได้แก่ การทดสอบประสิทธิภาพ E1/ E2  คะแนนเฉลี่ย ความเบี่ยงเบน
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 The purposes of the research were, 1) to develop of e-learning for training the  
creation of electronic book Angsilapittayakom school teachers to meet the 80/80 efficiency 
criteria. 2) to compare achievement of the training from e-learning for training the creation of 
electronic book. 3) to study the teacher satisfaction towards e-learning for training the creation of 
electronic book. The sample consisted 32 teachers at Angsilapittayakom school. The research 
instruments were e-learning for training, test and the satisfaction questionnaire. The statistics used 
for analyzing the data were mean, standard deviation, E1/ E2 and t-test dependent.  
 The findings were as follows:  1) The efficiency of the e-learning for training was at 
80.25/ 84.63 higher than 80/ 80 standard.  2) The achievement after training with e-learning for 
training the creation of electronic book was higher than before the training at the .05 level.  
3) The teachers at Angsilapittayakom expressed positive satisfaction on the e-learning for training  
with the very high level ( X = 4.50). 
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บทที ่1 
บทน า 

 

ความเป็นมาและความส าคัญของปัญหา 
 ประเทศไทยมีการนําเอาระบบคอมพิวเตอร์เข้ามาใช้ในระบบงานต่าง ๆ อย่างกว้างขวาง  
ในช่วงระยะสิบกว่าปีที่ผ่านมา คอมพิวเตอร์เร่ิมกลายเป็นส่วนหน่ึงของชีวิตผู้คน ปัจจุบันการนําเอา  
ระบบคอมพิวเตอร์มาใช้กับการเรียนการสอนในสถาบันการศึกษา เป็นเพราะกระแสความเจริญก้าวหน้า 
ของเทคโนโลยีที่เรามิอาจต้านทานหรือขัดขืนได้ รวมทั้งผู้นําทางการศึกษาและนโยบายของรัฐ 
ต่างให้ความสําคัญกับเร่ืองระบบคอมพิวเตอร์ อย่างไรก็ตาม การนําคอมพิวเตอร์มาใช้งาน 
ในสถานศึกษาก็อาจมีลักษณะที่ต่าง ๆกันไปทั้งที่ใช้ในการจัดการเรียนการสอนหรือใช้ในงานบริหาร 
การศึกษา (นพดล  อินทร์จันทร์ และพฤกษ์  ศุภเศรษฐศิร,ิ 2553) 
 จากแผนการศึกษาแห่งชาติ ฉบับที่ 10 (พ.ศ. 2545-2559) ได้กําหนดแนวนโยบาย  
เพื่อดําเนินการพัฒนาเทคโนโลยีเพื่อการศึกษา และการพัฒนาประเทศ โดยมีกรอบการดําเนินงาน 
ให้ใช้เทคโนโลยีเพื่อลดความเหลื่อมล้ําและเพิ่มคุณภาพของการศึกษาอย่างทั่วถึงและมีประสิทธิภาพ  
ตลอดจนส่งเสริมและสนับสนุนผู้ใช้และผู้ผลิตเทคโนโลยีเพื่อการศึกษาให้มีจิตสํานึก จรรยาบรรณ  
มีความรับผิดชอบต่อสังคมในการผลิตสื่อเพื่อการศึกษาที่มีคุณภาพ รวมทั้งพัฒนาผู้รับและผู้ใช้ 
เทคโนโลยีเพื่อการศึกษาให้มีความสามารถในการเรียนรู้ด้วยตนเอง สามารถเลือกสรรกลั่นกรอง 
และใช้ข้อมูลข่าวสารจากสื่อต่างๆ (สํานักงานคณะกรรมการการศึกษาแห่งชาติ, 2551 อ้างถึงใน  
สามมิติ  สุขบรรจง, 2554, หน้า 1)  
 การฝึกอบรม นับว่าเป็นเคร่ืองมือที่นิยมนํามาใช้ในการพัฒนาองค์การ และตามที่
แผนพัฒนาเศรษฐกิจและสังคมแห่งชาติ ฉบับที่ 8 (พ.ศ. 2540-2544) ได้กล่าวถึง การพัฒนาประเทศ  
คือ การพัฒนาคนโดยคน เพราะคนเป็นทรัพยากรที่มีค่าสูงสุดขององค์การจําเป็นต้องได้รับการพัฒนา
ให้มีคุณภาพอยู่เสมอ อันเป็นจุดสําคัญที่นําไปสู่การจัดกิจกรรมวิชาการเสริมการเรียนการสอน 
นอกหลักสูตรให้กับนักศึกษา การพัฒนานักศึกษาในแต่ละคณะส่งเสริมด้วยวิธีจัดการฝึกอบรม  
ซึ่งเป็นรูปแบบหรือเทคนิคที่สามารถนํามาใช้ความสามารถตามจุดมุ่งหมายที่กําหนดไว้ในหลักสูตร 
และเป็นบัณฑิตที่พึงประสงค์ตามที่พระราชบัญญัติการศึกษาแห่งชาต ิพ.ศ. 2542 หมวด 1 มาตรา 6  
และหมวด 24 (4) ได้กล่าวถึงการจัดการศึกษาต้องเป็นไปเพื่อพัฒนาคนไทยให้เป็นมนุษย์ที่สมบูรณ์ 
ทั้งร่างกาย จิตใจ สติปัญญาความรู้ และคุณธรรม มีจริยธรรมและวัฒนธรรมในการดํารงชีวิต  
สามารถอยู่ร่วมกับผู้อ่ืนได้อย่างมีความสุข จึงต้องจัดการเรียนการสอน โดยผสมผสานสาระความรู้ 
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ต่าง ๆ อย่างได้สัดส่วนสมดุลกันรวมทั้งปลูกฝังคุณธรรม ค่านิยมที่ดีงาม  และคุณลักษณะ 
อันพึงประสงค์ได้ทุกวิชา ทั้งความรู้ในสาขาวิชาการและวิชาชีพ โดยการพัฒนากระบวนการเรียน 
การสอนและกิจกรรมเสริมต่าง ๆ ที่เสริมสร้างกระบวนการเรียนรู้เร็ว (นุชตรียา  ผลพานิชย์, 2550) 
 วิกฤตการศึกษาในปัจจุบันแสดงให้เห็นชัดเจนว่าจําเป็นต้องมีการปฏิรูปการศึกษา 
ของประเทศทั้งระบบ รวมถึงเร่ืองที่สําคัญที่สุด นั่นคือ การผลิตครู การพัฒนาครูและบุคลากร 
ทางการศึกษาให้มีคุณภาพและประสิทธิภาพมากยิ่งขึ้น (คณะอนุกรรมการกิจการเพื่อการสื่อสาร 
สังคม, 2554) ผู้สอนเป็นผู้มีบทบาทสําคัญในการส่งเสริมการเรียนรู้ของผู้เรียน องค์ประกอบ 
ที่จะพัฒนาการเรียนรู้ของผู้เรียนขึ้นอยู่ที่เทคนิคและวิธีการสอนของผู้สอนที่จะช่วยกระตุ้น ส่งเสริม 
และพัฒนาการเรียนรู้ของผู้เรียนให้งอกงามขึ้น ผู้สอนควรจัดกิจกรรมให้สอดคล้องและเหมาะสม 
กับความต้องการของผู้เรียน โดยหาเทคนิค วิธีการสอนและสื่อแปลกใหม่ ๆ มุ่งให้ผู้เรียนได้ลงมือ 
ปฏิบัติด้วยตนเอง คอยติดตามและให้กําลังใจ พร้อมทั้งเปิดโอกาสให้ผู้เรียนได้มีอิสระในการแสดงออก 
ด้วยการพูด การกระทําตามจินตนาการและความพึงพอใจของผู้เรียน ซึ่งจะช่วยพัฒนาการเรียนรู้ 
ของผู้เรียนได้เป็นอย่างดี แต่ทั้งนี้ ผู้สอนจะต้องมีความสามารถในการวิเคราะห์เนื้อหาวิชา 
ในหลักสูตรเพื่อนําเนื้อหาเหล่านั้นมาแผ่ขยายประเด็นต่าง ๆ จัดทําเป็นสื่อสร้างสรรค์ให้ผู้เรียน 
เกิดความเข้าใจได้ง่ายขึ้น ในการออกแบบและพัฒนาสื่อให้ผู้เรียนเกิดความคิดสร้างสรรค์ได้นั้น  
จะต้องรู้จักสื่อแต่ละประเภทอย่างถ่องแท้ก่อนว่าจะสามารถพัฒนาความคิดสร้างสรรค์ของผู้เรียน 
แต่ละระดับชั้นได้อย่างไร จะต้องเลือกให้เหมาะสมกับวัยของผู้เรียนจึงจะทําให้การเรียนรู้น้ัน 
มีประสิทธิภาพ 
 โดยเฉพาะอย่างยิ่งการจัดกิจกรรมการเรียนการสอนของครูระดับประถมศึกษา 
ในปัจจุบันที่มุ่งเน้นการจัดกิจกรรมการเรียนการสอนในภาคทฤษฎีเป็นหลัก  ซึ่งส่วนใหญ่ 
ใช้สื่อการสอนประกอบ เช่น เอกสารประกอบการสอน ตํารา วารสาร จุลสาร แผ่นพับ โทรทัศน์  
คอมพิวเตอร์ สื่อของจริง เป็นต้น ซึ่งสื่อเหล่านี้ครูผลิตเองยังมีน้อย ขาดการใช้สื่อประกอบการสอน 
ที่ทันสมัยและหลากหลายเท่าที่ควรทําให้กิจกรรมการเรียนการสอนเกิดความน่าเบื่อหน่ายและ 
ไม่บรรลุผลเท่าที่ควร อีกทั้ง การผลิตสื่อการสอนของครูยังมีน้อย เน่ืองจากครูขาดความรู้และทักษะ 
ในการใช้และผลิตสื่อการสอนที่มีความน่าสนใจและสื่อที่กระตุ้นความสนใจให้ผู้เรียนอยากเรียนรู้  
เน่ืองจากครูส่วนใหญ่ยังขาดการฝึกอบรมเกี่ยวกับการใช้และการผลิตสื่อการสอน ขาดการศึกษา 
ค้นคว้าข้อมูล มีภาระงานสอนและภาระงานที่ได้รับมอบหมาย ทําให้ไม่มีเวลาศึกษาหาความรู้ 
เพิ่มเติม (ปิยะตา  ทองประสิทธิ์, 2551) 
 ด้วยเหตุจากสภาพปัญหา และจากการศึกษาแนวคิดในการแก้ปัญหาดังกล่าว ผู้วิจัยจึงได ้
พัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ สําหรับครู 
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โรงเรียนอ่างศิลาพิทยาคม โดยเน้นให้ผู้เข้ารับการฝึกอบรมสามารถเรียนรู้ได้ด้วยตนเองอย่างมี 
ประสิทธิภาพ และสามารถนําเอาเทคโนโลยีสารสนเทศอันทันสมัยมาใช้ปรับปรุงการอบรมที่มี 
ประสิทธิภาพต่อไป 
 

วัตถุประสงค์ของการวิจัย 
 1.  เพื่อพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสือ 
อิเล็กทรอนิกส์ สําหรับครูโรงเรียนอ่างศิลาพิทยาคม ให้มีประสิทธิภาพตามเกณฑ์ E1/ E2 (80/ 80) 
 2.  เพื่อเปรียบเทียบผลสัมฤทธิ์ก่อนการอบรมและหลังการอบรม จากการอบรมบทเรียน 
อิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ สําหรับครูโรงเรียนอ่างศิลา
พิทยาคม 
 3.  เพื่อศึกษาความพึงพอใจของครูที่มีต่อบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง 
การสร้างหนังสืออิเล็กทรอนิกส์  
 

สมมติฐานการวิจัย 
 1.  บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์  
สําหรับครูโรงเรียนอ่างศิลาพิทยาคม มีประสิทธิภาพตามเกณฑ์ E1/ E2 (80/80) 
 2.  ผลสัมฤทธิ์หลังอบรมสูงกว่าก่อนอบรมอย่างมีนัยสําคัญทางสถิติที่ระดับ .05 
 3.  ความพึงพอใจของครูที่มีต่อบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้าง
หนังสืออิเล็กทรอนิกส์ มีความพึงพอใจในระดับดีมาก 
 

ขอบเขตของการวิจัย 
 1.  ประชากรและกลุ่มตัวอย่าง 
  1.1  ประชากรที่ใช้ในการวิจัยคร้ังนี้เป็นครูโรงเรียนอ่างศิลาพิทยาคม จํานวนครู 
ทั้งหมด 55  คน 
  1.2  กลุ่มตัวอย่างที่ใช้ในการวิจัยครั้งน้ี ได้แก่ครูโรงเรียนอ่างศิลาพิทยาคม รวม 32 คน 
ได้มาจากการเลือกแบบเจาะจง (Purposive sampling) โดยจงเจาะเลือกครูจาก 8 กลุ่มสาระวิชา  
กลุ่มสาระวิชาละ 4 คน 
 2.  ตัวแปรที่ใช้ในการวิจัย 
  2.1  ตัวแปรอิสระ (Independent variable) ได้แก่ บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม 
เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ สําหรับครูโรงเรียนอ่างศิลาพิทยาคม 



4 

  2.2  ตัวแปรตาม (Dependent variable) ได้แก่ 
   2.2.1  ผลสัมฤทธิ์การอบรมของครูโรงเรียนอ่างศิลาพิทยาคมที่ใช้สื่อบทเรียน
อิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ 
   2.2.2  ความพึงพอใจของผู้เข้ารับการฝึกอบรมที่มีต่อบทเรียนอิเล็กทรอนิกส์ 
เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ 
 3.  เน้ือหาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ 
สําหรับครูโรงเรียนอ่างศิลาพิทยาคม แบ่งออกเป็น 6 หน่วย ดังนี ้
 เร่ืองที่ 1  แนะนําโปรแกรม Flip album 
 เร่ืองที่ 2  การจัดรูปแบบหนังสือ 
 เร่ืองที่ 3  การแทรกไฟล์ภาพและไฟล์มัลติมีเดีย 
 เร่ืองที่ 4  การปรับแต่งหนังสือ 
 เร่ืองที่ 5  การสร้างแผ่นซีดีเพื่อเผยแพร่ผลงาน 
 4.  ระยะเวลาในการดําเนินการวิจัย เดือนมิถุนายน-ตุลาคม พ.ศ. 2559 
 

นิยามศัพท์เฉพาะ 
 1.  กลุ่มตัวอย่าง หมายถึง ครู โรงเรียนอ่างศิลาพิทยาคมที่เข้ารับการอบรมด้วยบทเรียน 
อิเล็กทรอนิกส์ 
 2.  บทเรียนอิเล็กทรอนิกส์ หมายถึง รูปแบบของการเรียนรู้ด้วยตนเอง โดยอาศัยเครือข่าย 
คอมพิวเตอร์ หรือสื่ออิเล็กทรอนิกส์ในการถ่ายทอดเนื้อหา ประกอบด้วย เนื้อหา สื่อภาพนิ่ง 
ภาพเคลื่อนไหว แบบฝึก แบบทดสอบ 
 3.  หนังสืออิเล็กทรอนิกส์ (E-book) หมายถึง การนําเสนอเน้ือหาในรูปแบบของดิจิตอล 
ที่เป็นขั้นตอนนําเสนอ ผ่านหน้าจอคอมพิวเตอร์เพื่อการเรียนรู้ด้วยตนเอง 
 4.  Moodle หมายถึง โปรแกรมคอมพิวเตอร์ ที่ไม่มีลิขสิทธ์ ใช้เพื่อประกอบกับข้อความ  
ภาพนิ่ง ภาพเคลื่อนไหว เสียง และมีส่วนปฏิสัมพันธ์ของผู้ใช้กับหนังสืออิเล็กทรอนิกส์ LMS 
(Learning management system) 
 5.  Flip album หมายถึง โปรแกรมที่สามารถสร้างหนังสือหรืออัลบั้มภาพต่าง ๆ  
โดยเราสามารถใส่ภาพ, เสียง, คําบรรยายประกอบ สามารถบันทึกเป็นหนังสืออิเล็กทรอนิกส์  
หรือสมุดภาพอิเล็กทรอนิกส์ 
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 6.  ประสิทธิภาพการฝึกอบรม ตามเกณฑ์ E1/ E2 (80/80) หมายถึง  
 80 ตัวแรก แทน ประสิทธิภาพของกระบวนการ หมายถึง คะแนนเฉลี่ยคิดเป็นร้อยละ  
ที่ได้จากการทดสอบย่อย ในระหว่างอบรม 
 80 ตัวที่สอง แทนประสิทธิภาพของผลลัพธ์ หมายถึง คะแนนเฉลี่ยคิดเป็นร้อยละ  
ที่ได้จากการทดสอบหลังอบรม 
 7.  ความพึงพอใจ หมายถึง ความรู้สึกยินดี ความรู้สึกชอบ ความประทับใจ หรือมีเจตนา 
ที่ดีของครูที่มีต่อบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ 
 8.  ผลสัมฤทธิ์การอบรม หมายถึง ระดับความรูข้องครูโรงเรียนอ่างศิลาพิทยาคม เร่ือง 
การสร้างหนังสืออิเล็กทรอนิกส์ โดยวัดจากแบบทดสอบ  
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บทที ่2 
เอกสารและงานวิจัยที่เกี่ยวข้อง 

 
 การวิจัยเร่ืองการพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสือ
อิเล็กทรอนิกส์ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม ผู้วิจัยได้ศึกษาเอกสารและงานวิจัยที่เกี่ยวข้อง 
มาน าเสนอดังนี้ 
 1.  แนวคิดการฝึกอบรม 
 2.  แนวคิดบทเรียนอิเล็กทรอนิกส์ 
 3.  โปรแกรม Moodle, Flip album  
 4.  แนวคิดการหาประสิทธิภาพบทเรียน 
 5.  แนวคิดเกี่ยวกับความพึงพอใจ  
 6.  งานวิจัยที่เกี่ยวข้อง 
 

แนวคิดการฝึกอบรม  
 ความหมายของการฝึกอบรม  
 การฝึกอบรมเป็นกระบวนการที่ส าคัญในการพัฒนาทรัพยากรมนุษย์ หน่วยงานหรือ  
องค์กรต่าง ๆ และเป็นเคร่ืองมือส าคัญในการพัฒนาความรู้ ความสามารถให้กับบุคลากร 
ในหน่วยงาน ส าหรับความหมายของการฝึกอบรมมีผู้ให้ความหมายของการฝึกอบรมไว้ดังนี้  
 บุคลากรหรือทรัพยากรมนุษย์ คือ องค์ประกอบที่ส าคัญมากประการหนึ่งขององค์การ  
ทั้งนี้เพราะการที่องค์การหนึ่ง ๆ จะบรรลุเป้าหมายการด าเนินงานได้นั้น จะต้องอาศัยความร่วมมือ 
ร่วมใจของบุคลากรภายในองค์การนั้น ๆ นอกจากนั้นเมื่อเปรียบเทียบกับปัจจัยอ่ืน ๆ ของการด าเนินงาน  
อันได้แก่ เงิน วัตถุดิบ เคร่ืองจักร การตลาด และการจัดการแล้ว ทรัพยากรมนุษย์ คือ ปัจจัยที่มี 
ความส าคัญที่สุดของการแข่งขันทางธุรกิจ กล่าวคือ หากองค์การต่าง ๆ มีทรัพยากรด้านอ่ืน ๆ  
เหมือนกัน แต่มีผู้ปฏิบัติงานและผู้บริหารต่างกันแล้ว ผลการด าเนินงานย่อมต่างกัน  ดังนั้น 
การฝึกอบรมบุคลากร ซึ่งเป็นเคร่ืองมือชนิดหนึ่งของการพัฒนาองค์การและบุคลากร จึงยิ่งมี 
ความส าคัญมากขึ้นต่อความอยู่รอดและความส าเร็จขององค์การ (ชูชัย  สมิทธิไกร, 2554, หน้า 1) 
 พงศ์ประเสริฐ  หกสุวรรณ (2552, หน้า 6) ให้ความหมายการฝึกอบรมไว้ว่า การฝึกอบรม  
(Training) เป็นกระบวนการใช้กิจกรรมและวิธีการต่าง ๆ เพื่อท าให้ผู้รับการฝึกอบรม เกิดความรู้  
ความเข้าใจ มีทัศนคติที่ถูกต้องเหมาะสม และ/ หรือเกิดทักษะความช านาญเฉพาะเร่ือง และน าไปใช้ 
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ในการปฏิบัติงานเพื่อแก้ปัญหาหรือเพื่อให้การปฏิบัติงานเป็นไปอย่างมีประสิทธิภาพตามวัตถุประสงค์ 
ของหน่วยงาน/ องค์การ 
 เพ็ชรี  รูปะวิเชตร์ (2554, หน้า 7) ให้ความหมายการฝึกอบรมไว้ว่า กระบวนการที่องค์กร 
ได้จัดขึ้นมาหรือด าเนินการ โดยมีวัตถุประสงค์เพื่อเพิ่มพูน ความรู้ ทักษะ ประสบการณ์ ความสามารถ 
ในการท างานของบุคลากร และเพื่อการเปลี่ยนแปลงทัศนคติ พฤติกรรมอันไม่พึงประสงค์ของ 
บุคลากร ทั้งนี้ก็เพื่อให้บุคลากรได้เป็นบุคลากรที่มีคุณภาพ และมีคุณสมบัติที่องค์กรคาดหวังหรือ 
ต้องการ โดยการที่บุคลากรมีคุณสมบัติและคุณภาพนี้จะน ามาองค์กรให้สามารถด าเนินไปอย่างมี 
ประสิทธิภาพ และมีศักยภาพในการแข่งขันต่อไป 
 วิจิตร  อาวะกุล (2540, หน้า 47)  กล่าวว่า การฝึกอบรมเป็นกระบวนการที่ช่วยเพิ่มพูน 
ความถนัด ความรู้ทางธรรมชาติ ทักษะ หรือความช านาญ ความสามารถของบุคคลให้มีเทคนิค
วิชาการในการท างาน เพื่อให้บุคลากรเกิดพฤติกรรมใหม่ หรือเพื่อให้เกิดทักษะในการท างาน  
อย่างใดอย่างหนึ่ง หรืออีกนัยหนึ่ง การฝึกอบรม หมายถึง การพัฒนาหรือฝึกฝนอบรมบุคคลให้ 
เหมาะสมหรือเข้ากับงานหรือการท างาน 
 พัฒนา  สุขประเสริฐ (2541, หน้า 4) ได้กล่าวว่า การฝึกอบรม หมายถึง กระบวนการส าคัญ 
ที่จะช่วยพัฒนาหรือฝึกฝนเจ้าหน้าที่หรือบุคลากรใหม่ที่จะเข้าท างานหรือปฏิบัติงานประจ าอยู่แล้ว 
ในหน่วยงานให้มีความรู้ความสามารถ ทักษะหรือความช านาญ ตลอดจนประสบการณ์ให้เหมาะสม 
กับการท างาน รวมถึงก่อให้เกิดความรู้สึก เช่น ทัศนคติที่ดีต่อการปฏิบัติงานอันจะส่งผลให้บุคลากร 
แต่ละคนในหน่วยงานหรือองค์กรมีความสามารถเฉพาะตัวสูงขึ้น มีประสิทธิภาพในการท างาน 
ร่วมกับผู้อ่ืนได้ดี ท าให้หน่วยงานหรือองค์กรมีประสิทธิภาพที่ดีขึ้น 
 ชูชัย  สมิทธิไกร (2554, หน้า 7) ให้ความหมายการฝึกอบรมไว้ว่า เป็นกระบวนการเรียนรู้ 
ซึ่งถูกจัดขึ้นอย่างเป็นระบบ โดยมีจุดประสงค์เพื่อพัฒนาความรู้ ทักษะ ความสามารถ รวมทั้ง 
ความตระหนักรูแ้ละแรงจูงใจของบุคลากรในองค์การอันจะส่งผลให้บุคลากรเหล่านี้มีเจตคติต่อ 
องค์การ และผลการปฏิบัติงานดีขึ้นกว่าเดิม 
 สุภาณี  เส็งศรี (2543, หน้า 1) การฝึกอบรม หมายถึง กระบวนการเพิ่มความรู้ ความช านาญ  
ความสามารถของบุคคลหรือที่เรียกอีกอย่างว่าเป็นการพัฒนาบุคคล กล่าวได้ว่า การฝึกอบรม ก็คือ  
กระบวนการที่จะส่งเสริมสมรรถภาพของบุคคล ให้สามารถปฏิบัติหน้าที่ได้อย่างมีประสิทธิภาพ 
อันจะส่งผลโดยตรงไปยังผลงานของสถาบัน สังคม ประชาชน 
 ชาญ  สวัสดิ์สาลี (2550, หน้า 11) กล่าวว่า ปัจจุบัน เป็นที่ยอมรับกันโดยทั่วไปว่า 
ในบรรดาปัจจัยทางการบริหารทั้งหลายไม่ว่าจะเป็น คน เงิน วัสดุอุปกรณ์ และการจัดการ ฯลฯ 
“คน” นับว่าเป็นปัจจัยทางการบริหารที่ส าคัญที่สุด เมื่อเปรียบเทียบกับทรัพยากรอ่ืน ๆ แล้วจะเห็น 
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ได้ว่า ทรัพยากรมนุษย์มีความส าคัญและทรงคุณค่ามากกว่าทรัพยากรอ่ืน ๆ ทั้งหมด กล่าวคือ  
ทรัพยากรอ่ืน ๆ เมื่อใช้ไปแล้วย่อมมีการเสื่อมสลาย สึกหรอหรือหมดไปในที่สุด แต่คนหรือ 
ทรัพยากรมนุษย์เป็นสิ่งที่สามารถพัฒนาได้เพิ่มคุณค่าได้และสามารถน ากลับมาใช้ไดอ้ยู่เสมอ ๆ  
อีกทั้งจะยิ่งมีประสิทธิภาพมากขึ้น เพราะ “คน” จะมีการสะสมความรู้ความเข้าใจ ความสามารถ  
ทักษะ และประสบการณ์ที่สามารถ น าไปใช้ปฏิบัติงาน หรือพัฒนางานให้ดีขึ้นได้ 
 ดังนัน้สรุปได้ว่า การฝึกอบรมเป็นกระบวนการพัฒนาความรู้ ความสามารถ และทักษะ 
ให้เกิดความช านาญในการปฏิบัติงาน และการฝึกอบรมเป็นการแสวงหาความรู้ใช้ระยะเวลาสั้น ๆ  
ประหยัดเวลาและค่าใช้จ่าย และหาความรู้เฉพาะเร่ืองที่ต้องการ 
 ความส าคัญของการฝึกอบรม 
 เพ็ชรี  รูปะวิเชตร์ (2554, หน้า 21) ให้ความส าคัญของการฝึกอบรมสรุปไว้ว่า 
 1.  ท าให้องค์กรสามารถด ารงกิจการอยู่ได้ และมีศักยภาพในการแข่งขัน ด้วยปัจจุบัน 
มีผลการเปลี่ยนแปลงเพราะความเจริญของนวัตกรรม เทคโนโลยี ความรู้ใหม่ ๆ ท าให้องค์กร 
ทุกประเภทต้องเข้าสู่ระบบการแข่งขันอย่างหลีกเลี่ยงได้ยาก 
 2.  ท าให้องค์กรเจริญเติบโต มีการขยายการผลิต การตลาดหรือขยายงานด้านต่าง ๆ ออกไป  
ซึ่งองค์กรต้องการบุคลากรที่มีคุณภาพหรือมีคุณสมบัติที่เหมาะสมมาท างาน หรือต้องการให้บุคลากร
ที่องค์กรมีอยู่มีคุณภาพหรือมีคุณสมบัติที่เหมาะสม เพื่อน าพาองค์กรไปสู่ความเจริญเติบโตนั้น ๆ  
ต่อไป 
 3.  ท าให้บุคลากรใหม่และบุคลากรที่ท างานอยู่แล้วในองค์กรได้เข้าใจสภาพการท างาน
ขององค์กรและการเปลี่ยนแปลงของสภาพแวดล้อมทางธุรกิจ  เพื่อรับมือกับสภาพและ 
การเปลี่ยนแปลงนั้น ๆ ได้อย่างเหมาะสมและถูกต้อง 
 4.  ท าให้บุคลากรที่ท างานกับองค์กรในระยะหนึ่ง อาจเป็นระยะเวลาที่นานหรือไม่นาน  
ได้มีความกระตือรือร้น มีแรงจูงใจในการท างาน และมีความรักในองค์กร 
 5.  ด้วยองค์กรมีการเปลี่ยนแปลงไปเร่ือย ๆ ดังนั้นบุคลากรย่อมมีการเปลี่ยนแปลงหน้าที่ 
ต าแหน่งภายใน และเลื่อนต าแหน่งหน้าที่ ดังนั้นการฝึกอบรมจึงมีความส าคัญในการเตรียมบุคลากร 
สู่การเปลี่ยนหน้าที่หรือเปลี่ยนต าแหน่งได้อย่างถูกต้องและเป็นระบบ 
 สรุปได้ว่า การฝึกอบรมมีความส าคัญทั้งต่อหน่วยงานและต่อบุคลากร เพราะช่วยให้ 
หน่วยงาน/ องค์การมีความมั่นคง เจริญก้าวหน้า เพิ่มผลผลิต และเป็นการช่วยสร้างขวัญและก าลังใจ 
ในการท างานให้แก่บุคลากร อีกทั้งพัฒนาบุคลากรให้ทันต่อการเปลี่ยนแปลงของสังคมโลก 
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 องค์กรจ าเป็นอย่างยิ่งที่จะต้องมีการพัฒนาบุคลาการ วิธีการหนึ่งที่ใช้พัฒนาบุคลากรคือ 
การฝึกอบรม เพราะโดยล าพังองค์กรนั้นจะพัฒนาเองไม่ได้ ถ้าขาดบุคลากรที่มีคุณภาพการฝึกอบรม 
จึงมีความส าคัญต่อองค์กรดังต่อไปนี้ (กิตต ิ พัชรวิชญ์, 2544, หน้า 447-448) 
 1.  สร้างความประทับใจให้พนักงานที่เร่ิมท างาน เนื่องจากพนักงานที่บรรจุใหม่เปลี่ยน
สภาพแวดล้อมจากสังคมใหม่ มีเพื่อนใหม่ สถานที่ใหม่ เคร่ืองมือใหม่ และหน้าที่รับผิดชอบมากขึ้น 
ดังนั้นการฝึกอบรมปฐมนิเทศเร่ิมเข้าท างานจึงมีความส าคัญมาก พนักงานใหม่จะมีเจตคติ 
(Attitude) ที่ดีต่อหัวหน้า เพื่อนผู้ร่วมงาน และหน้าที่การงานที่ได้รับมอบหมาย 
 2.  เพิ่มประสิทธิภาพในการท างานให้สูงขึ้น พนักงานที่ท างานอยู่แล้วระยะหนึ่งอาจเกิด
ความเฉื่อยชา เมื่อได้โอกาสเข้ารับฝึกอบรมพบปะแลกเปลี่ยนความคิดเห็นและเพิ่มพูนความรู้จาก
วิทยากรจะเป็นการกระตุ้นให้กระตือรือร้น กระฉับกระเฉงขึ้น 
 3.  เตรียมขยายงานขององค์กร องค์กรต้องมีการพัฒนาขยายเครือข่ายของงานบุคลากร 
ที่มีประสบการณ์ในงานขององค์กรระดับหนึ่งย่อมมีความส าคัญต่อการขยายงานซึ่งองค์กร 
จ าเป็นต้องใช้บุคคลเหล่านี้เป็นผู้น า ดังนั้นองค์กรจึงต้องอบรมบุคลากรไว้รับการขยายงานของ 
องค์กร 
 4.  พัฒนาพนักงานขององค์กรให้ทันกับความก้าวหน้าของเทคโนโลยีประสิทธิภาพ  
ในการผลิตทั้งด้านปริมาณและคุณภาพ เทคโนโลยีใหม่ ๆ มีบทบาทมากขึ้น การน าเทคโนโลยี 
มาใช้กับงานจ าเป็นต้องอบรมพนักงานให้รู้จักใช้อุปกรณ์ที่ทันสมัย 
 5.  สร้างขวัญและก าลังใจให้พนักงานขององค์กรให้เกิดความมั่นคงการท างาน พนักงาน 
ที่ท างานมาระยะหนึ่งมีความรู้ความสามารถเหมาะสมควรได้เลื่อน ปรับเปลี่ยนต าแหน่งที่สูงขึ้น  
การไปรับต าแหน่งใหม่ควรมีการฝึกอบรมเพื่อเตรียมตัวไปด ารงต าแหน่งนั้น 
 6.  เพิ่มพูนวิทยาการที่เป็นประโยชน์กับการพัฒนาคุณภาพชีวิตพนักงานองค์กร องค์กร
ต้องมีการสัมมนา บรรยายพิเศษ เพื่อให้ความรู้ที่จ าเป็นแก่พนักงานในองค์กร 
 7.  ลดงบประมาณค่าวัสดุสูญเปล่า เน่ืองจากความไม่รู้ที่ท าให้เกิดการสูญเสียขององค์กร 
 8.  สร้างความสามัคคีในหมู่พนักงาน การฝึกอบรมเป็นโอกาสที่พนักงานได้พักอยู่ร่วมกัน  
ได้ร่วมกันคิด ร่วมพูด และร่วมท ากิจกรรม สร้างความคุ้นเคยให้พนักงานได้สนิทสนมสามัคคีกัน 
 9.  เป็นวิธีการแห่งประชาธิปไตย บรรยากาศการฝึกอบรมส่งเสริมการท างานร่วมกัน 
สนับสนุนการเป็นผู้น า และผู้ตาม เคารพในเหตุและผลซึ่งกันและกันเพื่อความถูกต้อง 
 10.  เป็นการส่งเสริมการศึกษาตลอดชีวิต (Lift long education) ของบุคคลให้ได้มีโอกาส 
พัฒนาตนเองอยู่ตลอดเวลา 
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 ดังนั้นสรุปได้ว่า ความส าคัญของการฝึกอบรมเป็นกระบวนการส่งเสริมการศึกษาของ
บุคคลต้องเรียนรู้ เพื่อพัฒนาให้เกิดความรู้ ความพร้อม ทักษะความช านาญในงานหรือหน้าที่ 
ที่ได้รับมอบหมาย และยังช่วยให้เกิดการเปลี่ยนแปลงทัศนคติที่ดีต่อองค์กร ปฏิบัติงานให้มี
ประสิทธิภาพสูงขึ้น 
 วัตถุประสงค์ของการฝึกอบรม 
 ในการจัดการฝึกอบรมไม่ว่าจะเป็นการจัดฝึกอบรมเร่ืองใด ๆ ก็ตาม จ าเป็นต้องมี 
การก าหนดวัตถุประสงค์ของการอบรม เพื่อให้บรรลุเป้าหมายที่ก าหนดไว้ ซึ่งมีดังนี้ 
 1.  เพื่อปรับปรุงคุณภาพการท างานให้ดีขึ้น การเข้ารับการฝึกอบรมจะท าให้ได้รับ 
ความรู้และยุทธวิธีการสอนใหม่ ได้แลกเปลี่ยนประสบการณ์ซึ่งกันและกัน  ช่วยให้เกิดความคิด 
ริเร่ิมและมองเห็นแนวทางในการปรับปรุงคุณภาพการปฏิบัติงานของตน 
 2.  เพื่อเป็นการกระตุ้นให้ผู้เข้าฝึกอบรม และผู้ที่เกี่ยวข้องเกิดความกระตือรือร้น 
ในการแสวงหาแนวทางใหม่ ๆ ในการปรับปรุงคุณภาพในการปฏิบัติงาน และการพัฒนาตนเอง 
 3.  เพื่อช่วยให้ผู้เข้าอบรมได้มีโอกาสแลกเปลี่ยนความคิดเห็นซึ่งกันและกัน ช่วยกัน
วางแผน และปรับปรุงวิธีการสอน และวิธีการปฏิบัติงานให้มีประสิทธิภาพยิ่งขึ้น 
 4.  เพื่อให้ผู้เข้าอบรมเกิดเจตคติ ขวัญ และก าลังใจที่ดี เกิดความเชื่อมั่นในตนเอง 
ที่จะปฏิบัติงานให้ได้ผลดีมีประสิทธิภาพ 
 5.  เพื่อพัฒนาบรรยากาศการท างานภายในองค์กรหรือสถานศึกษาให้ดีขึ้น  
เพราะการฝึกอบรมเป็นวิธีการหนึ่งที่จะท าให้สมาชิกมารวมตัวกัน เพื่อศึกษาหาแนวทางแก้ปัญหา 
การปฏิบัติงาน ช่วยพัฒนากระบวนการติดต่อสื่อสารภายในให้มีประสิทธิภาพ 
 โดยทั่วไปแล้ว การฝึกอบรมบุคลากรในองค์การมีวัตถุประสงค์ 3 ประการ ดังต่อไปนี้  
(Wexley & Latham, 1991 อ้างถึงใน ชูชัย  สมิทธิไกร, 2554, หน้า 5-6) 
 1.  เพื่อปรับปรุงระดับความตระหนักรู้ในตนเอง (Self-awareness) ของแต่ละบุคคล  
ความตระหนักรู้ในตนเอง คือ การเรียนรู้เกี่ยวกับตนเอง อันได้แก่ การท าความเข้าใจเกี่ยวกับ 
บทบาทและความรับผิดชอบของตนเองในองค์การ การตระหนักถึงความแตกต่างระหว่างสิ่งที่
ตนเองปฏิบัติจริงและปรัชญาที่ยึดถือ การเข้าใจถึงทัศนะที่ผู้อ่ืนมีต่อตนเอง และการเรียนรู้ว่า 
การกระท าของตนมีผลกระทบต่อผู้อ่ืนอย่างไร เป็นต้น 
 2.  เพื่อเพิ่มพูนทักษะการท างาน (Job skills) ของแต่ละบุคคล โดยอาจเป็นทักษะด้านใด 
ด้านหน่ึงหรือหลายด้านก็ได้ เช่น การใช้เคร่ืองคอมพิวเตอร์ การดูแลรักษาความปลอดภัย 
ในการท างาน หรือการปกครองบัญชาลูกน้อง เป็นต้น 
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 3.  เพื่อเพิ่มพูนแรงจูงใจ (Motivation) ของแต่ละบุคคล อันจะท าให้การปฏิบัติงาน 
เกิดผลดี แม้ว่าบุคคลหนึ่ง ๆ จะมีความรู้และความสามารถในการปฏิบัติงาน แต่หากขาดแรงจูงใจ 
ในการท างานแล้ว บุคคลนั้นก็อาจจะมิได้ใช้ความรู้และความสามารถของตนเองอย่างเต็มที่  
และผลงานก็ย่อมจะไม่มีประสิทธิภาพเท่าที่ควร ดังนั้น การสร้างแรงจูงใจในการท างานจึงเป็นสิ่งที่ 
มีความส าคัญอย่างยิ่งต่อความส าเร็จขององค์การ 
 ดังนั้นสรุปได้ว่า วัตถุประสงค์ของการฝึกอบรม เพื่อพัฒนาวิธีการปฏิบัติงานให้มี
สมรรถภาพสูงขึ้น เพื่อมุ่งพัฒนาการท างานหรือพัฒนาการเรียนการสอน และกระตุ้นให้เกิด 
ความกระตือรือร้นเกิดความสนใจในการปรับปรุงการปฏิบัติงานให้มีประสิทธิภาพมากยิ่งขึ้น 
 ประโยชน์ของการฝึกอบรม 
 พัฒนา  สุขประเสริฐ (2541, หน้า 14) ได้สรุปถึงประโยชน์ของการฝึกอบรมไว้ ดังนี้  
การฝึกอบรมช่วยพัฒนาบุคลากรให้มีคุณภาพสูงขึ้น ในยุคของข้อมูลข่าวสารเทคโนโลยีอันทันสมัย
ที่สภาพแวดล้อมเปลี่ยนแปลงอยู่เสมอและเป็นไปอย่างรวดเร็ว การพัฒนาตนให้เหมาะสมกับงาน 
มีความเหมาะสมกับคนจ าเป็นต้องด าเนินอย่างเป็นระบบและต่อเน่ือง ถึงแม้ว่าการฝึกอบรม 
จะไม่ช่วยแก้ไขปัญหาในการท างานได้ทุกเร่ือง แต่การฝึกอบรมจะจัดอย่างมีเป้าหมายและ 
มีการวางแผนที่ดีก็ช่วยเพิ่มประสิทธิภาพของงานได้ ซึ่งในการวัดหรือประเมินดูได้จากผลผลิต 
ที่เพิ่มขึ้น การลงทุนต่ าลงหรือก าไรที่เพิ่มขึ้น 
 ประโยชน์ต่อหน่วยงานหรือองค์กร ได้แก่ 1) ได้บุคลากร ทีมงานที่มีประสิทธิภาพ  
2) มีบุคลากรที่มีเจตคติที่ดีต่องานและองค์กร  3) บุคลากรรู้ภาระหน้าที่ มีความรับผิดชอบต่องาน  
4) มีบุคลากรที่พร้อมจะปฏิบัติงานอย่างมีประสิทธิภาพ  5) มีบุคลากรที่สามารถปรับปรุง 
การปฏิบัติงานให้ผลดียิ่งขึ้น เพิ่มประสิทธิภาพในการท างานหรือการผลิต ทั้งในด้านปริมาณและ
คุณภาพ  6) มีบุคลากรที่ท างานร่วมกันได้อย่างมีประสิทธิภาพ  7) มีบุคลากรที่พร้อมจะปรับตัว 
ให้เข้ากับการเปลี่ยนแปลงด้านต่าง ๆ ขององค์กร  8) บุคลากรสามารถปฏิบัติงานได้บรรลุผล 
ตามภารกิจและเป้าหมายขององค์กร  9) ช่วยลดภาระของผู้บริหารในการควบคุมงาน เนื่องจาก
บุคลากรมีความเชื่อมั่นปฏิบัติงานเองได้ เป็นการประหยัดเวลา งบประมาณและพลังงาน 
 ดังนั้นสรุปได้ว่า การฝึกอบรมท าให้เกิดประโยชน์ต่อองค์กรและบุคลากรที่เข้ารับ 
ฝึกอบรม ท าให้การท างานมีประสิทธิภาพเพิ่มขึ้น ช่วยลดปัญหาหรือข้อผิดพลาดในการท างานได้ 
สามารถปรับตัวต่อการเปลี่ยนแปลงในด้านต่าง ๆ ทั้งขององค์กรและความเจริญก้าวหน้า 
ทางเทคโนโลยีในปัจจุบัน 
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 องค์ประกอบของการฝึกอบรม 
 พงศ์ประเสริฐ  หกสุวรรณ (2552, หน้า 8) ก าหนดองค์ประกอบของการฝึกอบรม  
6 ประการ ได้แก่  
 1.  คน/ กลุ่มคน องค์ประกอบนี้ครอบคลุม ผู้จัดการฝึกอบรม ผู้เข้ารับการฝึกอบรม
วิทยากร และผู้เกี่ยวข้อง 
 2.  หลักสูตร/ เนื้อหาของการฝึกอบรม 
 3.  กิจกรรม วิธีการและสื่อที่ใช้ในการฝึกอบรม 
 4.  เวลาที่ใช้ในการฝึกอบรม 
 5.  สถานที่จัดฝึกอบรม วัสดุ อุปกรณ์การฝึกอบรม 
 6.  งบประมาณ 
 สรุปได้ว่า องค์ประกอบของการฝึกอบรมครอบคลุมผู้จัด/ ผู้เข้ารับการฝึกอบรม วิทยากร  
หลักสูตร กิจกรรม สื่อ เวลา สถานที่และงบประมาณ 
 

 
 
 
 
 
 
 

 
 
 
 

ภาพที่ 1  องค์ประกอบของการฝึกอบรม 
 
 รูปแบบของการฝึกอบรม 
 การฝึกอบรมแต่ละหลักสูตรย่อมมีรูปแบบการจัดหรือการรวมกลุ่มแตกต่างกันขึ้นอยู่กับว่า  
ตัวของวิทยากรจะน าเสนอในลักษณะใด แก่ผู้เข้าอบรม ซึ่งสามารถแบ่งเป็น 2 ประเภท ได้ดังนี้ 
(วิโรจน ์ ลักขณาอดิศร, 2550, หน้า 72-73) 
 

เวลา 

ในการฝึกอบรม 

การฝึกอบรม 

หลักสูตร 

การฝึกอบรม 

ผู้จัดการฝึกอบรม 

ผู้เข้ารับการฝึกอบรม 

วิทยากร ฯลฯ 

งบประมาณ 

สถานที่ วัสดุอุปกรณ์ 

ในการฝึกอบรม 

 

กิจกรรม 

การฝึกอบรม 
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 1.  การฝึกอบรมแบบ On the job training (OJT) คือ การฝึกการปฏิบัติงานจริง  
โดยมีผู้ช านาญงานนั้นเป็นครูฝึกคอยดูแลการฝึกงานของผู้เข้ารับการฝึกอบรม ซึ่งการฝึกอบรม 
แบบ On the job training จะไม่เน้นการเรียนทฤษฎีมากนัก แต่มุ่งเน้นไปในทางฝึกปฏิบัติ ท าให้ 
การฝึกอบรมแบบนี้มีความสามารถในการสร้างความรู้ความเข้าใจ เหมาะกับการปฏิบัติงานโดยตรง 
เพราะเห็นผลในระยะสั้นค่อนข้างชัดเจน ต้นทุนต่ า  แต่ก็ไม่ควรที่จะให้มีจ านวนผู้เข้ารับ 
การฝึกอบรมมากเกินไป เพราะอาจจะท าให้เกิดการดูแลของผู้ฝึกสอนไม่ทั่วถึง เกิดการบกพร่อง 
ในการปฏิบัติงาน ท าให้ Cost of quality สูงขึ้น และ Productivity ต่ าลงได้ 
 2.  การฝึกอบรมแบบ Off the job training เป็นการฝึกอบรมที่เน้นความรู้ ความเข้าใจ 
โดยการจัดฝึกอบรมอย่างเป็นทางการ ไม่ใช่การเรียนรู้แบบปฏิบัติงานจริง ซึ่งการฝึกอบรมประเภทนี้ 
จะให้ความรู้ผู้เข้าอบรมได้มากกว่าการอบรมแบบ On the job training เพราะผู้เข้าอบรมสามารถ 
เรียนรู้ได้อย่างเต็มที่ แต่อาจจะเกิดปัญหาในเร่ืองของการประยุกต์ใช้ เพราะความรู้เชิงทฤษฎีที่ได้ 
บางคร้ังไม่สามารถน าไปใช้ในการปฏิบัติงานได้ทั้งหมด หากผู้เข้าอบรมไม่มีทักษะในการประยุกต์ 
ความรู้เข้ากับการท างาน หรือมีทัศนคติต่อการฝึกอบรมว่า เป็นการพักผ่อน ผ่อนคลาย ก็จะท าให้ 
การฝึกอบรมนั้นไม่มีประสิทธิผลเท่าที่ควร 
 ประเภทของการฝึกอบรม 
 ประเภทของการฝึกอบรมสามารถจ าแนกได้หลายประเภทขึ้นอยู่กับว่าจะใช้สิ่งใด  
เป็นหลักเกณฑ์ในการพิจารณา ซึ่งนักวิชาการและนักฝึกอบรมได้จัดประเภทของการฝึกอบรมไว้
แตกต่างกัน เช่น อุทัย  หิรัญโต (2530, หน้า 32) ได้จ าแนกประเภทของการฝึกอบรม ดังนี้ 
 1.  การฝึกอบรมปฐมนิเทศ (Introduction or orientation) มีวัตถุประสงค์ต้องการให้ 
ผู้ท างานใหม่เป็นคนท างานที่มีประโยชน์ในระยะเวลาอันสั้นที่สุด การฝึกอบรมปฐมนิเทศจึงมักใช้ 
เวลาไม่มากนักในการให้ความรู้ต่าง ๆ ที่เกี่ยวกับงานในหน้าที่ความรู้เกี่ยวกับหน่วยงานที่ท าสิทธิ 
และหน้าที่ สวัสดิการที่จะได้รับตลอดจนนโยบายขององค์กรว่ามีอย่างไร 
 2.  การฝึกอบรมการท างาน (On the job training) การฝึกอบรมประเภทนี้ อาจเรียกได้ 
หลายอย่าง เช่น การฝึกอบรมทางเทคนิค และการฝึกอบรมการสอนงาน (Job instruction training)  
วัตถุประสงค์ของการฝึกอบรมประเภทนี้ ได้แก่ การสอนและให้ความรู้ ความเข้าใจในการปฏิบัติงาน 
จริง ๆ แก่เจ้าหน้าที่ชั้นเสมียนพนักงานการฝึกอบรมการท างานนี้นิยมใช้กันมากในวงการธุรกิจ  
เพราะเป็นการฝึกอบรมที่สอนให้คนงานท างานได้จริง ๆ โดยการฝึกอบรมกันในโรงงาน จึงมีการเรียน 
การฝึกอบรมประเภทนี้ว่าเป็น Shop training 
 3.  การฝึกอบรมเจ้าหน้าที่ระดับผู้บังคับบัญชา (Supervisory training) โดยทั่วไป 
การบริหารในหน่วยราชการ และองค์การธุรกิจเอกชนจะแบ่งแยกระดับการท างานออกเป็น 3 ระดับ  
คือ การบริหารงานระดับสุดยอด การบริหารระดับสุดยอด การบริหารระดับกลางและการบริหาร 
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ระดับต้น เจ้าหน้าที่ผู้บังคับบัญชาทุกระดับมีหน้าที่ในการมอบหมายงานควบคุมงาน และวินิจ 
สั่งการในเร่ืองส าคัญ ๆ จึงจ าเป็นอย่างยิ่งที่จะต้องได้รับการพัฒนาเป็นอย่างดี การจัดหลักสูตร 
การฝึกอบรมเจ้าหน้าที่ระดับผู้บังคับบัญชา จะต้องจัดให้ตรงกับความต้องการ (Needs) ของผู้รับ 
การฝึกอบรมและขององค์กรนั้น ๆ ซึ่งโดยหลักการแล้วถือว่า ผู้บังคับบัญชามีความต้องการ 
ในเร่ืองส าคัญ 5 ประการ คือ ความรอบรู้งาน ความรอบรู้ในด้านความรับผิดชอบ ความช านาญ 
ในการน าคน หรือการใช้ภาวะผู้น า ความช านาญในด้านการวางแผน ความช านาญในด้านการสอนงาน 
ผู้ใต้บังคับบัญชา 
 4.  การฝึกอบรมเจ้าหน้าที่ระดับนักบริหารหรือเรียกว่า การพัฒนานักบริหาร นักบริหาร  
นักบริหาร หมายถึง บุคคลที่ด ารงต าแหน่งสูงสุดในสายการบังคับบัญชาขององค์กรและเป็นผู้ที่มี 
อ านาจในการวินิจฉัยชี้ขาดในเร่ืองนโยบายส าคัญ ๆ หรืออีกนัยหนึ่ง นักบริหาร หมายถึง บุคคล 
ที่ท างานประสบความส าเร็จโดยอาศัยบุคคลอ่ืน และเป็นบุคคลที่มีวินิจฉัยชี้ขาดปัญหา ทั้งที่เป็น 
ปัญหานโยบาย และปัญหาทางปฏิบัติ เป็นผู้ใช้อ านาจหน้าที่ควบคุมให้มีการปฏิบัติเป็นไปตาม 
วินิจฉัยสั่งการน้ัน ๆ 
 วินัย  ดอนโคตรจันทร์ (2542, หน้า 37-38) กล่าวถึง การจ าแนกประเภทการฝึกอบรม 
ของส านักงานคณะกรรมการการประถมศึกษาแห่งชาติ 3 ประเภท คือ 
 1.  การฝึกอบรมก่อนเข้าท างาน เป็นการฝึกอบรมเพื่อพัฒนาให้บุคคลมีความรู้
ความสามารถเหมาะสมกับงานที่ปฏิบัติ อันเป็นการเตรียมคนก่อนเข้าท างาน 
 2.  การฝึกอบรมปฐมนิเทศ เป็นการอบรมบุคคลที่เข้าใหม่ในหน่วยงาน เช่น บรรจุใหม่ 
ย้ายหรือโอนมาปฏิบัติงานใหม่ เพื่อให้ทราบนโยบาย ผู้บริหารเพื่อนร่วมงานและเร่ืองราวทั่ว ๆ ไป  
ของหน่วยงาน การปฐมนิเทศอาจรวมถึงการฝึกอบรมก่อนการปฏิบัติงานก็ได้ 
 3.  การฝึกอบรมระหว่างการท างาน เป็นการช่วยปรับปรุง พัฒนาความสามารถ 
ในการท างานบุคลากรในโอกาสที่น าเอาเทคโนโลยีและวิธีการใหม่มาใช้ตลอดทั้งมีการโยกย้าย 
เลื่อนขั้นและเลื่อนต าแหน่ง 
 กิตติ  พัชรวิชญ์ (2544, หน้า 451) ได้สรุปไว้ ดังนี้ คือ การฝึกอบรมแบ่งเป็น 2 ประเภท 
 1.  การฝึกอบรมก่อนเข้าท างาน ได้แก่ 
  1.1  การปฐมนิเทศ 
  1.2  การแนะน างาน 
 2.  การฝึกอบรมระหว่างการท างาน ได้แก่ 
  2.1  การฝึกอบรมระหว่างท างาน 
  2.2  การฝึกอบรมนอกที่ท างาน 
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 เข็มทอง  แสวง (2544, หน้า 18-21) สรุปประเภทการฝึกอบรมไว้ 4 ประเภท คือ 
 1.  การฝึกอบรมก่อนเข้าท างาน เป็นการฝึกอบรมเพื่อเตรียมบุคลากรให้สามารถปฏิบัติ
ได้อย่างเหมาะสม ซึ่งฝึกอบรมก่อนเข้าท างาน สามารถด าเนินการโดยหน่วยงานต้นสังกัด  
หรือสถาบันวิชาชีพอ่ืน ๆ ก็ได้ 
 2.  การฝึกอบรมปฐมนิเทศ เป็นการฝึกอบรมบุคคลที่บรรจุใหม่หรือโอนมาปฏิบัติงานใหม่  
เพื่อการต้อนรับ แนะน า ชี้แจงวัตถุประสงค์ เป้าหมายและแนวงานโครงการให้กับบุคลากร 
ในหน่วยงาน 
 3.  การฝึกอบรมหลังเข้าท างาน เป็นการฝึกอบรมบุคลากรหลังได้ปฏิบัติงานในองค์กร
เรียบร้อยแล้ว เพื่อให้บุคลากรมีความรู้ ทักษะและประสบการณ์เพิ่มขึ้น 
 4.  การฝึกอบรมเพื่อเลื่อนต าแหน่งที่สูงขึ้น เป็นการฝึกอบรมที่มุ่งเน้นการเตรียม 
ความพร้อมในการปฏิบัติงาน ให้กับบุคลากรที่ได้รับเลื่อนต าแหน่ง เป็นการสร้างความมั่งคงให้กับ 
องค์กร ซึ่งฝึกอบรมจะมี 2 ลักษณะ คือ การฝึกอบรมเพื่อประเมินเข้าสู่ต าแหน่งและการฝึกอบรม 
เพื่อพัฒนาความรู้ ทักษะประสบการณ์ก่อนเข้ารับต าแหน่งใหม่ 
 สรุปได้ว่า ประเภทการฝึกอบรมจ าแนกตามวัตถุประสงค์ของการฝึกอบรม ซึ่งแยกออกเป็น  
2 ลักษณะ ดังนี้ 
 1.  การฝึกอบรมก่อนเข้าท างานใหม่ เป็นการสร้างความมั่นใจให้แก่บุคลากรก่อนที่จะ
ปฏิบัติงาน เนื่องจากสถาบันการศึกษาไม่สามารถจัดหลักสูตรให้สอดคล้องกับความต้องการของ 
ทุกหน่วยงานได้ หน่วยงานจึงจ าเป็นฝึกอบรมบุคลากรใหม่ให้มีความรู้ความเข้าใจ สามารถ
ปฏิบัติงานได้อย่างเหมาะสม ซึ่งการฝึกอบรมประเภทนี้ ได้แก่ การปฐมนิเทศ การทดลอง  
และการฝึกงาน เป็นต้น 
 2.  การฝึกอบรมหลังจากการเข้าท างานใหม่ เป็นการพัฒนาความรู้ความสามารถ 
ในการปฏิบัติงานให้มีประสิทธิภาพ เกิดประสิทธิผล ได้แก่ การฝึกอบรมเฉพาะเร่ือง การฝึกอบรม 
ก่อนเลื่อนต าแหน่ง เป็นต้น 
 กระบวนการฝึกอบรม  
 เน่ืองจากการพัฒนาบุคลากรถือเป็นหัวใจส าคัญขององค์กร การพัฒนาบุคลากรให้มี
ความรู้ ความสามารถ และมีทักษะในการปฏิบัติงานที่ดี จึงเป็นความจ าเป็นอย่างยิ่ง ดังนั้น ผู้น า
องค์กรจึงต้องด าเนินการพัฒนาบุคลากรอย่าต่อเน่ืองเป็นระบบและมีกระบวนการ ดังมีผู้กล่าวไว้ 
ดังนี้ 
 ส านักงานคณะกรรมการประถมศึกษาแห่งชาติ (2542, หน้า 101-102) ได้เสนอวิธีการ 
ในการพัฒนาบุคลากรไว้ ดังนี้ 
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 1.  การปฐมนิเทศ จัดขึ้นส าหรับผู้ที่เข้ารับราชการใหม่ หรือผู้ปฏิบัติงานให้สามารถ 
ปฏิบัติงานที่ได้รับมอบหมายได้ เร่ืองการปฐมนิเทศ คือ การน าสถานที่ ระเบียบข้อบังคับต่าง ๆ  
การจัดองค์กร การรู้จักผู้ร่วมงาน และแนวทางการปฏิบัติงาน เป็นต้น 
 2.  การอบรม เป็นการปรึกษาหรือ ชี้แจงในการตัดสินใจหรือการวบรวมข้อมูลตั้งแต่ 
3 คนขึ้นไป วิธีการที่ใช้ เช่น การอบรมสัมมนาเพื่อให้ครูได้ศึกษาสภาพปัจจุบัน ปัญหาและ 
ความต้องการการวางแผนในการปฏิบัติงาน การอบรมประจ าเดือนเพื่อชี้แจงการปฏิบัติราชการ 
และเสริมความรู้ต่าง ๆ การอบรมสายชั้นเป็นการพัฒนาความรู้ในแต่ละสายชั้น ส าหรับการอบรม 
 3.  การฝึกอบรม เป็นกระบวนการเพิ่มพูนความรู้ ความสามารถ และทักษะของบุคลากร  
เพื่อให้สามารถท างานได้อย่างมีประสิทธิภาพ ทั้งในสภาพการณ์ปัจจุบันและในอนาคต 
 4.  การอบรมเชิงปฏิบัติการ เป็นการจัดเพื่อเพิ่มพูนความรู้ ความเข้าใจ และเพิ่มความสามารถ
เร่ืองต่าง ๆ ที่บุคลากร มีความต้องการและได้ฝึกปฏิบัติจริง เช่น การอบรมเชิงปฏิบัติการ การใช้ 
คอมพิวเตอร์ในการปฏิบัติงาน เป็นต้น 
 5.  การปฏิบัติจริง เป็นการน าความรู้หรือวิธีการใหม่ ๆ ใหบุ้คลากรที่มีความรู้ 
ความสามารถน าไปทดลองการปฏิบัติจริง แล้วน าผลมาเสนอที่ประชุม เพื่อให้บุคลากรคนอ่ืน 
น าไปปฏิบัติตาม 
 6.  การศึกษาเอกสาร เป็นวิธีพัฒนาความรู้ความสามารถของบุคลากรด้วยการอ่าน 
หนังสือที่เกี่ยวข้อง 
 7.  การจัดท าคู่มือการปฏิบัติงาน เป็นวิธีการพัฒนาความรู้ และขั้นตอนการปฏิบัติของ 
บุคลากรด้วยการจัดท าคู่มือการปฏิบัติงาน ให้บุคลากรในแต่ละงานที่เกี่ยวข้องได้มีไว้ศึกษาและ  
เป็นคู่มือการปฏิบัติงาน 
 8.  การเข้าศึกษาอบรมนอกสังกัด สนับสนุนให้บุคลากรได้เข้าประชุมอบรมในวิชาการ
ต่าง ๆ ในหน่วยงานนอกสังกัดจัดเพิ่มเติมโดยการร่วมออกค่าใช้จ่ายในการอบรม 
 9.  การศึกษาดูงาน เป็นวิธีการพัฒนาความรู้ ความสามารถ และประสบการณ์โดยตรง 
ประหยัดเวลา เป็นที่ชื่นชอบของบุคลากรที่ได้เห็นตัวอย่างผลงาน และให้ความสนใจในการปฏิบัติตาม 
 มหาวิทยาลัยมหาสารคาม (2544, หน้า 156) สรุปกระบวนการพัฒนาบุคลากรของ 
ส านักงานคณะกรรมการการประถมศึกษาแห่งชาติไว้เป็น 4 ขั้นตอน ดังน้ี 
 1.  การหาความจ าเป็นในการพัฒนาบุคลากร หรือปัญหาที่ต้องการแก้ไขโดยวิธีการพัฒนา 
บุคลากร จากการศึกษาผลผลิตขององค์กรศึกษาการปฏิบัติงานของบุคลากรศึกษานโยบายแผนงาน  
และเป้าหมายของงานที่เปลี่ยนแปลงไปจากเดิมว่ามีส่วนใดที่ต้องท าการพัฒนาหรือแก้ไขปัญหา 
 2.  การวางแผนการพัฒนาบุคลากร 
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 3.  การด าเนินการพัฒนาบุคลากร 
 4.  การติดตามประเมินผลการพัฒนาบุคลากร 
 สรุปได้ว่า กระบวนการฝึกอบรมคือกระบวนการ ด าเนินกิจกรรมการจัดการอบรมตั้งแต่  
วิเคราะห์หลักสูตรและผู้เข้าอบรม ก าหนดการอบรม เปิดรับสมัคร ด าเนินการอบรม ประเมินผล  
และสรุปผลของการอบรม 
 

แนวคิดบทเรียนอิเล็กทรอนิกส์ 
 บทเรียนอิเล็กทรอนิกส์ (e-Learning courseware) เป็นสื่อการเรียนการสอนที่ถูก  
ออกแบบให้อยู่ในรูปแบบอิเล็กทรอนิกส์ เพื่อตอบสนองการเรียนการสอนทางไกลผ่านระบบ 
เครือข่ายอินเทอร์เน็ต หรือการเรียนการสอนออนไลน์ (Online) ซึ่งลักษณะการเรียนการสอน 
เป็นการเรียนการสอนที่เน้นผู้เรียนเป็นศูนย์กลางการเรียนรู้ 
 ความหมายของบทเรียนอิเล็กทรอนิกส์ ความหมายของบทเรียนอิเล็กทรอนิกส์ หรือ 
e-Learning courseware มีนักการศึกษาได้ให้ ความหมายไว้หลายทัศนะได้แก่  
 ถนอมพร  เลาหจรัลแสง (2545, หน้า 4-5) ให้ความหมายของ e-Learning courseware  
ไว้ 2 ลักษณะด้วยกัน คือ ความหมายโดยทั่วไป และความหมายเฉพาะเจาะจง ส าหรับความหมาย 
โดยทั่วไปค าว่า e-Learning courseware จะครอบคลุมความหมายที่กว้างมาก กล่าวคือ จะหมายถึง  
การเรียนในลักษณะใดก็ได้ ซึ่งใช้การถ่ายทอดเน้ือหาผ่านทางอุปกรณ์อิเล็กทรอนิกส์  ไม่ว่าจะเป็น  
คอมพิวเตอร์ เครือข่ายอินเทอร์เน็ต อินทราเน็ต เอ็กทราเน็ต ทางสัญญาณโทรทัศน์ หรือสัญญาณ  
ดาวเทียม (Satellite) ก็ได้ ซึ่งเน้ือหาสารสนเทศ อาจอยู่ในรูปแบบการเรียนที่เราคุ้นเคยกันมา  
พอสมควร เช่น คอมพิวเตอร์ช่วยสอน (Computer assisted instruction) การสอนบนเว็บ (Web based  
instruction) การเรียนออนไลน์ (On-line learning) การเรียนทางไกลผ่านดาวเทียม หรืออาจอยู่ใน 
ลักษณะที่ยังไม่ค่อยเป็นที่แพร่หลาย เช่น การเรียนจากวีดีทัศน์ตามอัธยาศัย (Video on-demand)  
เป็นต้น ส าหรับความหมายเฉพาะเจาะจงนั้น หมายถึง การเรียนเนื้อหาหรือสารสนเทศส าหรับ 
การสอนหรือการอบรม ซึ่งใช้การน าเสนอด้วยตัวอักษร ภาพนิ่ง ผสมผสานกับการใช้ภาพเคลื่อนไหว 
วีดีทัศน์และเสียง โดยอาศัยเทคโนโลยีของเว็บ (Web technology) ในการถ่ายทอดเน้ือหา รวมทั้ง 
การใช้ เทคโนโลยีระบบการจัดการคอร์ส (Course management system) ในการบริหารจัดการ 
งานสอนด้านต่าง ๆ เช่น การจัดให้มีเคร่ืองมือการสื่อสารต่าง ๆ เช่น e-mail, Web-board ส าหรับ 
ตั้งค าถาม หรือแลกเปลี่ยนแนวคิดระหว่างผู้เรียนด้วยกัน หรือกับวิทยากร การจัดให้มีแบบทดสอบ 
หลังจากเรียนจบ เพื่อวัดผลการเรียน รวมทั้งการจัดให้มีระบบบันทึก ติดตาม ตรวจสอบและ 
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ประเมินผลการเรียน โดยผู้เรียนที่เรียนจาก e-Learning courseware นี้ส่วนใหญ่แล้วจะศึกษาเน้ือหา 
ในลักษณะออนไลน์ซึ่ง หมายถึง จากเครื่องที่มีการเชื่อมต่อกับระบบเครือข่ายคอมพิวเตอร์ 
 ศูนย์เทคโนโลยีอิเล็กทรอนิกส์และคอมพิวเตอร์แห่งชาติ (2546) ได้ให้ความหมายของ 
e-Learning courseware ว่าเป็นการเรียนรู้ผ่านเครือข่ายคอมพิวเตอร์อินเทอร์เน็ต (Internet) หรือ 
อินทราเน็ต (Intranet) เป็นการเรียนรู้ด้วยตัวเองผู้เรียนจะได้เรียนตามความสามารถและความสนใจ 
ของตน โดยเนื้อหาบทเรียน ซึ่งประกอบด้วย ข้อความ รูปภาพ เสียง วีดีโอ และมัลติมีเดียอื่น ๆ  
จะถูกส่งไปยังผู้เรียนผ่าน Web browser โดยผู้เรียน ผู้สอน และเพื่อนร่วมชั้นเรียนทุกคน สามารถ 
ติดต่อ ปรึกษา แลกเปลี่ยนความคิดเห็นระหว่างกันได้เช่นเดียวกับการเรียนในชั้นเรียนปกติ  
โดยอาศัย เคร่ืองมือการติดต่อสื่อสารที่ทันสมัยจึงเป็นการเรียนส าหรับทุกคนเรียนได้ทุกเวลาและ 
ทุกสถานที ่
 บุปผชาติ  ทัฬหิกรณ์ (2544, หน้า 7-15) ได้ให้ความหมายเกี่ยวกับการเรียนผ่านสื่อ 
อิเล็กทรอนิกส์ไว้ว่า บทเรียนอิเล็กทรอนิกส์ เป็นนวัตกรรมทางการศึกษาที่เปลี่ยนแปลงวิธีที่เรียน  
แบบเดิมเป็นการเรียนที่ใช้เทคโนโลยีที่ก้าวหน้า เช่น อินเทอร์เน็ต อินทราเน็ต ดาวเทียม วีดิโอเทป  
แผ่นซีดี เป็นต้น โดยวิธีเหล่านี้จะใช้ในสถานการณ์การเรียนรู้ที่มีความหมายกว้างขวาง มีความหมาย
รวมถึงการเรียนทางไกล การเรียนผ่านระบบเครือข่าย โดยในสถานการณ์ดังกล่าว  มีสิ่งเหมือนกัน 
ประการหนึ่ง คือ การใช้เทคโนโลยีสื่อสารเป็นสื่อกลางของการเรียน บางคร้ังเน้ือหาการเรียนรู้ 
อาจน ามาสร้างเป็นบทเรียนส าเร็จรูปที่ใช้ซีดีรอมเป็นสื่อกลาง  ไม่จ าเป็นต้องจัดการศึกษา 
ที่ก าหนดเวลาและสถานที่ เสมือนการเปิดประตูของการเรียนรู้ตลอดชีวิตให้กับประชาชน 
 นอกจากนี้การเรียนการสอนโดยใช้บทเรียนอิเล็กทรอนิกส์ (e-Learning courseware)  
เป็นกระบวนการเรียนการสอนรายบุคคลที่อาศัยเครือข่ายอินเตอร์เน็ตส่วนบุคคลหรือสาธารณะ  
ผ่านทางโปรแกรมค้นผ่าน (Web browser) โดยลักษณะการเรียนการสอนไม่ได้เป็นการดาวน์โหลด  
โปรแกรมคอมพิวเตอร์ช่วยสอนลงมาที่เคร่ืองของตนเอง แต่เป็นการเข้าไปในเครือข่ายคอมพิวเตอร์  
เพื่อการศึกษาเนื้อหาความรู้ที่ผู้จัดได้บรรจุในเซิร์ฟเวอร์ โดยที่ผู้จัดสามารถปรับปรุงพัฒนาเนื้อหา  
ให้ทันสมัยได้อย่างรวดเร็วตลอดเวลา (ปรัชญนันท์  นิลสุข, 2547) ซึ่งในปัจจุบันเทคโนโลยี  
คอมพิวเตอร์ และอินเทอร์เน็ตได้พัฒนาเติบโตอย่างรวดเร็ว และได้ก้าวมาเป็นเคร่ืองมือชิ้นส าคัญ 
ที่เปลี่ยนแปลงรูปแบบการเรียนการสอน รวมทั้งการถ่ายทอดความรู้ โดยใช้สื่อการเรียนการสอน 
ที่อยู่บนฐานของเทคโนโลยีเว็บ ส่งผลให้การพัฒนาสื่อการเรียนการสอนได้รับความนิยมอย่างสูง  
สามารถเผยแพร่ได้รวดเร็ว และกว้างไกล ดังที่นักการศึกษาได้ให้ความหมายเกี่ยวกับการสอน 
บนเครือข่าย ไว้หลากหลาย ดังนี้ 
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 กิดานันท์  มลิทอง (2543, หน้า 11) ให้ความหมายเกี่ยวกับการเรียนการสอน โดยใช้ 
บทเรียนอิเล็กทรอนิกส์ว่า เป็นการใช้เว็บในการเรียนการสอน โดยอาจใช้เว็บเพื่อน าเสนอบทเรียน 
ในลักษณะสื่อหลายมิติของวิชาทั้งหมดตามหลักสูตร หรือใช้เพียงการเสนอข้อมูลบางอย่าง 
เพื่อประกอบการสอนก็ได้ รวมทั้งใช้ประโยชน์จากคุณลักษณะต่าง ๆ ของการสื่อสารที่มีอยู่ในระบบ  
อินเทอร์เน็ต เช่น การเขียนโต้ตอบกันทางไปรษณีย์อิเล็กทรอนิกส์และการพูดคุยสดด้วยข้อความ  
และเสียงมาใช้ประกอบด้วยเพื่อให้เกิดประสิทธิภาพสูงสดุ 
 ถนอมพร  เลาหจรัสแสง (2545, หน้า 46) ได้ให้ความหมายของการเรียนการสอนโดยใช้ 
บทเรียนอิเล็กทรอนิกส์ไว้ว่า เป็นการเรียนการสอนผ่านทางเครือข่ายอินเตอร์เน็ต โดยใช้ประโยชน์  
จากบริการบนเครือข่ายที่มีชื่อว่า เวิร์ดไวด์ เว็บ (World wide web) ซึ่งมีข้อได้เปรียบ คือ ผู้เรียน  
สามารถเข้าถึงคอมพิวเตอร์ที่เชื่อมต่อกับเครือข่ายอินเตอร์เน็ตได้ โดยไม่จ าเป็นต้องเข้าชั้นเรียน  
ในเวลาเรียนที่ก าหนดเท่านั้น ซึ่งผู้สอนสามารถท าได้ในลักษณะการจัดการเรียนการสอนแบบ 
ออนไลน์ โดยไม่ต้องมีการเข้าชั้นเรียน ส่วนใหญ่การเรียนการสอนจะเป็นแบบออนไลน์ ในขณะที่  
ยังมีการนัดหมายเข้าชั้นเรียนบ้างหรือการจัดการเรียนการสอนแบบออนไลน์เพื่อเสริมการเรียน 
การสอนในชั้นเรียนปกติก็ได้ 
 Hannum (1988 อ้างถึงใน สุกรี  แวววรรณจิตร, 2545) ได้ให้ความหมายของการเรียน   
การสอนโดยใช้บทเรียนอิเล็กทรอนิกส์ไว้ว่าเป็นการจัดสภาพการเรียนการสอนผ่านระบบ
อินเทอร์เน็ตหรืออินทราเน็ต บนพื้นฐานของหลักและวิธีการออกแบบการเรียนการสอนอย่างมีระบบ 
 Khan (1997 อ้างถึงใน ธนพล  กมลหัตถ์, 2551, หน้า 6) ได้ให้ความหมายของการเรียน  
การสอนโดยใช้บทเรียนอิเล็กทรอนิกส์ ไว้ว่า เป็นการจัดสภาพแวดล้อมการเรียนการสอน 
ที่ประยุกต์ใช้คุณลักษณะของอินเตอร์เน็ต โดยน าทรัพยากรที่มีอยู่ในเวิลด์ไวด์เว็บ มาเป็นสื่อกลาง 
เพื่อส่งเสริมสนับสนุนให้เกิดการเรียนรู้ ในรูปแบบต่าง ๆ ไม่ว่าจะเป็นแหล่งข้อมูลอ้างอิง เอกสาร  
ประกอบการเรียน บทเรียนส าเร็จรูป หรือแม้กระทั่งหลักสูตรวิชา เน่ืองจากเวิร์ดไวด์ เว็บ  
เป็นบริการบนอินเตอร์เน็ตที่มีแหล่งข้อมูลอยู่มากมายและหลายรูปแบบ ทั้งตัวอักษร ภาพนิ่ง  
ภาพเคลื่อนไหว หรือเสียง โดยอาศัยคุณลักษณะของการเชื่อมโยงหลายมิติ (Hypertext) หรือสื่อ 
หลายมิติ (Hypermedia) เพื่อเชื่อมโยงแหล่งข้อมูลที่เกี่ยวข้องไว้ด้วยกัน 
 จากความหมายของบทเรียนอิเล็กทรอนิกส์ (e-Learning courseware) ที่ได้มี นักวิชาการ 
กล่าวไว้ข้างต้นพอสรุปได้ว่า บทเรียนอิเล็กทรอนิกส์(e-Learning courseware) คือ ระบบการเรียน 
การสอนผ่านเครือข่ายอินเตอร์เน็ต ซึ่งผู้เรียนสามารถที่จะเรียนรู้ได้ด้วยตนเอง โดยใช้คอมพิวเตอร์ 
และทรัพยากรในระบบอินเตอร์เน็ตที่ออกแบบการเรียนการสอนอย่างเป็นระบบ เพื่อให้เกิด 
การเรียนรู้โดยไม่จ ากัดเร่ืองเวลาและสถานที่  ซึ่งบทเรียนอิเล็กทรอนิกส์บนเครือข่าย สามารถ 
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น าไปใช้ในการเรียนการสอน โดยน าประโยชน์ของเทคโนโลยีสารสนเทศเพื่อการศึกษา ค้นคว้า 
หาข้อมูล ในการเรียนรู้ด้วยตนเอง ด้วยวิธีการที่หลากหลายและเกิดขึ้นได้ทุกสถานที่ ทุกเวลา  
โดยใช้เทคโนโลยีสื่อสาร สารสนเทศต่าง ๆ และทรัพยากรของอินเตอร์เน็ต มาออกแบบเพื่อการเรียน 
การสอน ซึ่งสื่อต่าง ๆ เหล่านี้สามารถกระตุ้นให้ผู้เรียนสามารถเรียนรู้และแก้ปัญหาได้อย่างอิสระ   
มีลักษณะที่ผู้สอนกบผู้เรียนมีปฏิสัมพันธ์กันผ่านระบบเครือข่ายคอมพิวเตอร์ที่เชื่อมโยงซึ่งกันและกัน 
 องค์ประกอบของบทเรียนอิเล็กทรอนิกส์  
 ถนอมพร  เลาหจรัสแสง (2545, หน้า 30-40) ได้กล่าวถึงการออกแบบพัฒนาบทเรียน 
อิเล็กทรอนิกส์ประกอบไปด้วย 4 องค์ประกอบหลัก ได้แก่ 
 1.  เน้ือหา (Content) เป็นองค์ประกอบที่ส าคัญที่สุดเพื่อให้เน้ือหามีความสมบูรณ์จะต้อง 
มีองค์ประกอบอ่ืน ๆ ที่ส าคัญ ได้แก่ 
  1.1  โฮมเพจหรือเว็บเพจแรกของเว็บไซต์ ซึ่งการออกแบบให้สวยงามและเป็นไปตาม 
หลักของการออกแบบเว็บเพจที่ดี โฮมเพจจะต้องมีองค์ประกอบที่จ าเป็น ดังนี้ 
   1.1.1  ค าประกาศ/ ค าแนะน าการเรียนทาง e-Learning courseware โดยรวม  
   1.1.2  ระบบส าหรับใส่ชื่อผู้เรียนและรหัสลับส าหรับการเข้าใช้ระบบ  
   1.1.3  รายละเอียดเกี่ยวกับโปรแกรมที่จ าเป็นส าหรับการเรียกดูเนื้อหาอย่างสมบูรณ์ 
   1.1.4  ชื่อหน่วยงานและวิธีการติดต่อกับหน่วยงานที่รับผิดชอบ 
   1.1.5  วันที่และเวลาที่ท าการปรับปรุงแก้ไขเว็บไซต์ล่าสุด 
   1.1.6  เคาน์เตอร์เพื่อนับจ านวนผู้เรียนที่เข้ามาเรียน 
  1.2  หน้าแสดงรายชื่อวิชา จะแสดงหลังจากที่ผู้เรียนได้มีการเข้าสู่ระบบแล้ว  
  1.3  เว็บเพจแรกของแต่ละรายวิชา ซึ่งประกอบไปด้วย  
   1.3.1  ค าประกาศ/ ค าแนะน าการเรียนทาง e-Learning courseware เฉพาะรายวิชา  
   1.3.2  รายชื่อผู้สอน  
   1.3.3  รายชื่อผู้เรียน  
   1.3.4  ประมวลรายวิชา  
   1.3.5  ห้องเรียน 
   1.3.6  เว็บเพจสนับสนุนการเรียน  
   1.3.7  ความช่วยเหลือ  
   1.3.8  รายวิชาอื่น ๆ  
   1.3.9  เว็บเพจค าถามค าตอบที่พบบ่อย  
   1.3.10  ลิงค์ไปยังส่วนของการจัดการการสอนด้านอ่ืนๆ  
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   1.3.11  ส าหรับการติดต่อสื่อสารกับผู้อื่น 
   1.3.12  การออกจากระบบ 
 2.  ระบบบริหารจัดการรายวิชา (Course management system) เป็นองค์ประกอบที่ส าคัญ 
เช่นกันส าหรับ e-Learning courseware ได้แก่ การบริหารจัดการรายวิชา ซึ่งเป็นเสมือนระบบ 
ที่รวบรวมเคร่ืองมือซึ่งออกแบบไว้เพื่อให้ความสะดวกแก่ผู้ใช้ในการจัดการเรียนการสอนออนไลน์  
ซึ่งผู้ใช้แบ่งได้เป็น 3 กลุ่ม ไดแ้ก่ผู้สอน (Instructor) ผู้เรียน (Student) และผู้บริหารระบบเครือข่าย  
(Network administrator) 
 3.  โหมดการติดต่อสื่อสาร (Modes of communication) องค์ประกอบส าคัญที่ขาด  
ไม่ได้อีกประการหนึ่งของ e-Learning courseware ก็คือ การจัดให้ผู้เรียนสามารถติดต่อสื่อสารกับ 
ผู้สอน วิทยากรผู้เชี่ยวชาญอ่ืน ๆ รวมทั้งผู้เรียนด้วยกันในลักษณะที่หลากหลาย และสะดวกต่อ 
การใช้งาน ทั้งแบบประสานเวลาและไม่ประสานเวลาซึ่งเคร่ืองมือที่ควรจัดหาให้ผู้เรียน ได้แก่ 
  3.1  การประชุมทางคอมพิวเตอร์ หมายถึง ลักษณะการติดต่อสื่อสารแบบต่างเวลา  
(Asynchronous) เช่น เว็บบอร์ด (Web board) หรือการติดต่อแบบเวลาเดียวกัน เช่น การแชท (Chat)  
หรือในบางระบบอาจจัดให้มีการถ่ายทอดสัญญาณภาพและเสียงสด (Live broadcast) ผ่านทางเว็บ  
เป็นต้น ในการน าไปใช้ด าเนินกิจกรรมการเรียนการสอน ผู้สอนสามารถเปิดสัมมนาในหัวข้อ 
ที่เกี่ยวข้องกับเนื้อหาในบทเรียน ซึ่งอาจอยู่ในรูปของการบรรยาย การสัมภาษณ์ผู้เชี่ยวชาญ 
การเปิดอภิปรายออนไลน์ เป็นต้น 
  3.2  ไปรษณีย์อิเล็กทรอนิกส์ เป็นองค์ประกอบส าคัญเพื่อให้ผู้เรียนสามารถ  
ติดต่อสื่อสารกับผู้สอน หรือผู้เรียนอ่ืน ๆ ในลักษณะรายบุคคล การส่งงานและผลป้อนกลับ 
ให้ผู้เรียน ผู้สอนสามารถใช้ไปรษณีย์อิเล็กทรอนิกส์ในการให้ความคิดเห็นให้ค าแนะน าปรึกษา 
แก่ผู้เรียน รายบุคคลเพื่อกระตุ้นให้ผู้เรียนเกิดความกระตือรือร้นในการเข้าร่วมกิจกรรม 
อย่างต่อเนื่อง  
 4.  แบบฝึกหัด/ แบบทดสอบ เป็นองค์ประกอบสุดท้ายที่จัดให้ผู้เรียนได้มีโอกาสโต้ตอบ  
กับเน้ือหาในรูปแบบของการท าแบบฝึกหัด และแบบทดสอบความรู้ 
 จินตวีร์  คล้ายสังข์ (2554, หน้า 10) ได้กล่าวถึงการออกแบบบทเรียนอิเล็กทรอนิกส์ 
ทางการศึกษา ซึ่งมีรายละเอียด ดังน้ี  
 1.  บทเรียนอิเล็กทรอนิกส์ควรเน้นการใช้วิธีการ กลยุทธ์ และการให้ข้อมูลป้อนกลับ 
แก่ผู้เรียนโดยทันที  
 2.  บทเรียนอิเล็กทรอนิกส์ควรกระตุ้นให้ผู้เรียนเกิดการเรียนรู้ตามวัตถุประสงค์ 
ที่ก าหนดไว้ 
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 3.  บทเรียนอิเล็กทรอนิกส์ควรเปิดโอกาสให้ผู้เรียนสามารถเข้าถึงเนื้อหาได้ตาม 
ความต้องการ  
 4.  บทเรียนอิเล็กทรอนิกส์ ควรมีแบบฝึกหัดหรือแบบทดสอบเพื่อให้ผู้เรียนสามารถ  
ตรวจสอบความเข้าใจ 
 รูปแบบและลักษณะของบทเรียนอิเล็กทรอนิกส์  
 การเรียนการสอนโดยใช้บทเรียนอิเล็กทรอนิกส์สามารถท าได้ในหลายลักษณะ  
โดยในแต่ละเน้ือหาของหลักสูตร มีวิธีการจัดการเรียนการสอนผ่านระบบเครือข่ายที่แตกต่างกัน 
ออกไป ซึ่งในประเด็นน้ีมีนักการศึกษาหลายท่าน ได้กล่าวถึงรูปแบบและลักษณะของบทเรียน 
อิเล็กทรอนิกส์ ดังต่อไปนี้ 
 Parson (1997 อ้างถึงใน กิดานันท์  มลิทอง, 2543) ได้แบ่งประเภทของการเรียนการสอน  
โดยใช้บทเรียนอิเล็กทรอนิกส์ออกเป็น 3 ลักษณะ คือ  
 1.  การเรียนการสอนแบบรายวิชาอย่างเดียว เป็นการเรียนการสอนที่มีเคร่ืองมือและ
แหล่งที่เข้าไปถึงข้อมูลโดยผ่านระบบอินเทอร์เน็ตได้มากที่สุด ลักษณะของเว็บช่วยสอนแบบนี้ 
มีลักษณะเป็นแบบวิทยาเขต ผู้เรียนสามารถเข้ามาศึกษาจากที่ต่าง  ๆ โดยสามารถเล่นผ่านระบบ  
คอมพิวเตอร์สื่อสารได้  
 2.  การเรียนการสอนแบบสนับสนุนรายวิชา เป็นรายวิชาที่มีลักษณะเป็นรูปธรรมที่มี 
การพบปะระหว่างครูกับนักเรียนและมีแหล่งสนับสนุนกิจกรรมการเรียนรู้จ านวนมาก เช่น  
การก าหนด งานที่ให้ท าบนเว็บ การก าหนดให้อ่าน การสื่อสารผ่านระบบคอมพิวเตอร์ หรือการมี 
เว็บที่สามารถ ชี้ต าแหน่งของแหล่งบนพื้นที่ของเว็บไซต์โดยรวมกิจกรรมต่าง ๆ เอาไว้ 
 3.  การเรียนการสอนแบบศูนย์เป็นชนิดของเว็บไซต์ที่มีวัตถุดิบเคร่ืองมือ ซึ่งสามารถ 
รวบรวมรายวิชาขนาดใหญ่เข้าไว้ด้วยกันหรือเป็นแหล่งสนับสนุนกิจกรรมทางการศึกษา  ซึ่งผู้ที่เข้ามา 
ใช้ก็จะมีสื่อให้บริการหลายรูปแบบเช่น เป็นข้อความ เป็นภาพกราฟิก การสื่อสารระหว่างบุคคล 
และการท าภาพเคลื่อนไหวต่าง ๆ เป็นต้น James (1997 อ้างถึงใน กิดานันท์  มลิทอง, 2543) ได้แบ่ง 
ประเภทของการเรียนการสอน โดยใช้บทเรียนอิเล็กทรอนิกส์ออกเป็น 3 ลักษณะคือ  
 1.  โครงสร้างแบบค้นหา (Eclectic structures) ลักษณะของโครงสร้างเว็บไซต์แบบนี้  
เป็นแหล่งของเว็บไซต์ที่ใช้ในการการศึกษา (Web pedagogical resources) เป็นชนิดของเว็บไซต์ 
ที่มีวัตถุดิบเคร่ืองมือ ซึ่งสามารถรวบรวมรายวิชาขนาดใหญ่เข้าไว้ด้วยกันหรือเป็นแหล่งสนับสนุน  
กิจกรรมทางการศึกษา  ซึ่งผู้ที่เข้ามาใช้ก็จะมีสื่อให้บริการหลายรูปแบบ เช่น เป็นข้อความ  
เป็นภาพกราฟิก การสื่อสารระหว่างบุคคล และการท าภาพเคลื่อนไหวต่าง ๆ เป็นต้น การค้นหาไม่มี 
การก าหนดขนาด รูปแบบ ไม่มีโครงสร้างที่ผู้เรียนต้องมีปฏิสัมพันธ์กับเว็บ ลักษณะของเว็บไซต์ 
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แบบนี้ จะมีแต่การให้ใช้เคร่ืองมือในการสืบค้นหรือเพื่อบางสิ่งที่ต้องการค้นหาตามที่ก าหนดหรือ 
ผู้เขียนเว็บไซต์ต้องการ โครงสร้างแบบนี้จะเป็นแบบเปิดให้ผู้เรียนได้เข้ามาค้นคว้าในเนื้อหา 
ในบริบท โดยไม่มีโครงสร้างข้อมูลเฉพาะให้ได้เลือกแต่โครงสร้างแบบนี้จะมีปัญหากับผู้เรียน 
เพราะผู้เรียนอาจจะไม่สนใจข้อมูลที่ไม่มีโครงสร้างโดยไม่ก าหนดแนวทางในการสืบค้น 
 2.  โครงสร้างแบบสารานุกรม (Encyclopedic structures) ลักษณะโครงสร้างของเว็บ 
ที่สร้างขึ้นเองใช้โครงสร้างข้อมูลในแบบต้นไม้ในการเข้าสู่ข้อมูล ซึ่งเหมือนกับหนังสือที่มีเนื้อหา  
และมีการจัดเป็นบทเป็นตอน ซึ่งจะก าหนดให้ผู้เรียนหรือผู้ใช้ได้ผ่านเข้าไปหาข้อมูลหรือเคร่ืองมือ 
ที่อยู่ในพื้นที่ของเว็บหรืออยู่ภายในและนอกเว็บ เว็บไซต์จ านวนมากมีโครงสร้างในลักษณะ
ดังกล่าวนี้ โดยเฉพาะเว็บไซต์ทางการศึกษาที่ต้องรับผิดชอบต่อการเรียนรู้ของผู้เรียน กลวิธีด้าน  
โครงสร้างจึงมีผลต่อการเรียนรู้ของผู้เรียน  
 3.  โครงสร้างแบบการเรียนการสอน (Pedagogic structures) ลักษณะของโครงสร้าง 
มีรูปแบบหลายอย่างในการน ามาสอนตามความต้องการ ซึ่งเป็นที่รู้จักดีในบทบาทของการออกแบบ 
ทางการศึกษาส าหรับคอมพิวเตอร์ช่วยสอนหรือเคร่ืองมือมัลติมีเดีย ซึ่งความจริงมีหลักการแตกต่างกัน 
ระหว่างคอมพิวเตอร์ช่วยสอนกับเว็บช่วยสอนนั้น คือ ความสามารถของ HTML ในการที่จะจัดท า 
ในแบบไฮเปอร์เท็กซ์กับการเข้าถึงข้อมูลหน้าจอโดยผ่านระบบอินเทอร์เน็ต 
 Doherty (1988 อ้างถึงใน กิดานันท์  มลิทอง, 2543) ได้แบ่งประเภทตามลักษณะของ 
การเรียนการสอนโดยใช้บทเรียนอิเล็กทรอนิกส์ออกเป็น 3 ลักษณะ คือ 
 1.  การน าเสนอ (Presentation) ในลักษณะของเว็บไซต์ที่ประกอบไปด้วยข้อความ  
ภาพกราฟิกโดยมีวิธีการน าเสนอ คือ  
  1.1  การน าเสนอแบบสื่อเด่ียว เช่น ข้อความ หรือ รูปภาพ 
  1.2  การน าเสนอแบบสื่อคู่ เช่น ข้อความกับรูปภาพ 
  1.3  การน าเสนอแบบมัลติมีเดีย คือ ประกอบด้วยข้อความ ภาพนิ่ง ภาพเคลื่อนไหว 
เสียง 
 2.  การสื่อสาร (Communication) การสื่อสารเป็นสิ่งจ าเป็นที่จะต้องใช้ทุกวันในชีวิต 
ซึ่งเป็นลักษณะส าคัญของอินเทอร์เน็ต โดยมีการสื่อสารบนอินเทอร์เน็ตหลายแบบ เช่น  
  2.1  การสื่อสารทางเดียว เช่น การดูข้อมูลจากเว็บเพจ 
  2.2  การสื่อสารสองทาง เช่น การส่งไปรษณีย์อิเล็กทรอนิกส์โต้ตอบกัน 
  2.3  การสื่อสารแบบหนึ่งแหล่งไปหลายที่ เป็นการส่งข้อความจากแหล่งเดียว 
แพร่กระจายไปหลายแหล่ง เช่น การอภิปรายจากคนเดียวให้คนอื่น ๆ ได้รับฟังด้วยหรือการประชุม 
ผ่านคอมพิวเตอร์ (Computer conferencing)  
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  2.4  การสื่อสารหลายแหล่งไปสู่หลายแหล่ง เช่น การใช้กระบวนการกลุ่ม 
ในการสื่อสารบนเว็บ โดยมีคนใช้หลายคนและคนรับหลายคนเช่นกัน 
 3.  การท าให้เกิดความสัมพันธ์ (Dynamic interaction) เป็นคุณลักษณะที่ส าคัญของ  
อินเทอร์เน็ตและส าคัญที่สุด ซึ่งมี 3 ลักษณะ คือ 
  3.1  การสืบค้นข้อมูล 
  3.2  การหาวิธีการเข้าสู่เว็บ  
  3.3  การตอบสนองของมนุษย์ต่อการใช้เว็บ  
 Hannum (1988 อ้างถึงใน สุกรี  แวววรรณจิตร, 2545) ได้แบ่งประเภทของการเรียน 
การสอนโดยใช้บทเรียนอิเล็กทรอนิกส์ออกเป็น 4 ลักษณะ ใหญ่ ๆ คือ  
 1.  รูปแบบการเผยแพร่ รูปแบบนี้สามารถแบ่งได้ออกเป็น 3 ชนิด คือ  
  1.1  รูปแบบห้องสมุด (Library model) เป็นรูปแบบที่ใช้ประโยชน์จากความสามารถ  
ในการเข้าไปยังแหล่งทรัพยากรอิเล็กทรอนิกส์ที่มีอยู่หลากหลาย โดยวิธีการจัดหาเน้ือหาให้ผู้เรียน 
ผ่านการเชื่อมโยงไปยังแหล่งเสริมต่าง ๆ เช่น สารานุกรม วารสาร หรือหนังสือออนไลน์ทั้งหลาย  
ซึ่งถือได้ว่า เป็นการน าเอาลักษณะทางกายภาพของห้องสมุดที่มีทรัพยากรจ านวนมหาศาล 
มาประยุกต์ใช้ ส่วนประกอบของรูปแบบนี้ ได้แก่ สารานุกรมออนไลน์ วารสารออนไลน์ หนังสือ  
ออนไลน ์สารบัญการอ่านออนไลน์ (Online reading list) เว็บห้องสมุด เว็บงานวิจัย รวมทั้ง 
การรวบรวมรายชื่อเว็บที่สัมพันธ์กับวิชาต่าง ๆ 
  1.2  รูปแบบหนังสือเรียน (Textbook model) การเรียนการสอนผ่านเว็บรูปแบบนี้  
เป็นการจัดเนื้อหาของหลักสูตรในลักษณะออนไลน์ให้แก่ผู้เรียน เช่น ค าบรรยาย สไลด์ นิยาม  
ค าศัพท์และส่วนเสริมผู้สอนสามารถเตรียมเน้ือหาออนไลน์ที่ใช้เหมือนกับที่ใช้ในการเรียน 
ในชั้นเรียนปกติและสามารถท าส าเนาเอกสารให้กับผู้เรียนได้ รูปแบบนี้ต่างจากรูปแบบห้องสมุด 
คือ รูปแบบนี้จะเตรียมเนื้อหาส าหรับการเรียนการสอนโดยเฉพาะ ขณะที่รูปแบบห้องสมุดช่วยให้ 
ผู้เรียนเข้าถึงเนื้อหาที่ต้องการจากการเชื่อมโยงที่ได้เตรียมเอาไว้ส่วนประกอบของรูปแบบหนังสือ  
เรียนนี้ประกอบด้วยบันทึกของหลักสูตร บันทึกค าบรรยาย ข้อแนะน าของห้องเรียน สไลด์ที่น าเสนอ  
วิดีโอและภาพ ที่ใช้ในชั้นเรียน เอกสารอ่ืนที่มีความสัมพันธ์กับชั้นเรียน เช่น ประมวล รายวิชา  
รายชื่อในชั้น กฎเกณฑ์ข้อตกลงต่าง ๆ ตารางการสอบและตัวอย่างการสอบครั้งที่แล้วความคาดหวัง 
ของชั้นเรียน งานที่มอบหมาย เป็นต้น 
  1.3  รูปแบบการสอนที่มีปฏิสัมพันธ์ (Interactive instruction model) รูปแบบนี้ 
จัดให้ผู้เรียนได้รับประสบการณ์การเรียนรู้จากการมีปฏิสัมพันธ์กับเนื้อหาที่ได้รับ โดยน าลักษณะ 
ของบทเรียนคอมพิวเตอร์ช่วยสอน (CAI) มาประยุกต์ใช้เป็นการสอนแบบออนไลน์ที่เน้นการมี 
ปฏิสัมพันธ์ มีการให้ค าแนะน าการปฏิบัติ การให้ผลย้อนกลับ รวมทั้งการให้สถานการณ์จ าลอง 
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 2.  รูปแบบการสื่อสาร (Communication model) การเรียนการสอนผ่านเว็บรูปแบบนี้ 
เป็นรูปแบบที่อาศัยคอมพิวเตอร์มาเป็นสื่อเพื่อการสื่อสาร ผู้เรียนสามารถที่จะสื่อสารกับผู้เรียน 
คนอ่ืน ๆ ผู้สอนหรือกับผู้เชี่ยวชาญได้ โดยรูปแบบการสื่อสารที่หลากหลายในอินเทอร์เน็ต ซึ่งได้แก่  
จดหมายอิเล็กทรอนิกส์ กลุ่มอภิปรายการสนทนาและการอภิปรายและการประชุมผ่านคอมพิวเตอร์ 
เหมาะส าหรับการเรียนการสอนที่ต้องการส่งเสริมการสื่อสารและปฏิสัมพันธ์ระหว่างผู้ที่มีส่วนร่วม 
ในการเรียนการสอน  
 3.  รูปแบบผสม (Hybrid model) รูปแบบการเรียนการสอนผ่านเว็บรูปแบบนี้เป็นการน าเอา 
รูปแบบ 2 ชนิด คือ รูปแบบการเผยแพร่กับรูปแบบการสื่อสารมารวมเข้าไว้ด้วยกัน เช่น เว็บไซต์ 
ที่รวมเอารูปแบบห้องสมุดกับรูปแบบหนังสือเรียนไว้ด้วยกัน เว็บไซต์ที่รวบรวมเอาบันทึกของ 
หลักสูตร รวมทั้งค าบรรยายไว้กับกลุ่มอภิปรายหรือเว็บไซต์ที่รวมเอารายการแหล่งเสริมความรู้ต่าง ๆ  
และความสามารถของจดหมายอิเล็กทรอนิกส์ไว้ด้วยกัน เป็นต้น รูปแบบนี้มีประโยชน์เป็นอย่างมาก 
กับผู้เรียนเพราะผู้เรียนจะได้ใช้ประโยชน์ของทรัพยากรที่มีในอินเทอร์เน็ตในลักษณะที่หลากหลาย 
 4.  รูปแบบห้องเรียนเสมือน (Virtual classroom model) รูปแบบห้องเรียนเสมือนเป็น 
การน าเอาลักษณะเด่นหลาย ๆ ประการของแต่ละรูปแบบที่กล่าวมาแล้วข้างต้นมาใช้ ห้องเรียน
เสมือนเป็นสภาพแวดล้อมการเรียนการสอนที่น าแหล่งทรัพยากรออนไลน์มาใช้ในลักษณะ 
การเรียนการสอนแบบร่วมมือ โดยการร่วมมือระหว่างนักเรียนด้วยกัน นักเรียนกับผู้สอน ชั้นเรียน 
กับสถาบันการศึกษาอ่ืน และกับชุมชนที่ไม่เป็นเชิงวิชาการ การเรียนการสอนที่ตั้งขึ้นภายใต้ระบบ 
การสื่อสารผ่านคอมพิวเตอร์ในลักษณะของการเรียนแบบร่วมมือ ซึ่งเป็นกระบวนการที่เน้น 
ความส าคัญของกลุ่มที่จะร่วมมือท ากิจกรรมร่วมกันนักเรียนและผู้สอนจะได้รับความรู้ใหม่ ๆ  
จากกิจกรรมการสนทนาแลกเปลี่ยนความคิดเห็นและข้อมูล ลักษณะเด่นของการเรียนการสอน 
รูปแบบนี้ ก็คือ ความสามารถในการลอกเลียนลักษณะของห้องเรียนปกติมาใช้ในการออกแบบ 
การเรียนการสอนผ่านเครือข่ายอินเทอร์เน็ต โดยอาศัยความสามารถต่าง ๆ ของอินเทอร์เน็ต  
โดยมีส่วนประกอบ คือ ประมวลรายวิชา เนื้อหาในหลักสูตร รายชื่อแหล่งเน้ือหาเสริม กิจกรรม 
ระหว่างผู้เรียนผู้สอนค าแนะน าและการให้ผลป้อนกลับการน าเสนอในลักษณะมัลติมีเดีย การเรียน 
แบบร่วมมือ รวมทั้งการสื่อสารระหว่างกัน รูปแบบนี้จะช่วยให้ผู้เรียนได้รับประโยชน์จากการเรียน  
โดยไม่มีข้อจ ากัด ในเร่ืองของเวลาและสถานที่ 
 ถนอมพร  เลาหจรัสแสง (2545, หน้า 49-65) กล่าวไว้ว่า บทเรียนอิเล็กทรอนิกส์  
(e-Learning courseware) สามารถแบ่งได้เป็น 4 ประเภท ดังนี้  
 1.  การเรียงล าดับการน าเสนอ (Presentation sequence) หมายถึง บทเรียนอิเล็กทรอนิกส์  
ที่ออกแบบลักษณะที่ผู้เรียนศึกษาเน้ือหา โดยการอ่าน ฟัง และสังเกต การบรรยาย และ/ หรือ 
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การสาธิตต่าง ๆ ตามเวลาและจังหวะการเรียนของตน  ซึ่งบทเรียนอิเล็กทรอนิกส์ลักษณะนี้ 
จะมีการใช้การน าเสนอเนื้อหาเป็นล าดับ และเหมาะส าหรับการถ่ายทอดเน้ือหาสารสนเทศ 
ที่ไม่สลับซับซ้อนมากนัก บทเรียนอิเล็กทรอนิกส์ในรูปแบบของการเรียงล าดับการน าเสนอ 
จะใช้สื่อน าเสนอใน 3 ระดับ คือ เน้นตัวอักษรเป็นหลัก เน้นมัลติมีเดียอย่างง่าย ๆ เน้นการน าเสนอ 
ด้วยมัลติมีเดียเป็นหลัก 
 2.  แบบฝึกหัด (Drill and practice) หมายถึง บทเรียนอิเล็กทรอนิกส์ที่อนุญาตให้ผู้เรียน  
ฝึกฝนซ้ าแล้วซ้ าอีก เพื่อประยุกต์ใช้ความรู้หรือทักษะโดยความรู้และทักษะนั้น ๆ จะเป็นความรู้  
และทักษะพื้นฐาน ตัวอย่างของบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกฝนที่นิยม ได้แก่ บทเรียน  
อิเล็กทรอนิกส์แบบฝึกการค านวณอย่างง่าย และบทเรียนอิเล็กทรอนิกส์สอนค าศัพท์ภาษอังกฤษ  
โครงสร้างของบทเรียนอิเล็กทรอนิกส์ จะคล้ายกับวงจรแบบทดสอบที่เร่ิมด้วยการน าเสนอปัญหา  
หรือค าถามให้ผู้เรียนตอบหลังจากที่ผู้เรียนตอบค าถามแล้ว  ก็จะมีการน าเสนอผลป้อนกลับ 
ก่อนที่จะมีการน าเสนอค าถามในข้อต่อไป 
 3.  แล็บเสมือนจริง (Virtual lab) เป็นบทเรียนอิเล็กทรอนิกส์ประเภทหน่ึงซึ่งเป็น 
การน าเสนอการจ าลองบนหน้าจอ ที่ผู้เรียนสามารถใช้แล็บเสมือนจริงในการทดสอบสมมติฐาน 
ที่ได้ตั้งไว้ รวมทั้งสังเกตผลที่ได้จากการทดสอบ ตัวอย่างของเน้ือหาที่สามารถออกแบบในลักษณะ 
แล็บเสมือนจริง ได้แก่ การสอนวิธีการใช้กล้องส่องมองส่วนประกอบของสัตว์ประเภทต่าง ๆ  
ความยาวของคลื่นแสง กล้องส่องทางไกลขนาดต่าง ๆ เป็นต้น 
 4.  เกม (Game) หมายถึง บทเรียนอิเล็กทรอนิกส์ที่มุ่งเน้นให้ผู้เรียนเรียนรู้ในบรรยากาศ 
ที่ท้าทาย สนุกสนานและเพลดิเพลิน อาจอยู่ในรูปของการจ าลองก็ได้ ซึ่งก็จะเรียกว่าเกมการจ าลอง 
ซึ่งรูปแบบเกม อนุญาตให้ผู้เรียนฝึกฝนในลักษณะโต้ตอบกับบทเรียนอิเล็กทรอนิกส์อย่างสม่ าเสมอ  
โดยคาดหวังว่าเมื่อผู้เรียนเล่นเกมหลาย ๆ ครั้ง ผู้เรียนจะสามารถเรียนรู้และสามารถประยุกต์ 
การเรียนรู้นั้นได้ 
 นอกจากนี้ ถนอมพร  เลาหจรัสแสง (2545, หน้า 16) ได้แบ่งประเภทของการเรียน 
การสอน โดยใช้บทเรียนอิเล็กทรอนิกส์ออกเป็น 3 ลักษณะ ดังนี้  
 1.  สื่อเสริม (Supplementary) หมายถึง การน าเอาบทเรียนอิเล็กทรอนิกส์ไปใช้ในลักษณะ 
สื่อเสริม กล่าวคือ นอกจากเนื้อหาที่ปรากฏในบทเรียนอิเล็กทรอนิกส์แล้วผู้เรียนยังสามารถศึกษา 
เน้ือหาเดียวกันนี้ในลักษณะอื่น ๆ เช่น จากเอกสารประกอบการสอน จากวิดีทัศน์การใช้บทเรียน 
อิเล็กทรอนิกส์ในลักษณะนี้เท่ากับว่า ผู้สอนเพียงต้องการหาทางเลือกใหม่ให้ผู้เรียนส าหรับผู้เรียน 
ในการเข้าถึงเน้ือหาเพื่อให้ประสบการพิเศษเพิ่มเติมแก่ผู้เรียนเท่านั้น 
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 2.  สื่อเติม (Complementary) หมายถึง การน าบทเรียนอิเล็กทรอนิกส์ไปใช้ในลักษณะ 
เพิ่มเติมจากวิธีการสอนในลักษณะอื่น ๆ เช่น นอกจากการบรรยายในห้องเรียนแล้ว  ผู้สอน 
ยังออกแบบเนื้อหาให้ผู้เรียนเข้าไปศึกษาเน้ือหาเพิ่มเติมจากบทเรียนอิเล็กทรอนิกส์  
 3.  สื่อหลัก (Comprehensive replacement) หมายถึง การน าบทเรียนอิเล็กทรอนิกส์ไปใช้
ในลักษณะแทนที่การบรรยายในห้องเรียน ผู้เรียนจะต้องศึกษาเน้ือหาทั้งหมดออนไลน์ ในปัจจุบัน 
บทเรียนอิเล็กทรอนิกส์ส่วนใหญ่ในต่างประเทศจะได้รับการพัฒนาขึ้นเพื่อวัตถุประสงค์ในการใช้ 
เป็นสื่อหลักส าหรับแทนครูในการสอนทางไกล ด้วยแนวคิดที่ว่า มัลติมีเดียที่น าเสนอทางบทเรียน 
อิเล็กทรอนิกส์ สามารถช่วยในการถ่ายทอดเนื้อหาได้ใกล้เคียงกับการสอนจริงของครูผู้สอน 
โดยสมบูรณ์ได้ 
 จากลักษณะการน าบทเรียนอิเล็กทรอนิกส์ (e-Learning courseware) ไปใช้ในการเรียน 
การสอน ได้มีนักวิชาการกล่าวไว้ข้างต้น พอสรุปได้ว่า หากผู้เรียนสามารถเรียนรู้เน้ือหาเดียวกับ 
ในชั้นเรียนด้วยสื่อชนิดอ่ืน เป็นการน าบทเรียนอิเล็กทรอนิกส์ไปใช้ในลักษณะสื่อเสริม หากผู้เรียน  
เข้าไปศึกษาเน้ือหาเพิ่มเติมนอกเหนือจากในชั้นเรียน เป็นการน าบทเรียนอิเล็กทรอนิกส์ไปใช้ 
ในลักษณะสื่อเติม ส าหรับผู้เรียนที่ศึกษาเน้ือหาทั้งหมดในบทเรียนอิเล็กทรอนิกส์เป็นการน า 
บทเรียนอิเล็กทรอนิกส์ไปใช้ในสื่อหลัก ซึ่งการน าบทเรียนอิเล็กทรอนิกส์ไปใช้ในลักษณะสื่อหลัก 
ควรที่จะได้รับการออกแบบที่ดี  เพื่อที่จะท าให้เน้ือหาวิชามีความน่าสนใจและสามารถท าให้ 
การเรียนการสอนมีประสิทธิภาพ 
 การออกแบบและผลิตบทเรียนอิเล็กทรอนิกส์  
 ถนอมพร  เลาหจรัสแสง (2545, หน้า 21) กล่าวถึง บทเรียนอิเล็กทรอนิกส์(e-Learning 
courseware) ที่ดีควรออกแบบและผลิตบทเรียนอิเล็กทรอนิกส์ โดยค านึงถึงลักษณะส าคัญ ดังนี้  
 1.  Anywhere, anytime หมายถึง e-Learning courseware ควรต้องช่วยขยายโอกาส 
ในการเข้าถึงเน้ือหาการเรียนรู้ของผู้เรียนได้จริง ในที่นี้หมายถึง การที่ผู้เรียนสามารถเรียกดูเนื้อหา
ตามความสะดวกของผู้เรียน ในประเทศไทยควรมีการใช้เทคโนโลยีการน าเสนอเน้ือหาที่สามารถ
เรียกดูได้ทั้งขณะที่เคร่ืองมีการเชื่อมต่อกับเครือข่ายและไม่มีการเชื่อมต่อกับเครือข่าย 
 2.  Multimedia หมายถึง e-Learning courseware ควรต้องมีการน าเสนอเน้ือหาโดยใช้  
ประโยชน์จากสื่อประสม เพื่อช่วยในการประมวลผลสารสนเทศของผู้เรียนเพื่อให้เกิดความคงทน  
ในการเรียนรู้ได้ดีขึ้น  
 3.  Non-linear หมายถึง ควรต้องมีการน าเสนอเน้ือหาในลักษณะไม่เป็นเชิงเส้นตรง  
กล่าวคือ ผู้เรียนสามารถเข้าถึงเน้ือหาตามความต้องการ โดย e-Learning courseware จะต้องจัดหา  
การเชื่อมโยงที่ยืดหยุ่นแก่ผู้เรียน  
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 4.  Interaction หมายถึง e-Learning courseware ควรต้องมีการเปิดโอกาสให้ผู้เรียน  
โต้ตอบกับเนื้อหาหรือกับผู้อื่นได้ กล่าวคือ  
  4.1  e-Learning courseware ควรต้องมีการออกแบบกิจกรรม ซึ่งผู้เรียนสามารถ  
โต้ตอบกับเนื้อหา รวมทั้งมีการจัดเตรียมแบบฝึกหัดและแบบทดสอบให้ผู้เรียนสามารถตรวจสอบ  
ความเข้าใจด้วยตนเองได้  
  4.2  e-Learning courseware ควรต้องมีการจัดหาเคร่ืองมือในการให้ช่องทางแก่ผู้เรียน  
ในการติดต่อสื่อสารเพื่อการปรึกษา อภิปราย ซักถาม แสดงความคิดเห็นกับผู้สอน วิทยากร  
ผู้เชี่ยวชาญ หรือเพื่อน ๆ  
 5.  Immediate response หมายถึง e-Learning courseware ควรต้องมีการออกแบบให้มี 
การทดสอบการวัดผลและการประเมินผล ซึ่งให้ผลป้อนกลับโดยทันทีแก่ผู้เรียน ไม่ว่าจะอยู่ใน
ลักษณะของแบบทดสอบก่อนเรียน หรือแบบทดสอบหลังเรียนก็ตาม 
 ส าหรับการออกแบบบทเรียนอิเล็กทรอนิกส์ (e-Learning courseware) ถนอมพร   
เลาหจรัสแสง (2545, หน้า 114) ได้กล่าวว่า สามารถแบ่งออกเป็น 2 ส่วนหลัก ๆ ได้แก่ ส่วนของ 
เทมเพลต  ซึ่งหมายถึง โครงสร้างของเว็บเพจที่จะน าเน้ือหาแต่ละส่วนมาใส่ และส่วนของเน้ือหา  
บทเรียน  ซึ่งการออกแบบอาจอยู่ในลักษณะของสตอร่ีบอร์ดบนกระดาษหรือในลักษณะ
อิเล็กทรอนิกส์ก็ได้  ส าหรับการออกแบบบทเรียนระดับสูง  ขั้นตอนของการออกแบบบทเรียน 
เป็นสิ่งที่ส าคัญมากที่สุด  เพราะเน้ือหาของบทเรียนจะน่าสนใจหรือกระตุ้นให้ผู้เรียนอยากเรียนรู้ 
หรือไม่  ขึ้นอยู่กับว่าวิธีการที่ผู้ออกแบบใช้ในการออกแบบเนื้อหานั้น ๆ มีประสิทธิภาพหรือไม่   
การออกแบบสารหรือการออกแบบสื่อที่ใช้เพื่อส่งสารไปยังผู้เรียน  ซึ่งจะต้องกระท าอย่างรัดกุม
และให้ประสิทธิภาพ  นอกจากนี้ ในขั้นตอนนี้จะมีการเลือกสื่อที่ใช้ในการน าเสนอหลากหลาย 
รูปแบบ ไม่ว่าจะเป็นภาพนิ่ง ภาพเคลื่อนไหว กราฟิก วีดีทัศน์ ข้อความ และเสียง ซึ่งการเลือกใช้ 
สื่อใดนั้นขึ้นอยู่กับธรรมชาติของเนื้อหาแต่ละส่วน หลังจากออกแบบแล้ว ผู้พัฒนาจะต้องเขียน 
สคริปต์เนื้อหาและอธิบายอย่างชัดเจนในรายละเอียดเกี่ยวกับสิ่งที่ต้องการจะน าเสนอในแต่ละหน้าจอ  
หลังจากการออกแบบใน ลักษณะสตอร่ีบอร์ด แล้วจะต้องให้ผู้เชี่ยวชาญเน้ือหาตรวจสอบจนกว่า 
จะพอใจในคุณภาพ เมื่อสตอร่ีบอร์ดได้ผ่านการตรวจสอบแล้วจะถูกส่งผ่านไปยังนักออกแบบ
กราฟิกและผู้เชี่ยวชาญด้านสื่อต่อไป ซึ่งก็จะน าสตอรี่บอร์ดที่ได้รับไปพัฒนาเป็นสื่อที่เหมาะสม
ตามที่นักออกแบบเน้ือหาได้ออกแบบไว้ต่อไป  เมื่อสื่อพัฒนาเสร็จแล้วนักออกแบบการสอน
ตรวจสอบคุณภาพของสื่อก่อนที่จะส่งผ่านไปยังโปรแกรมเมอร์ ผู้ซึ่งจะรวบรวมสื่อหลาย ๆ ชนิด 
เข้าด้วยกันเป็นแพลทฟอร์มเดียวกัน 
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 ประโยชน์ท่ีได้รับจากบทเรียนอิเล็กทรอนิกส์  
 ถนอมพร  เลาหจรัสแสง (2545, หน้า 18-20) ได้กล่าวถึงประโยชน์ที่ได้รับจากการน า 
บทเรียนอิเล็กทรอนิกส์(e-Learning courseware)ไปใช้ในการเรียนการสอน ดังนี้  
 1.  บทเรียนอิเล็กทรอนิกส์ช่วยให้การจัดการเรียนการสอนมีประสิทธิภาพมากยิ่งขึ้น 
เพราะการถ่ายทอดเน้ือหาผ่านทางมัลติมีเดียสามารถท าให้ผู้เรียนเกิดการเรียนรู้ได้ดีกว่าการเรียน  
จากสื่อข้อความเพียงอย่างเดียวหรือจากการสอนภายในห้องเรียนของผู้สอนซึ่งเน้นการบรรยาย   
ในลักษณะ Chalk and talk แต่เพียงอย่างเดียวโดยไม่ใช้สื่อใด ๆ ซึ่งเมื่อเปรียบเทียบกับบทเรียน  
อิเล็กทรอนิกส์ที่ได้รับการออกแบบและผลิตอย่างมีระบบ  บทเรียนอิเล็กทรอนิกส์สามารถ 
ช่วยท าให้ผู้เรียนเกิดการเรียนรู้ได้อย่างมีประสิทธิภาพมากกว่า ในเวลาที่เร็วกว่า  นอกจากนี้ยังเป็น 
การสนับสนุนให้เกิดการเรียนรู้ที่ผู้เรียนเป็นศูนย์กลางได้เป็นอย่างดี  เพราะผู้สอนจะสามารถใช้
บทเรียนอิเล็กทรอนิกส์ในการจัดการเรียนการสอนที่ลดการบรรยายและสามารถเน้นให้ผู้เรียน 
ได้เป็นผู้รับผิดชอบในการจัดการเรียนรู้ด้วยตนเองได้ดียิ่งขึ้น 
 2.  บทเรียนอิเล็กทรอนิกส์ช่วยท าให้ผู้สอนสามารถตรวจสอบความก้าวหน้าพฤติกรรม  
การเรียนของผู้เรียนได้อย่างละเอียดและตลอดเวลา  เน่ืองจากบทเรียนอิเล็กทรอนิกส์มีการจัดหา  
เคร่ืองมือที่สามารถท าให้ผู้สอนติดตามการเรียนของผู้เรียนได้  
 3.  บทเรียนอิเล็กทรอนิกส์ช่วยท าให้ผู้เรียนสามารถควบคุมการเรียนของตนเองได้  
เน่ืองจากการน าเอาเทคโนโลยี Hypermedia มาประยุกต์ใช้ซึ่งมีลักษณะการเชื่อมโยงข้อมูลไม่ว่า 
จะเป็นในรูปของข้อความ ภาพนิ่ง เสียง กราฟิก วิดีโอ ภาพเคลื่อนไหว ที่เกี่ยวเนื่องเข้าไว้ด้วยกัน  
ในลักษณะที่ไม่เป็นเชิงเส้นท าให้ Hypermedia สามารถน าเสนอเนื้อหาในรูปแบบใยแมงมุมได้
ดังนั้น ผู้เรียนจึงสามารถเข้าถึงข้อมูลใดก่อนหรือหลังก็ได้ โดยไม่ต้องเรียงล าดับและเกิดความสะดวก 
ในการเข้าถึงของผู้เรียนอีกด้วย  
 4.  บทเรียนอิเล็กทรอนิกส์ช่วยท าให้ผู้เรียนสามารถเรียนรู้ได้ตามจังหวะของตน 
เน่ืองจากการน าเสนอเนื้อในรูปแบบของ Hypermedia  เปิดโอกาสให้ผู้เรียนสามารถควบคุม 
การเรียนรู้ของตนในด้านของล าดับการเรียนได้ตามพื้นฐานความรู้ ความถนัด และความสนใจ 
ของตน  นอกจากนี้ผู้เรียนยังสามารถเลือกเรียนเน้ือหาเฉพาะบางส่วนที่ต้องการทบทวนได้ 
โดยไม่ต้องเรียนในส่วนที่เข้าใจแล้ว  ซึ่งถือว่าผู้เรียนได้รับอิสระในการควบคุมการเรียนของตนเอง  
จึงท าให้ผู้เรียนรู้ตามจังหวะของตน 
 5.  บทเรียนอิเล็กทรอนิกส์ช่วยท าให้เกิดปฏิสัมพันธ์ระหว่างผู้เรียนกับครูผู้สอน  
และกับเพื่อน ๆ ได้เน่ืองจากบทเรียนอิเล็กทรอนิกส์มีเคร่ืองมือต่าง ๆ มากมาย เชน่ Chat room,  
Web board, e-mail เป็นต้น ที่เอ้ือต่อการโต้ตอบที่หลากหลาย นอกจากนั้นบทเรียนอิเล็กทรอนิกส์  
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ที่ออกแบบมาเป็นอย่างดีจะเอ้ือให้เกิดปฏิสัมพันธ์ระหว่างผู้เรียนกับเนื้อหาได้อย่างมีประสิทธิภาพ  
เช่น การออกแบบเน้ือหาในลักษณะเกม หรือการจ าลอง เป็นต้น  
 6.  บทเรียนอิเล็กทรอนิกส์ช่วยเสริมให้เกิดการเรียนรู้ทักษะใหม่ ๆ รวมทั้งเนื้อหาที่มี  
ความทันสมัยและตอบสนองต่อเร่ืองราวต่าง ๆ ในปัจจุบันได้อย่างทันทีเพราะการที่เนื้อหาการเรียน  
อยู่ในรูปของข้อความอิเล็กทรอนิกส์ ซึ่งได้แก่ ข้อความซึ่งได้รับการจัดเก็บ ประมวลผล น าเสนอ 
และเผยแพร่ทางคอมพิวเตอร์ ท าให้มีข้อได้เปรียบสื่ออ่ืน ๆ หลายประการ โดยเฉพาะอย่างยิ่งในด้าน 
ความสามารถในการปรับปรุงเนื้อหาสารสนเทศในทันสมัยได้ตลอดเวลา  การเข้าถึงข้อมูลที่ต้องการ
ด้วยความสะดวกรวดเร็ว และความคงทนของข้อมูล  
 7.  บทเรียนอิเล็กทรอนิกส์ท าให้เกิดรูปแบบการเรียนที่สามารถจัดการเรียนการสอน 
ให้แก่ผู้เรียนในวงกว้างขึ้น  เพราะผู้เรียนจะไม่มีข้อจ ากัดในด้านการเดินทางมาศึกษาในเวลาใด  
เวลาหนึ่งและสถานที่ใดสถานที่หนึ่ง  ดังนั้นบทเรียนอิเล็กทรอนิกส์จึงสามารถน าไปใช้เพื่อสนับสนุน  
การเรียนรู้ตลอดชีวิตได้ และยิ่งไปกว่านั้นยังสามารถน าบทเรียนอิเล็กทรอนิกส์ไปใช้เพื่อเปิดโอกาส  
ให้ผู้เรียนที่ขาดโอกาสทางการศึกษาในระดับอุดมศึกษาได้เป็นอย่างดี  
 8.  บทเรียนอิเล็กทรอนิกส์ท าให้สามารถลดต้นทุนในการจัดการศึกษานั้น ๆ ได้ในกรณี 
ที่มีการจัดการเรียนการสอนส าหรับผู้เรียนที่มีจ านวนมาก และเปิดกว้างในสถาบันอื่น ๆ หรือบุคคล 
ทั่วไปเข้ามาใช้บทเรียนอิเล็กทรอนิกส์ได้ ซึ่งจะพบเมื่อต้นทุนการผลิตบทเรียนอิเล็กทรอนิกส์  
เท่าเดิม แต่ปริมาณผู้เรียนมีปริมาณเพิ่ม มากขึ้นหรือขยายวงกว้างการใช้ออกไปเท่ากับเป็นการลด 
ต้นทุนทางการศึกษานั้นเอง 
 ศูนย์เทคโนโลยีอิเล็กทรอนิกส์และคอมพิวเตอร์แห่งชาติ (2545) ยังได้กล่าวถึง  
ประโยชน์ของ e-Learning courseware ดังนี ้ 
 1.  บทเรียนอิเล็กทรอนิกส์สามารถเพิ่มประสิทธิภาพการเรียนการสอน โดยใช้สื่อ 
อุปกรณ์ และคลังความรู้ที่มีอยู่บนอินเทอร์เน็ต เพื่อสนับสนุนการเรียนการสอนของครูและนักเรียน  
 2.  บทเรียนอิเล็กทรอนิกส์สามารถท าให้เกิดเครือข่ายความรู้ที่สามารถแลกเปลี่ยนความรู้  
และวัฒนธรรมซึ่งกันและกันบนอินเทอร์เน็ต ข้อมูลจะมีการปรับปรุงให้ทันสมัยอยู่เสมอ สะดวก  
และรวดเร็ว  
 3.  บทเรียนอิเล็กทรอนิกส์สามารถส่งเสริมการเรียนรู้แบบผู้เรียนเป็นศูนย์กลางผู้เรียน 
สามารถสืบค้นวิชาความรู้ได้ด้วยตนเอง โดยมีการให้ค าปรึกษา และชี้น าโดยครูผู้สอน 
 4.  บทเรียนอิเล็กทรอนิกส์สามารถลดช่องว่างระหว่างการศึกษาในเมืองและชนบทสร้าง  
ความเท่าเทียมกันและกระจายโอกาสทางการศึกษาให้เด็กชนบทได้รู้เท่าทัน เพื่อสนับสนุนนโยบาย  
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และการพัฒนาระบบ เทคโนโลยีทางการศึกษาและเครือข่ายสารสนเทศเพื่อความสอดคล้อง 
และสนับสนุนการปฏิรูปการศึกษาตามพระราชบัญญัติการศึกษาแห่งชาติ พ.ศ. 2542 
 นอกจากนี้ กิดานันท ์ มลิทอง (2548, หน้า 163) ได้กล่าวถึงประโยชน์ของบทเรียน
อิเล็กทรอนิกส์ไว้ ดังนี้  
 1.  บทเรียนอิเล็กทรอนิกส์ท าให้เกิดเครือข่ายความรู้ที่สามารถแลกเปลี่ยนและแบ่งปันกัน 
ได้ทั่วโลก   
 2.  บทเรียนอิเล็กทรอนิกส์สามารถเพิ่มประสิทธิภาพการเรียนการสอนโดยใช้การท า
กิจกรรมการเรียนทั้งแบบประสานเวลาและแบบไม่ประสานเวลา  
 3.  บทเรียนอิเล็กทรอนิกส์สนับสนุนการให้ผู้เรียนเป็นศูนย์กลางการเรียนในหลายรูปแบบ  
เช่น การเรียนรู้ร่วมกันการเรียนแบบการแก้ปัญหา การเรียนตามอัตราความก้าวหน้าของตนเอง  
 4.  บทเรียนอิเล็กทรอนิกส์เป็นการกระจายโอกาสทางการศึกษาเพื่อลดช่องว่างและสร้าง
ความเท่าเทียมกันแก่ผู้เรียนทุกคน  
 5.  บทเรียนอิเล็กทรอนิกส์สร้างความยืดหยุ่นในการเรียนทั้งในลักษณะบทเรียน  
การทบทวนเนื้อหาบทเรียน การท ากิจกรรม รวมถึงการเรียนได้อย่างไม่จ ากัดเวลาและสถานที่   
โดยที่ผู้เรียนไม่จ าเป็นต้องใช้เวลานั่งฟังการบรรยายของผู้สอนเหมือนการเรียนในห้องเรียน  
 6.  บทเรียนอิเล็กทรอนิกส์เป็นทางเลือกที่น่าสนใจส าหรับผู้ที่ไม่ต้องการเดินทางไปเรียน 
ในประเทศห่างไกลหรือผู้ไม่มีโอกาสได้เข้าเรียนในสถาบันอุดมศึกษาระบบปิด  
 7.  บทเรียนอิเล็กทรอนิกส์เป็นการเรียนผ่านเครือข่ายท าได้ง่ายและสะดวกรวดเร็ว 
 จากประโยชน์ของบทเรียนอิเล็กทรอนิกส์ (e-Learning courseware) พอสรุปได้ว่า  
บทเรียนอิเล็กทรอนิกส์ท าให้การจัดการเรียนการสอนมีประสิทธิภาพมากยิ่งขึ้น ด้วยการน าเสนอ  
ที่หลากหลายและน่าสนใจ ผู้เรียนได้เรียนรู้อย่างอิสระและเป็นผู้ควบคุม วิธีการเรียนรู้ของตนเอง  
สามารถ เข้าถึงเนื้อหาได้อย่างสะดวก อีกทั้งยังส่งเสริมให้เกิดการเรียนรู้ทักษะทางด้านเทคโนโลยี 
ใหม่ ๆ 
 จากงานวิจัยที่กล่าวมาข้างต้นจะเห็นว่า ในการจัดการเรียนการสอนโดยใช้บทเรียน  
อิเล็กทรอนิกส์ (e-Learning courseware) นั้นเป็นแนวทางการจัดการเรียนการสอนที่ท าให้ทั้งผู้เรียน  
และผู้สอนพึงพอใจ และเห็นประโยชน์ของบทเรียนอิเล็กทรอนิกส์ สร้างทัศนคคติที่ดีต่อการเรียน 
ด้วยบทเรียนอิเล็กทรอนิกส์  บทเรียนอิเล็กทรอนิกส์ที่สร้างขึ้นมีผลการประเมินจากผู้เชี่ยวชาญและ 
นักเรียนอยู่ในระดับดี และยังท าให้ผู้เรียนมีผลสัมฤทธิ์ทางการเรียนที่สูงขึ้นด้วย 
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แนวคิดโปรแกรม Moodle, Flip Album 
 Moodle ย่อมาจาก Modular object-oriented dynamic learning environment คือ  
ระบบจัดการเรียนการสอนในระบบออนไลน์ให้มีบรรยากาศเหมือน เรียนในห้องเรียน หรือเรียกว่า 
LMS (Learning management system) หรือระบบจัดคอร์สการเรียนการสอน CMS (Course 
management system ผ่านระบบเครือข่ายอินเตอร์เน็ต อินทราเน็ต ส าหรับสถาบันการศึกษาหรือครู 
ใช้เพื่อเตรียมแหล่งข้อมูล กิจกรรม และเผยแพร่แบบออนไลน์ผ่านอินเทอร์เน็ต หรืออินทราเน็ต 
Moodle สามารถน าไปใช้ได้ ทั้งองค์กรระดับมหาวิทยาลัย โรงเรียน สถาบัน หรือครูสอนพิเศษ  
 ความสามารถของ Moodle 
 1.  เป็นโปรแกรมจัดการเรียนการสอนผ่านระบบเครือข่ายคอมพิวเตอร์ ประเภทฟรีแวร์ 
ที่ได้รับการยอมรับกันทั่วโลก 
 2.  สามารถเป็นได้ทั้ง CMS (Course management system) และ LMS (Learning 
management system) ช่วยรวบรวมวิชาเป็นหมวดหมู่ เผยแพร่เนื้อหา ของผู้สอน พร้อมบริการ 
ให้นักเรียนเข้ามาศึกษา และบันทึกกิจกรรมของนักเรียน 
 3.  สามารถสร้างแหล่งข้อมูลใหม่ หรือเผยแพร่เอกสารที่ท าไว้ เช่น Microsoft office, 
Web page, PDF หรือ Image เป็นต้น ใจกว้าง ไม่หวงวิชา มีเอกสารที่เคยรวบรวมไว้ ก็ส่งเข้าไป
เผยแพร่ได้โดยง่าย 
 4.  มีระบบติดต่อสื่อสาร ระหว่างนักเรียน เพื่อนร่วมชั้น และผู้สอน เช่น Chat หรือ  
Web board เป็นต้น  นักเรียนฝากค าถาม ครูทิ้งค าถามไว้ ครูนัดสนทนาแบบออนไลน์ ครูนัดสอนเสริม 
หรือแจกเอกสารให้อ่านก่อน เข้าเรียน ก็ได้ 
 5.  มีระบบแบบทดสอบ รับการบ้าน และกิจกรรม ที่รองรับระบบ ให้คะแนนที่หลากหลาย 
ให้ส่งงาน ให้ท าแบบฝึกหัด ตรวจให้คะแนนแล้ว Export ไป Excel 
 6.  ส ารองข้อมูลเป็น .zip แฟ้มเดียว ในอนาคตสามารถน าไปกู้คืน ลงไปในเคร่ืองใดก็ได้ 
ข้อมูลประกอบการตัดสินใจเลือกใช้ Moodle 
 องค์ประกอบของ Moodle ท่ีโรงเรียนควรมี 
 1.  มี Web browser เช่น Internet explorer ในการติดต่อกับ Moodle ทั้งโดยครูผู้สอนและ
นักเรียน 
 2.  มี Web Server ที่ให้บริการ php และ mysql 
 3.  มีผู้ติดต้ัง ผู้ดูแล และบ ารุงรักษา ควรท าโดยนักคอมพิวเตอร์ที่มีประสบการณ์เกี่ยวกับ 
การติดตั้ง การบ ารุงรักษา และการเขียนเว็บ 
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 4.  มีครู นักเรียน และผู้บริหาร ที่ยอมรับในเทคโนโลยีสมัยใหม่ ดังนั้น Moodle  
ไม่เหมาะกับเด็กอนุบาล หรือครูที่ไม่มีไฟ 
 5.  มีการเชื่อมต่อเป็นระบบเครือข่าย เช่น อินเทอร์เน็ต อินทราเน็ต (LAN) 
 ผู้ท่ีเกี่ยวข้องกับ Moodle 
 1.  ผู้ดูแลระบบ (Admin): ติดตั้งระบบ บ ารุงรักษา ก าหนดค่าเร่ิมต้น และก าหนดสิทธิ์
การเป็นครูผู้สอน 
 2.  ผู้สอน (Teacher): เพิ่มแหล่งข้อมูล เพิ่มกิจกรรม ให้คะแนน ตรวจสอบกิจกรรมผู้เรียน 
ตอบค าถาม และติดต่อสื่อสาร 
 3.  ผู้เรียน (Student): เข้าศึกษาแหล่งข้อมูล และท ากิจกรรม ตามแผนการสอน 
 4.  ผู้เยี่ยมชม (Guest): เข้าเรียนได้เฉพาะวิชาที่อนุญาต และจ ากัดสิทธ์ ในการท ากิจกรรม  
 ความหมายของ Flip Album 
 โปรแกรมที่สามารถสร้างหนังสือหรืออัลบั้มภาพต่าง ๆ โดยเราสามารถใส่ภาพ, เสียง,  
ค าบรรยายประกอบได้หลังจากนั้นโปรแกรมท าการบันทึกเป็นหนังสืออิเล็กทรอนิกส์ หรือสมุด
ภาพสามมิติ ซึ่งคล้ายหนังสือจริงมาก โดยเฉพาะการพลิกหน้ากระดาษของหนังสือ จะคล้ายกับ 
การเปิดอ่านหนังสือจริง ๆ การสร้าง E-book ด้วย Flip album ค่อนข้างง่าย สามารถน าภาพ 
หน้าหนังสือแต่ละหน้าที่ถูกแยกเป็นไฟล์แล้วมารวมเข้าด้วยกัน เป็นไฟล์ E-book ได้ทันทีคู่มือ 
การใช้งานนี้ จะเป็นการใช้งานโปรแกรม Flip album standard  
 โปรแกรมที่นิยมใช้สร้าง e-Book มีอยู่หลายโปรแกรม แต่ที่นิยมใช้กันมากในปัจจุบัน 
ได้แก่ 
 1.  โปรแกรมชุด Flip album 
 2.  โปรแกรม Desk top author 
 3.  โปรแกรม Flip flash album 
 คุณสมบัติของโปรแกรม Flip Album 
 การพัฒนา Multimedia e-Book มีซอฟต์แวร์ช่วยหลายตัว โดยซอฟต์แวร์ที่โดดเด่น 
ตัวหนึ่ง คือ Flip album ซึ่งปจัจุบันได้พัฒนามาเป็น Flip album โดยความสามารถของโปรแกรม 
ที่ท าให้การน าเสนอสื่อออกมาในรูปแบบ 3D Page-flipping interface และมีชื่อเรียกเฉพาะว่า  
Flip book ผลงานที่ได้นี้สามารถน าเสนอได้ทั้งแบบ Offline ด้วยความสามารถ Auto run อัตโนมัติ  
และ Online ผ่านโปรแกรมแสดงผลเฉพาะ Flip viewer 
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 ประโยชน์ของโปรแกรม Flip album 
 โปรแกรม Flip album 6 Pro เป็นโปรแกรมลักษณะของโปรแกรมส าเร็จรูป โดยโปรแกรม
ชุด Flip album เปน็โปรแกรมที่นิยมใช้สร้าง e-Book ซึ่ง อีบุ๊ค” (eBook, EBook, e-Book)  
เป็นค าภาษาต่างประเทศ ย่อมาจากค าว่า Electronic book หรือหนังสืออิเล็กทรอนิกส์ซึ่งจัดท าขึ้น
ด้วยระบบคอมพิวเตอร์ หรือหนังสือที่สร้างขึ้นด้วยโปรแกรมคอมพิวเตอร์มีลักษณะเป็นเอกสาร
อิเล็กทรอนิกส์ และสามารถอ่านได้จากหน้าจอคอมพิวเตอร์ทั้งในระบบออฟไลน์และออนไลน์
เหมือนเปิดอ่านจากหนังสือโดยตรงที่เป็นกระดาษ แต่ไม่มีการเข้าเล่ม เหมือนหนังสือที่เป็นกระดาษ 
หนังสืออิเล็กทรอนิกส์ มีความสามารถมากมายคือ มีการเชื่อมโยง (Link) กับหนังสืออิเล็กทรอนิกส์ 
เล่มอื่น ๆ ได้  
 

แนวคิดการหาประสิทธิภาพบทเรียน 
 ความหมายของการหาประสิทธิภาพของบทเรียน 
  การพัฒนาบทเรียนคอมพิวเตอร์ช่วยสอนควรมีการก าหนดวัตถุประสงค์ทั่วไป  
(Goal/ objectives) ศึกษารายละเอียดของเนื้อหา (Content specification) วิเคราะห์เน้ือหา (Content 
analysis) ก าหนดวัตถุประสงค์เชิงพฤติกรรม (Behavioral objective) เลือกกลยุทธ์ทางการสอน 
และการน าเสนอ (Teaching strategies & models of delivery) ออกแบบและลงมือสร้างบทเรียน  
(Design & implementation) น าเสนอต่อผู้เรียน (Delivery) และวัดและประเมินผล (Evaluation)  
(วุฒิชัย  ประสารสอย, 2543, หน้า 28-31) การหาประสิทธิภาพของบทเรียนคอมพิวเตอร์ช่วยสอน 
ดังนั้น ในการหาประสิทธิภาพชุดการสอนจึงเป็นการน าชุดการสอนที่ได้ไปทดลองใช้แล้ว 
ท าการปรับปรุงแก้ไขเพื่อน าไปใช้ทดลองจริง แล้วน าผลมาท าการวิเคราะห์ แล้วปรับปรุง 
เพื่อน าไปใช้งานจริง 
 ประสิทธิภาพบทเรียนคอมพิวเตอร์ช่วยสอน หมายถึง ความสามารถของบทเรียน 
ในการสร้างผลสัมฤทธิ์ให้ผู้เรียนบรรลุวัตถุประสงค์ถึงระดับที่คาดหวังไว้และครอบคลุม 
ความเชื่อถือได้ (Reliability) ความพร้อมที่จะใช้งาน (Availability) ความมั่นคงปลอดภัย (Security)  
และความถูกต้องสมบูรณ์ (Integrity) (วุฒิชัย  ประสารสอย, 2543, หน้า 39-43) 
 กระบวนการหาประสิทธิภาพของบทเรียนคอมพิวเตอร์ช่วยสอนจะเน้นไปทางด้าน 
การประกันคุณภาพหรือความสามารถของสื่อที่จะใช้เชื่อมโยงความรู้และมีคุณลักษณะภายใน 
ตัวของสื่อที่เปิดโอกาสให้ผู้เรียนสามารถตัดสินใจ และช่วยส่งเสริมการแสวงหาความรู้จาก
ประสบการณ์เดิมของผู้เรียน ผสมผสานกับความรู้ใหม่ที่ถ่ายโยงจากโปรแกรมบทเรียนไปสู่ตัวของ 
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ผู้เรียน จากการที่ได้ก าหนดวัตถุประสงค์ในการน าเสนอความรู้เอาไว้ล่วงหน้าอย่างแน่ชัด ซึ่งเป็น 
การก าหนดล าดับขั้นในการเรียนและเกณฑ์ที่ใช้ตัดสินคุณค่าของบทเรียน 
 ขั้นตอนการหาประสิทธิภาพของการฝึกอบรม 
 ชัยยงค์  พรหมวงศ์ (2556) ได้กล่าวถึงการทดสอบประสิทธิภาพสื่อไว้ว่า การผลิตสื่อนั้น 
ก่อนน าไปใช้จริงจะต้องน าสื่อที่ผลิตขึ้นไปทดสอบประสิทธิภาพ เพื่อดูว่าสื่อหรือชุดการสอนท าให้ 
ผู้เรียนมีความรู้เพิ่มขึ้นหรือไม่ มีประสิทธิภาพในการช่วยให้กระบวนการเรียนการสอนด าเนินไป 
อย่างมีประสิทธิภาพเพียงใด มีความสัมพันธ์กับผลลัพธ์หรือไม่และผู้เรียน มีความพึงพอใจต่อ 
การเรียนจากสื่อในระดับใด ดังนั้นผู้ผลิตสื่อการสอนจ าเป็นจะต้องน าสื่อไปหาคุณภาพ เรียกว่า  
การทดสอบประสิทธิภาพ 
 การก าหนดเกณฑ์ประสิทธิภาพกระท าได้โดยการประเมินผลพฤติกรรมของผู้เรียน 
2 ประเภท คือ พฤติกรรมต่อเนื่อง (กระบวนการ) ก าหนดค่าประสิทธิภาพเป็น E1 = Efficiency of 
process (ประสิทธิภาพของกระบวนการ) และพฤติกรรมสุดท้าย (ผลลัพธ์) ก าหนดค่าประสิทธิภาพ 
เป็น E2 = Efficiency of product (ประสิทธิภาพของผลลัพธ์) 
 1.  ประเมินพฤติกรรมต่อเนื่อง (Transitional behavior) คือ ประเมินผลต่อเนื่อง 
ซึ่งประกอบด้วย พฤติกรรมย่อยของผู้เรียน เรียกว่า “กระบวนการ” (Process) ที่เกิดจากการประกอบ 
กิจกรรมกลุ่ม ได้แก่ การท าโครงการ หรือท ารายงานเป็นกลุ่ม  และรายงานบุคคล ได้แก่  
งานที่มอบหมายและกิจกรรมอ่ืนใดที่ผู้สอนก าหนดไว้ 
 2.  ประเมินพฤติกรรมสุดท้าย (Terminal behavior) คือประเมินผลลัพธ ์(Product)  
ของผู้เรียน โดยพิจารณาจากการประเมินหลังเรียนทั้งหมด นั่นคือ E1/ E2 = ประสิทธิภาพของ 
กระบวนการ/ ประสิทธิภาพของผลลัพธ์ 
 ตัวอย่าง 80/ 80 หมายความว่า เมื่อเรียนจากสื่อหรือชุดการสอนแล้ว ผู้เรียนจะสามารถ 
ท าแบบฝึกปฏิบัติหรืองานได้ผลเฉลี่ย 80% และประเมินหลังเรียนและงานสุดท้ายได้ผลเฉลี่ย 80% 
การที่จะก าหนดเกณฑ์ E1/ E2 ให้มีค่าเท่าใดนั้น ให้ผู้สอนเป็นผู้พิจารณาตามความพอใจ โดยพิจารณา 
พิสัยการเรียนที่จ าแนกเป็นวิทยพิสัย (Cognitive domain) จิตพิสัย (Affective domain) และทักษะพิสัย  
(Skill domain) ในขอบข่ายวิทยพิสัย (เดิมเรียกว่าพุทธิพิสัย) เนื้อหาที่เป็นความรู้ความจ ามักจะตั้งไว้ 
สูงสุดแล้วลดต่ าลงมา คือ 90/ 90  85/ 85  80/ 80  ส่วนเนื้อหาสาระที่เป็นจิตพิสัย จะต้องใช้เวลาไป 
ฝึกฝนและพัฒนา ไม่สามารถท าให้ถึงเกณฑ์ระดับสูงได้ในห้องเรียนหรือในขณะที่เรียน จึงอนุโลม 
ให้ตั้งไว้ต่ าลง นั่นคือ 80/ 80  75/ 75  แต่ไม่ต่ ากว่า 75/ 75 เพราะเป็นระดับความพอใจต่ าสุด  
จึงไม่ควรตั้งเกณฑ์ไว้ต่ ากว่านี้หากตั้งเกณฑ์ไว้เท่าใด ก็มักได้ผลเท่านั้น 
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 วิธีการค านวณค่าประสิทธิภาพ  
 สูตรท่ีใช้ในการค านวณ 
 

 สูตรที่ 1   E1 =       100



A
N

X
 

 
 E1  คือ  ค่าประสิทธิภาพของกระบวนการเรียนรู้ 
  X คือ  ผลรวมของคะแนนกิจกรรมระหว่างเรียนของผู้เรียนทุกคน (N คน) 
 N  คือ  จ านวนผูเ้รียนที่ใช้ในการประเมิน 
 A  คือ  คะแนนเต็มของกิจกรรมระหว่างเรียน 
 

 สูตรที่ 2   E2 =       100



B
N

F
 

 
 E2  คือ  ค่าประสิทธิภาพของผลลัพธ์การเรียนรู้ 
 F  คือ  ผลรวมของคะแนนที่ได้จากแบบทดสอบหลังเรียนของผู้เรียนทุกคน (N คน) 
 N  คือ  จ านวนผู้เรียนที่ใช้ในการประเมิน 
 B  คือ  คะแนนเต็มของแบบทดสอบหลังเรียน  
 ขั้นตอนการหาประสิทธิภาพ 
 การหาประสิทธิภาพของบทเรียนคอมพิวเตอร์ช่วยสอนที่สร้างขึ้นควรเร่ิมต้นจาก 
การตรวจสอบคุณภาพและหาค่าความเชื่อมั่นให้ได้มาตรฐานก่อนที่จะน าไปใช้ด้วยการประเมิน 
จากความคิดเห็นของผู้เชี่ยวชาญหรือผู้ทรงคุณวุฒิที่มีความรู้และประสบการณ์ในด้านเนื้อหาและ 
สื่อการสอน เพื่อให้เป็นผู้พิจารณาให้ข้อมูลในการปรับปรุงหรือแก้ไขข้อบกพร่องของบทเรียน  
โดยสร้างเคร่ืองมือประเมินความเหมาะสมให้ครอบคลุมองค์ประกอบในด้านต่าง ๆ เช่น ด้านเน้ือหา  
ด้านภาพ เสียง และการใช้ภาษา ด้านการออกแบบจอภาพและด้านการจัดการบทเรียน เกณฑ์การวัด 
ประสิทธิภาพของบทเรียนคอมพิวเตอร์ช่วยสอน ก าหนดเป็นร้อยละของคะแนนเฉลี่ยที่ได้จาก 
การท าแบบฝึกหัดหรือท ากิจกรรมระหว่างเรียนในบทเรียนนั้นต่อร้อยละของคะแนนเฉลี่ยที่ได้จาก 
การท าแบบทดสอบหรือท ากิจกรรมหลังการเรียนเนื้อหาครบถ้วนแล้ว นั่นคือ E1/ E2  ตัวอย่างเช่น  
ก าหนดเกณฑ์มาตรฐาน 80/ 80 หมายความว่า เมื่อผู้เรียนเรียนด้วยบทเรียนคอมพิวเตอร์ช่วยสอนนี้ 
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แล้วผู้เรียนจะสามารถท าแบบฝึกหัดได้ถูกต้องเฉลี่ยร้อยละ 80  และสามารถท าแบบทดสอบ 
หลังเรียนได้ถูกต้องร้อยละ 80 (เสาวนีย์  สิกขาบัณฑิตย,์ 2528, หน้า 294-295) 
 ขั้นตอนการหาประสิทธิภาพของบทเรียน (องอาจ  ชาญเชาว์, 2544, หน้า 51 อ้างถึงใน  
ชัยยงค์  พรหมวงศ์, 2556) มีขั้นตอน ดังนี้ 
 1.  ทดลองแบบเดี่ยว (1: 1) คือ ทดลองกับผู้เรียน 3 คน โดยใช้เด็กอ่อน ปานกลาง  
และเด็กเก่ง ค านวณหาประสิทธิภาพเสร็จแล้วให้ปรับปรุงแก้ไขบทเรียนให้ดีขึ้น 
 2.  ทดลองแบบกลุ่ม (1: 10) คือ ทดลองกับผู้เรียน 6-10 คน คละผู้เรียนที่เก่ง อ่อน  
ค านวณหาประสิทธิภาพเสร็จแล้วให้ปรับปรุงแก้ไขบทเรียนให้ดีขึ้น 
 3.  ทดลองภาคสนาม (1: 100) คือ ทดลองกับผู้เรียนทั้งชั้น ค านวณหาประสิทธิภาพแล้ว 
ท าการปรับปรุงแก้ไขในการทดลองแต่ละขั้น ถ้าค านวณหาประสิทธิภาพแล้วได้ผลลัพธ์เท่ากับ 
หรือสูงกว่าเกณฑ์ที่ก าหนดไว้ก็ให้ยอมรับ แต่ถ้ายังไม่ถึงเกณฑ์ก็ต้องปรับปรุงแก้ไขบทเรียนและ 
หาประสิทธิภาพจนกว่าจะได้ตามเกณฑ์ที่ก าหนด 
 ความจ าเป็นในการหาประสิทธิภาพ 
 ชุดฝึกอบรมใด ๆ ก็ตาม เมื่อสร้างขึ้นมาแล้วจ าเป็นอย่างยิ่งที่จะต้องน าไปหาประสิทธิภาพ 
เพื่อเป็นการประกันว่าจะมีคุณภาพจริง ซึ่ง ชัยยงค์  พรหมวงศ์ (2556, หน้า 134) ได้ให้เหตุผล 
ถึงความจ าเป็นที่ต้องมีการประสิทธิภาพของการฝึกอบรมที่สร้างขึ้นดังนี้ 
 เพือ่เป็นการประกันคุณภาพของบทเรียนหรือชุดการสอน ว่าอยู่ในขั้นสูงเหมาะที่จะ
ลงทุนผลิตเป็นจ านวนมาก  
  ช่วยท าให้ผู้ฝึกอบรมน าบทเรียนหรือชุดการฝึกอบรมไปใช้เกิดความมั่นใจว่าบทเรียน
หรือชุดการฝึกอบรมมีประสิทธิภาพในการช่วยให้ผู้ฝึกอบรมเกิดการเรียนรู้จริง 
 

แนวคิดเกี่ยวกับความพึงพอใจ 
 ความหมายความพึงพอใจ 
 ความพึงพอใจเป็นค าที่มีความหลากหลาย ซึ่งได้จากแนวคิดแต่ละทัศนะตามกรอบ 
ความคิดและความเชื่อของแต่ละบุคคลที่ยึดถือ นักวิชาการหลายท่านได้ให้ความหมายไว้ ดังนี้ 
 จิราภรณ์  หอมกลิ่น (2548, หน้า 52) ให้ความหมายไว้ว่า ความพึงพอใจ หมายถึง  
ความรู้สึกที่เกิดขึ้นภายในจิตในของบุคคลต่อสิ่งใดสิ่งหนึ่ง  เมื่อได้รับการตอบสนองตามความต้องการ 
หรือได้รับการยกย่องชมเชย 
 จ าปา  วัฒนศิรินทรเทพ (2550, หน้า 48) สรุปได้ว่า ความพึงพอใจ หมายถึง ความรู้สึก 
นึกคิดความเชื่อ การแสดงความรู้สึก ความคิดเห็นต่อสิ่งใดสิ่งหนึ่ง โดยแสดงพฤติกรรมออกมา 
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2 ลักษณะ คือ ทางบวก ซึ่งแสดงในลักษณะความชอบ ความพึงพอใจ ความสนใจ เห็นด้วย ท าให้
อยากท างานหรือปฏิบัติกิจกรรม อีกลักษณะหนึ่งคือ ทางลบ ซึ่งจะแสดงออกในลักษณะของ 
ความเกลียด ไม่พึงประสงค์ ไม่พอใจ ไม่สนใจ ไม่เห็นด้วย อาจท าให้บุคคลเกิดความเบื่อหน่ายหรือ 
ต้องการหนีห่างจากสิ่งนั้น นอกจากนี้ความพึงพอใจอาจจะแสดงออกในลักษณะความเป็นกลางก็ได้  
เช่น รู้สึกเฉย ๆ ไม่รักไม่ชอบไม่น่าสนใจในสิ่งนั้น ๆ 
 สมพิศ  ไชยเสนา (2550, หน้า 54) กล่าวว่า ความพึงพอใจ คือ ความรู้สึกของบุคคลต่อ 
สิ่งใดสิ่งหนึ่ง ความรู้สึกพึงพอใจเกิดขึ้นเมื่อบุคคลได้รับสิ่งที่ตนต้องการและท าให้บุคคลมี 
พฤติกรรมต่อสิ่งเร้านั้นในเชิงบวกหรือเป็นไปตามเป้าหมายที่ตนเองต้องการ หรือไม่มีความรู้สึก 
ขัดแย้งกับสิ่งเหล่านั้น และถ้าระดับความรู้สึกถ้ามีความเครียดมากจะท าให้เกิดความไม่พึงพอใจ 
ในการท างาน ความพึงพอใจเปลี่ยนแปลงไปตามเวลาและสถานการณ์แวดล้อม 
 จากที่กล่าวมาสรุปได้ว่า ความพึงพอใจ หมายถึง ความรู้สึกนึกคิด ความเชื่อ การแสดง 
ความรู้สึก ความคิดเห็นต่อสิ่งใดสิ่งหนึ่ง หรือทัศนคติของบุคคล ที่มีต่องานหรือกิจกรรมซึ่งสามารถ 
เป็นไปได้ทั้งทางบวกและทางลบ ระดับความพึงพอใจของแต่ละบุคคลย่อมมีความแตกต่างกัน 
 ทฤษฎีท่ีเกี่ยวข้องกับความพึงพอใจ 
 ไชยยันห์  ชาญปรีชารัตน์ (2543, หน้า 52) ได้กล่าวถึงทฤษฎีทางพฤติกรรมศาสตร์ 
ที่เกี่ยวกับลักษณะและความต้องการของมนุษย์ซึ่งสามารถน ามาประยุกต์ใช้ในการสร้างเสริม 
ความพึงพอใจของบุคคลได้อย่างเหมาะสม ประกอบด้วยทฤษฎีที่ส าคัญ ดังนี้ 

ทฤษฎีของ Maslow (1970) มาสโลว์ต้ังทฤษฎีนี้โดยมีแนวคิดพื้นฐานเกี่ยวกับพฤติกรรม
ของมนุษย์ไว้ ดังนี้ 
 1.  ลักษณะความต้องการมนุษย์ ประกอบด้วย 
  1.1  ความต้องการของมนุษย์เป็นไปตามล าดับขั้นความส าคัญโดยเร่ิมจากระดับ 
ความต้องการขั้นต่ าไปสู่ความต้องการขั้นสูง 
  1.2  มนุษย์มีความต้องการอยู่เสมอ เมื่อความต้องการอย่างหนึ่งได้รับการตอบสนอง
แล้วจะมีความต้องการสิ่งใหม่เข้ามาแทนที่ 
  1.3  เมื่อความต้องการในระดับหนึ่งได้รับการตอบสนองแล้วจะไม่จูงใจให้เกิด
พฤติกรรมต่อสิ่งหนึ่ง  แต่จะมีความต้องการในระดับสูงเข้ามาแทน  และเป็นแรงจูงใจให้เกิด 
พฤติกรรมในสิ่งนั้น 
  1.4  ความต้องการที่เกิดขึ้นอาศัยซึ่งกันและกัน มีลักษณะควบคู่กันคือ เมื่อความต้องการ
อย่างหนึ่งไม่หมดสิ้นไป ก็จะมีความต้องการอย่างหนึ่งเกิดขึ้นมา 
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 2.  ล าดับขั้นความต้องการของมนุษย์ (Hierarchy of needs) มี 5 ระดับ คือ 
  2.1  ความต้องการทางด้านกายภาพ (Physiological needs) เป็นความต้องการเบื้องต้น 
เพื่อความอยู่รอด เช่น ความต้องการเรื่องอาหาร ที่อยู่อาศัย ความต้องการทางเพศ ความต้องการ
ทางด้านร่างกาย จะมีอิทธิพลต่อพฤติกรรมของคนก็ต่อเมื่อความต้องการทั้งหมดของตนยังไม่ได้รับ
การตอบสนองเลย 
  2.2  ความต้องการทางด้านความปลอดภัย (Safety needs) เป็นเรื่องที่เกี่ยวกับ 
ความป้องกันเพื่อให้เกิดความปลอดภัยจากอันตรายต่าง ๆ ที่เกิดกับร่างกาย ความเจ็บป่วย  
และความสูญเสียทางเศรษฐกิจ รวมถึงการรับประกันต่อความมั่นคงในหน้าที่การงานและส่งเสริม 
เพื่อให้เกิดความมั่นคงทางด้านเศรษฐกิจ 
  2.3  ความต้องการความรักและความต้องการทางด้านสังคม (Love and belonging 
needs) เป็นความต้องการที่เกี่ยวกับการอยู่ร่วมกันและการได้รับการยอมรับจากบุคคลอ่ืน 
โดยมีความรู้สึกว่าตนเองนั้นเป็นส่วนหน่ึงของกลุ่มทางสังคมเสมอ เมื่อความต้องการทางด้าน 
กายภาพ และความปลอดภัยได้รับการตอบสนองแล้ว ความต้องการด้านสังคมจะเร่ิมเป็นสิ่งจูงใจ 
ที่ส าคัญต่อพฤติกรรมของคน ทั้งนี้เพราะคนมีนิสัยชอบอยู่รวมกันเป็นกลุ่ม 
  2.4  ความต้องการที่จะได้รับการยกย่อง (Esteem needs) เป็นความต้องการระดับ 
ที่เกี่ยวกับความมั่นใจในตนเอง ในเร่ืองความรู้ ความสามารถ เป็นความต้องการที่จะให้ผู้อ่ืนยกย่อง  
สรรเสริญเมื่อท างานสิ่งใดสิ่งหนึ่งได้ส าเร็จ และความพึงพอในในการมีฐานะเด่นทางสังคม 
  2.5  ความต้องการที่จะได้รับความส าเร็จในชีวิต (Self actualization needs)  
เป็นความต้องการที่พิจารณาถึงสมรรถนะที่เป็นไปได้ของตนและการบรรลุเป้าหมายที่ตนต้องการ  
เมื่อบุคคลมีการพิจารณาถึงบทบาทของเขาในชีวิตว่าจะเป็นอย่างไร  บุคคลนั้นจะผลักดันชีวิต 
ของตนเองให้เป็นไปในทางที่ดีที่สุดตามที่คาดหมายไว้ อย่างไรก็ตามย่อมขึ้นอยู่กับขีดความสามารถ 
ของเขาเองด้วย 
 ทฤษฎี ERG Theory (Alderfer, 1972) มีความเชื่อว่า ความต้องการมีอิทธิพลต่อการแสดง 
พฤติกรรมของมนุษย์เช่นเดียว Maslow แต่ความต้องการตามแนวคิดอัลเดอร์เฟอร์แบ่งออกเป็น  
2 กลุ่มใหญ่ด้วยกัน คือ 
 1.  ความต้องการเพื่อด ารงชีวิต (Existence needs) เป็นความต้องการทางกายภาพและ
ความต้องการทางวัตถุที่ช่วยให้มนุษย์อยู่รอดได้ เช่น อาหาร น้ า ที่อยู่อาศัย นอกจากนี้ค่าจ้างแรงงาน  
ความมั่นคง สวัสดิภาพ ความปลอดภัย ก็จัดอยู่ในกลุ่มนี้เมื่อเปรียบเทียบกับทฤษฎีของมาสโลว์  
ความต้องการเพื่อการด ารงชีวิตและรวมส่วนที่เป็นความต้องการทางด้านสรีระทั้งหมดกับบางส่วน 
ของความต้องการความมั่นคงปลอดภัย 
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 2.  ความต้องการด้านความสัมพันธ์ (Relatedness needs) เป็นความต้องการทางสังคม  
ความต้องการความรู้สึกปลอดภัยในความสัมพันธ์ระหว่างบุคคล  การได้รับการยอมรับ   
การมีชื่อเสียง  และการได้รับการยกย่องจากสังคม เมื่อเทียบกับทฤษฎีของมาสโลว์ความต้องการ 
ด้านความสัมพันธ์นี้จะรวมถึงส่วนที่เป็นความต้องการความมั่นคง ปลอดภัย ความต้องการ 
ทางสังคมและบางส่วนของความต้องการเกียรติและศักดิ์ศรี และความต้องการท าตนให้ประจักษ์ 
ทั้งหมด 
 แนวคิดพื้นฐานของทฤษฎีนี้ มีดังนี้ 
 1.  มนุษย์อาจจะมีความต้องการหลาย ๆ อย่างเกิดขึ้นในเวลาเดียวกัน โดยไม่ต้องจ าเป็นว่า 
ความต้องการเบื้องล่างจะต้องได้รับการตอบสนองก่อนจึงจะเกิดความต้องการเบื้องสูง 
 2.  ยิ่งความต้องการได้รับการตอบสนองน้อยเท่าใด บุคคลก็จะมีความต้องการ 
แต่ละประเภทมากยิ่งขึ้น 
 3.  ยิ่งความต้องการระดับต่ าได้รับการตอบสนองมากเท่าใด บุคคลก็จะมีความต้องการ 
ระดับสูงมากขึ้นไป 
 4.  ยิ่งความต้องการระดับสูงได้รับการตอบสนองน้อยเท่าใด บุคคลก็จะมีความต้องการ  
ในระดับต่ ามากขึ้นเท่านั้น จะเห็นได้ว่า ความต้องการของมนุษย์นั้นมีอยู่มากมาย ทั้งปริมาณ  
และขอบเขต เพราะมนุษย์อยู่ในสภาพแวดล้อมที่ไม่เหมือนกัน การก าหนดความต้องการพื้นฐาน 
จึงแตกต่างกันไป แต่อย่างไรก็ตามหากความต้องการของมนุษย์ได้รับการตอบสนองแล้ว มนุษย์ 
จะเกิดความพึงพอใจในระดับหนึ่ง ซึ่งสิ่งเหล่านนี้จะส่งผลถึงประสิทธิภาพในการปฏบิัติกิจกรรม 
ต่าง ๆ ด้วย 
 ปัจจัยท่ีท าให้เกิดความพึงพอใจ 
 ปัจจัยที่ท าให้เกิดความพึงพอใจในการท างาน 2 ปัจจัย มีดังนี้ (เผชิญ  กิจระการ, 2544, 
หน้า 17)  
 1.  ปัจจัยกระตุ้น (Motivation factors) เป็นปัจจัยที่เกี่ยวกับการงาน ซึ่งมีผลก่อให้เกิด
ความพึงพอในในการท างาน เช่น ความส าเร็จของงาน การได้รับการยอมรับนับถือ ลักษณะของงาน 
ความรับผิดชอบ ความก้าวหน้าในต าแหน่งการงาน 
 2.  ปัจจัยค้ าจุน (Hygiene factors) เป็นปัจจัยที่เกี่ยวข้องกับสิ่งแวดล้อมในการท างาน  
และท าให้บุคคลเกิดความพึงพอใจในการท างาน เช่น เงินเดือนโอกาสที่จะก้าวหน้าในอนาคต  
สถานะของอาชีพ สภาพการท างาน เป็นต้น ในการด าเนินกิจกรรมการเรียนการสอน ความพึงพอใจ 
เป็นสิ่งส าคัญที่กระตุ้นให้ผู้เรียนท างานที่ได้รับมอบหมาย หรือปฏิบัติงานให้บรรลุผลตามวัตถุประสงค์   
โดยมีครูผู้สอนเป็นเพียงผู้อ านวยความสะดวกหรือให้ค าแนะน าปรึกษา  จึงต้องค านึงถึงความพึงพอใจ 
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ในการเรียนรู้ ที่ท าให้ผู้เรียนเกิดความพึงพอใจการเรียนรู้หรือการปฏิบัติงานนั้น ซึ่งมีแนวคิดพื้นฐาน  
ที่ต่างกัน 2 ลักษณะ 
  2.1  ความพึงพอใจน าไปสู่การปฏิบัติงาน การตอบสนองความต้องการผู้ปฏิบัติงาน 
จนเกิดความพึงพอใจ จะท าให้เกิดแรงจูงใจในการเพิ่มประสิทธิภาพการท างานที่สูงกว่าผู้ไม่ได้ 
รับการตอบสนองเป็นศูนย์กลางบรรลุผลส าเร็จ  จึงต้องค านึงถึงการจัดบรรยากาศและสถานการณ์ 
รวมทั้งสื่ออุปกรณ์การเรียน การสอนที่เอ้ืออ านวยต่อการเรียน  เพื่อตอบสนองความพึงพอใจของ 
ผู้เรียนให้มีแรงจูงใจในการท ากิจกรรมบรรลุตามวัตถุประสงค์ของหลักสูตร  ผลของการปฏิบัติงาน 
น าไปสู่ความพึงพอใจ  ความสัมพันธ์ระหว่างความพึงพอใจและผลการปฏิบัติงานจะถูกเชื่อมโยง 
ด้วยปัจจัยอื่น ๆ ผลการปฏิบัติงานที่ดีจะน าไปสู่ผลตอบแทนที่เหมาะสม  ซึ่งในที่สุดจะน าไปสู่ 
การตอบสนองความพึงพอใจ ผลการปฏิบัติงาน  ย่อมได้รับการตอบสนองในรูปของรางวัลหรือ 
ผลตอบแทน ซึ่งแบ่งออกเป็นผลตอบแทนภายใน (Intrinsic rewards) และผลตอบแทนภายนอก 
(Extrinsic rewards) โดยผ่านการรับรู้เกี่ยวกับความยุติธรรมของผลตอบแทน  ซึ่งเป็นตัวบ่งชี้ปริมาณ 
ของผลตอบแทนที่ผู้ปฏิบัติงานได้รับ คือ ความพึงพอใจในงานของผู้ปฏิบัติงานจะถูกก าหนด 
โดยความแตกต่างระหว่างผลตอบแทนที่เกิดขึ้นจริงและการรับรู้เร่ืองเกี่ยวกับความยุติธรรมของ 
ผลตอบแทนที่รับรู้แล้วความพึงพอใจย่อมเกิดขึ้น 
 การสร้างความพึงพอใจในการเรียน 
 สมยศ  นาวีการ (2544, หน้า 125) ได้กล่าวว่า การด าเนินงานกิจกรรมการเรียนการสอนนั้น  
ความพึงพอใจเป็นสิ่งส าคัญที่จะกระตุ้นให้ผู้เรียนท างานที่ได้รับมอบหมายหรือต้องการปฏิบัติให้ 
บรรลุตามวัตถุประสงค์ ครูผู้สอนซึ่งในปัจจุบันเป็นเพียงผู้อ านวยความสะดวกหรือให้ค าแนะน า 
ปรึกษาการท าให้ผู้เรียนเกิดความรู้สึกพึงพอใจในการปฏิบัติงานครูผู้สอนต้องค านึงถึงแนวคิด
พื้นฐานที่มีความแตกต่างกันใน 2 ลักษณะ ต่อไปนี้ 
 1.  ความพึงพอใจน าไปสู่การปฏิบัติการตอบสนองความต้องการผู้ปฏิบัติงาน  
จนเกิดความพึงพอใจ  ซึ่งจะท าให้เกิดแรงจูงใจในการเพิ่มประสิทธิภาพการท างานที่สูงกว่า 
ผู้ที่ไม่ได้รับการตอบสนอง 
 2.  ความพึงพอใจน าไปสู่การกระตุ้นการเสริมแรง เป็นแรงบันดาลในเพื่อให้ผู้ได้รับ 
จากการกระตุ้นด้วยวิธีการหรือเทคนิคต่าง ๆ ได้รับความพึงพอใจอย่างต่อเน่ืองและอยากปฏิบัติ 
เพื่อตอบสนองการเสริมแรงในเชิงบวก ก่อให้เกิดผลสัมฤทธิ์ของการปฏิบัติงานใด ๆ ได้ ดังน้ัน  
ครูผู้สอนที่ต้องการให้กิจกรรมการเรียนการสอนที่เน้นผู้เรียนเป็นส าคัญบรรลุจุดประสงค์ 
ต้องค านึงถึงการจัดบรรยากาศ สถานการณ์ สื่อการสอน ที่เอ้ืออ านวยต่อการเรียนเพื่อตอบสนอง 
ความพึงพอใจของผู้เรียนให้มีแรงจูงใจท ากิจกรรมจนบรรลุจุดประสงค์ 
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 จากแนวคิดที่กล่าวมา เมื่อน ามาใช้ในการฝึกอบรม ผลตอบแทนภายในหรือรางวัลภายใน  
เป็นผลด้านความรู้สึกของผู้เรียนที่เกิดแก่ตัวผู้เรียนเอง เช่น ความรู้สึกต่อความส าเร็จที่เกิดขึ้น  
เมื่อสามารถเอาชนะความยุ่งยากต่าง ๆ และสามารถด าเนินงานภายใต้ความยุ่งยากทั้งหลายได้ส าเร็จ  
ท าให้เกิดความภาคภูมิใจ ความมั่นใจตลอดจนได้รับการยกย่องจากบุคคลอ่ืน ส่วนผลตอบแทน
ภายนอกเป็นรางวัลที่ผู้อ่ืนจัดหาให้มากกว่าที่ตนเองให้ตนเอง เช่น การได้รับค ายกย่องชมเชย  
จากผู้อ านวยการโรงเรียน ครูผู้สอนด้วยกัน 
 สรุปได้ว่า ความพึงพอใจในการฝึกอบรมจะมีความสัมพันธ์กันทางบวก ทั้งนี้ขึ้นอยู่กับ 
กิจกรรมที่ผู้ฝึกอบรมได้ปฏิบัติ ท าให้ผู้ฝึกอบรมได้รับการตอบสนองความต้องการทางด้านร่างกาย 
และจิตใจ ส่วนส าคัญที่จะท าให้เกิดความสมบูรณ์ของชีวิตมากน้อยเพียงใด  
 

งานวิจัยที่เก่ียวข้อง 
 นิตยา  เจียงประเสริฐ (2546) ได้ท าการวิจัยเร่ือง ความคิดเห็นของอาจารย์และนักศึกษา  
คณะบริหารธุรกิจที่มีต่อการน าบทเรียนอิเล็กทรอนิกส์มาใช้กับการเรียนในกระบวนวิชาของ 
คณะบริหารธุรกิจ มหาวิทยาลัยเชียงใหม่ โดยผลของการวิจัยพบว่า อาจารย์ส่วนใหญ่มีความคิดเห็น 
ต่อประโยชน์ของบทเรียนอิเล็กทรอนิกส์ในระดับมาก ขณะที่นักศึกษามีความคิดเห็นต่อประโยชน์ 
ของบทเรียนอิเล็กทรอนิกส์ในระดับกลาง อาจารย์และนักศึกษาส่วนใหญ่มีความต้องการในการน า 
บทเรียนอิเล็กทรอนิกส์มาใช้กับการเรียนการสอนในระดับมาก  
 ธิติมา  เกษศิรินทร์เทพ (2545 อ้างถึงใน อมรรัตน์  ชัยเสนหาญ, 2555) ได้ศึกษาเร่ือง  
การสร้างและหาประสิทธิภาพบทเรียน มัลติมีเดียวิชาหลักการผลิตวัสดุกราฟิกบนเครือข่าย
อินเทอร์เน็ต พบว่า บทเรียนมัลติมีเดียวิชาหลักการผลิตวัสดุกราฟิก บนเครือข่ายอินเทอร์เน็ต 
ที่สร้างขึ้นมีประสิทธิภาพสูงกว่าเกณฑ์ที่ก าหนด เนื่องจากผลการเรียนของผู้เรียนที่เรียนด้วยบทเรียน 
มัลติมีเดียบนเครือข่ายอินเทอร์เน็ต มีผลการเรียนที่สูงกว่าการเรียนปกติอย่างมีนัยส าคัญทางสถิติ 
ที่ระดับ .01 นอกจากนี้ผู้เรียนยังมีทัศนคติที่ดีต่อการเรียนด้วยบทเรียนมัลติมีเดียบนอินเทอร์เน็ต  
เพราะว่าผู้เรียนสามารถเรียนรู้ได้ด้วยตนเอง ในเวลาใดก็ได้สถานที่ใดก็ได้ตามความสะดวกของ 
ผู้เรียนเอง 
 รัชนีกร  สุวรรณภักดี (2547) ได้ศึกษาการพัฒนาบทเรียนบนระบบเครือข่าย เร่ือง  
การใช้เทคโนโลยีทางการศึกษาและสื่อการเรียนรู้เพื่อเปรียบเทียบผลสัมฤทธิ์ทางการเรียน  
ศึกษาความพึงพอใจของนิสิตที่มีต่อบทเรียนบนระบบเครือข่ายและเปรียบเทียบความพึงพอใจ 
ต่อบทเรียนบนระบบเครือข่ายของนิสิตที่มี คุณลักษณะส่วนบุคคลแตกต่างกัน ผลการวิจัยพบว่า  
นิสิตที่เรียนด้วยบทเรียนบนระบบเครือข่ายมีระดับความพึงพอใจต่อการเรียนด้วยบทเรียน 
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ระบบเครือข่าย โดยรวมอยู่ในระดับมาก นิสิตที่มีคุณลักษณะการน าตนเอง แตกตา่งกัน และแรงจูงใจ 
ใฝ่สัมฤทธิ์ทางการเรียนแตกต่างกัน มีผลสัมฤทธิ์ทางการเรียนไม่แตกต่างกัน และไม่มีปฏิสัมพันธ์ 
ระหว่างตัวแปรทั้งสองดังกล่าว นิสิตที่คุณลักษณะการน าตนเองสูงและต่ ามีความพึงพอใจจาก
บทเรียนบนระบบเครือข่ายแตกต่างกันน้อยกว่านิสิตที่มีคุณลักษณะการน าตนเองต่ า 
 นภดล  โรจนอุดมศาสตร์ (2550, บทคัดย่อ) ได้ท าการศึกษาพัฒนาบทเรียนคอมพิวเตอร์ 
ช่วยสอนมัลติมีเดียเพื่อการฝึกอบรม เร่ือง เงินฝากประจ า ส าหรับฝึกอบรมพนักงานธนาคาร 
นครหลวงไทย จ ากัด (มหาชน) เพื่อเปรียบเทียบกับการฝึกอบรมแบบปกติ จ านวน 60 คน พบว่า  
ประสิทธิภาพของบทเรียนมัลติมีเดียเป็น  95.22/ 96.08  ซึ่งสูงกว่าเกณฑ์ 95/ 95 ที่ตั้งไว้   
และผลการเรียนโดยใช้บทเรียนคอมพิวเตอร์ช่วยสอนมัลติมีเดีย ท าให้ผู้เข้ารับการฝึกอบรม 
มีผลสัมฤทธิ์ทางการเรียนสูงกว่าการฝึกอบรมแบบปกติอย่างมีนัยส าคัญทางสถิติที่ระดับ .05 
 ธรรมชาติ  ทองแดง (2547, บทคัดย่อ) ได้วิจัยเร่ือง การพัฒนาบทเรียนคอมพิวเตอร์ 
ช่วยสอน เร่ือง ความรู้เบื้องต้นเกี่ยวกับ บทเรียนคอมพิวเตอร์ช่วยสอน กลุ่มตัวอย่างที่ใช้ในการวิจัย
เป็นนักศึกษาวิชาเอกเทคโนโลยีการศึกษาชั้นปีที่ 2 ปีการศึกษา 2546 คณะศึกษาศาสตร์  
มหาวิทยาลัยสงขลานครินทร์ จ านวน 42 คน ได้มาโดยจากวิธี การสุ่มอย่างง่าย ผลการวิจัยพบว่า  
1) ประสิทธิภาพของกระบวนการ (Process efficiency (E1)) เท่ากับร้อยละ 81.24 ประสิทธิภาพของ 
ผลลัพธ์ (Product efficiency (E2)) เท่ากับร้อยละ 80.50 ซึ่งเป็นไปตามเกณฑ์ที่ก าหนดไว้ สรุปได้ว่า 
บทเรียนคอมพิวเตอร์ช่วยสอนมีประสิทธิภาพ  2) นักศึกษาที่เรียนด้วยบทเรียนคอมพิวเตอร์ 
ช่วยสอน มีความก้าวหน้าทางการเรียนเฉลี่ยเท่ากับร้อยละ 30 คะแนน ซึ่งเป็นไปตามสมมติฐาน  
และ 3) ที่ระดับความเชื่อมั่น 85 เปอร์เซ็นต์ ช่วงความห่างของความก้าวหน้าทางการเรียนของ 
นักศึกษา มีค่าเฉลี่ยของคะแนนระหว่างร้อยละ 27.87 จนถึง 36.03 คะแนน ผลการวิจัยดังกล่าว 
ชี้ให้เห็นว่า บทเรียนคอมพิวเตอร์ช่วยสอน มีประสิทธิภาพตามเกณฑ์มาตรฐานสามารถน าไปใช้ 
ในการเรียนการสอน 
 ธีรศานต ์ ไหลหลั่ง (2549, บทคัดย่อ) ได้วิจัยเร่ือง การออกแบบและประเมินชุดสื่อ 
มัลติมีเดียวิชาการถ่ายภาพทางการศึกษาตามโมเดลการออกแบบของกานเย และบริกส์ การวิจัย 
คร้ังนี้ได้มีวัตถุประสงค์ 1) ออกแบบและประเมินชุดสื่อมัลติมีเดีย วิชาการถ่ายภาพทางการศึกษา  
ตามโมเดลการออกแบบของกานเยและบริกส์  2) เพื่อหาประสิทธิภาพชุดสื่อมัลติมีเดียตามเกณฑ์ 
มาตรฐาน 80/ 80 และ 3) เปรียบเทียบผลสัมฤทธิ์ทางการเรียนระหว่างก่อนเรียนและหลังเรียน 
ด้วยชุดสื่อมัลติมีเดีย กลุ่มตัวอย่างที่ใช้ในการวิจัย นักศึกษาระดับปริญญาตรี สถาบันเทคโนโลยี 
พระจอมเกล้าพระนครเหนือ ที่ลงทะเบียนเรียนวิชาถ่ายภาพทางการศึกษา แบบทดสอบ 
วัดผลสัมฤทธิ์ทางการเรียนและแบบประเมินคุณภาพสื่อการสอนในการทดลองให้กลุ่มตัวอย่าง 
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ท าแบบทดสอบก่อนเรียน เรียนเนื้อหาวิชา ท าแบบฝึกหัดระหว่างเรียน และท าแบบทดสอบ 
หลังเรียน ผลการวิจัยปรากฏว่า ชุดสื่อมัลติมีเดียที่สร้างขึ้นตามโมเดลการออกแบบของกานเย  
และบริกส์ มีค่าประเมินจากผู้เชี่ยวชาญอยู่ในเกณฑ์ดีมาก ชุดสื่อมัลติมีเดียมีประสิทธิภาพ  
85.96/ 83.07 ซึ่งสูงกว่าเกณฑ์ที่ก าหนดไว้ 80/ 80 และผลเปรียบเทียบผลสัมฤทธิ์ทางการเรียน 
ระหว่างเรียนกับหลังเรียน ผลปรากฏว่าคะแนนแบบทดสอบหลังเรียนสูงกว่าคะแนนแบบทดสอบ 
ก่อนเรียน อย่างมีนัยส าคัญทางสถิติที่ระดับ .05 
 ขณะที่ นงเยาว์  เอ่ียมภาคีนิวัฒน์ (2550) ได้ศึกษาการพัฒนาบทเรียนคอมพิวเตอร์ 
ช่วยสอนอินเตอร์เน็ต เรื่อง ฐานข้อมูลเบื้องต้น โดยศึกษากับกลุ่มตัวอย่างที่เป็นนักศึกษาชั้นปีที่ 2  
ของมหาวิทยาลัยราชภัฏ ผลการศึกษา พบว่า การเรียนด้วยบทเรียนคอมพิวเตอร์ช่วยสอน 
บนอินเตอร์เน็ต ท าให้นักศึกษามีผลสัมฤทธิ์ทางการเรียนสูงขึ้นอย่างมีนัยส าคัญที่ระดับ .05  
เมื่อเปรียบเทียบคะแนนเฉลี่ยก่อนเรียนและหลังเรียน อีกทั้งนักศึกษามีความคิดเห็นที่ดีและ 
มีความพึงพอใจต่อการใช้บทเรียนคอมพิวเตอร์ช่วยสอนบนอินเตอร์เน็ต 
 รชตวรรณ  เชื้อเพชร (2549) การพัฒนาบทเรียนคอมพิวเตอร์ช่วยฝึกอบรม เร่ือง  
เคร่ืองหมายจราจรและพฤติกรรมในการขับขี่อย่างปลอดภัย ส าหรับผู้เรียนช่วงอายุ 15-18 ปี  
การวิจัยครั้งนี้มีจุดมุ่งหมายเพื่อพัฒนาบทเรียนคอมพิวเตอร์ช่วยฝึกอบรม เร่ือง เคร่ืองหมายจราจร  
และพฤติกรรมในการขับขี่อย่างปลอดภัย ส าหรับผู้เรียนช่วงอายุ 15-18 ปี ให้มีประสิทธภิาพ 
ตามเกณฑ์ 80/ 80 และเป็นไปตามคุณสมบัติที่ก าหนดไว้ ผู้วิจัยได้ท าการศึกษาวิเคราะห์ปัญหา  
ตามหลักสูตรการอบรมผู้ขอรับใบอนุญาตขับขี่รถตามกรรมการขนส่งก าหนด ก าหนดวัตถุประสงค์
และแบ่งเน้ือหาออกเป็น 6 เร่ืองย่อย แล้วจึงท าการพัฒนา โดยใช้โปรแกรม Authorware  
ในการก าหนดโครงสร้างและใช้โปรแกรม Flash ในการน าเสนอกิจกรรมการเรียนการสอน  
กระบวนการพัฒนาเร่ิมจากการเขียนผังงานสตอร่ีบอร์ด และท าการเขียนโปรแกรม แล้วน าบทเรียน 
ที่พัฒนาขึ้นนี้ไปทดลองใช้แบบรายบุคคลและกลุ่มเล็ก เพือ่หาข้อบกพร่องและปรับปรุงแก้ไข  
หลังจากนั้นน าบทเรียนที่ปรับปรุงแก้ไขแล้วไปหาประสิทธิภาพกับกลุ่มตัวอย่าง  โดยให้กลุ่มตัวอย่าง 
ซึ่งเป็นผู้เรียนบทเรียนคอมพิวเตอร์ช่วยฝึกอบรม ท าแบบฝึกหัดระหว่างบทเรียนและท าแบบทดสอบ 
หลังเรียน และตอบแบบประเมินความคิดเห็นที่มีต่อบทเรียนโดยใช้แบบประเมินค่า 5 ระดับ  
ผลการวิจัยท าให้ได้บทเรียนคอมพิวเตอร์ช่วยฝึกอบรม เร่ือง เคร่ืองหมายจราจร และพฤติกรรม 
ในการขับขี่อย่างปลอดภัยที่มีประสิทธิภาพ 86.67/ 84.56  ซึ่งเป็นไปตามเกณฑ์ที่ตั้งไว้  
และจากการประเมินความคิดเห็นของนักเรียนที่มีต่อบทเรียนคอมพิวเตอร์มัลติมีเดีย พบว่า  
โดยเฉลี่ยแล้วนักเรียนมีความพึงพอใจต่อบทเรียนคอมพิวเตอร์มัลติมีเดียอยู่ในระดับดี 
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 วิชัย  นภาพงศ์, ณรัณ  ศรีวิหะ และศิริวรรณ  แดงมะแจ้ง (2549) เสนอรายงานการวิจัย
เร่ือง การพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง เทคโนโลยีกราฟิก มีวัตถุประสงค์ 
เพื่อพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เร่ือง เทคโนโลยีทาง กราฟิก ซึ่งประกอบด้วยเนื้อหา  
5 บท คือ ความรู้เบื้องต้นของกราฟิก องค์ประกอบของงานกราฟิก หลักการออกแบบงานกราฟิก 
จิตวิทยาในการออกแบบงานกราฟิก และกราฟิกเพื่อการศึกษา ประชากรที่ใช้ในการวิจัย 
เป็นนักศึกษาระดับปริญญาตรี วิชาเอกและวิชาโทเทคโนโลยีการศึกษา คณะศึกษาศาสตร์  
มหาวิทยาลัยสงขลานครินทร์ ปีการศึกษา 2547 กลุ่มตัวอย่างที่ใช้ในการวิจัยได้มา โดยวิธีการสุ่ม
หลายขั้นตอน จ านวน 42 คน การทดลองแบบกลุ่มย่อย จ านวน 9 คน และการทดลอง แบบภาคสนาม  
จ านวน 30 คน เคร่ืองมือในการวิจัย ได้แก่ แบบสอบถามความคิดเห็นเกี่ยวกับบทเรียน แบบประเมิน 
คุณภาพบทเรียน  แบบประเมินความพึงพอใจของผู้เรียนที่มีต่อบทเรียน  และแบบทดสอบ 
วัดประสิทธิภาพของบทเรียน 5 บท ได้มีการหาประสิทธิภาพของกระบวนการและผลลัพธ์ของ 
บทเรียน โดยใช้เกณฑ์ 60/ 60 ผลการวิจัยพบว่า บทเรียนผ่านเครือข่ายอินเทอร์เน็ต เร่ือง เทคโนโลยี 
ทางกราฟิก ในวิชาเทคโนโลยีทางกราฟิกและสิ่งพิมพ์ ในการศึกษาทุกเร่ือง ได้มีประสิทธิภาพ 
ของกระบวนการและผลลัพธเ์ป็นไปตามเกณฑ์ตั้งไว้ คือ เร่ือง ความรู้เบื้องต้นของกราฟิก 
ประสิทธิภาพร้อยละ 82.50/ 81.77 เร่ือง องค์ประกอบของงานกราฟิก ประสิทธิภาพ 83.36/ 82.50  
เร่ือง หลักการออกแบบงานกราฟิก มีประสิทธิภาพ 84.08/ 82.08 เร่ือง จิตวิทยาในการออกแบบ 
งานกราฟิกประสิทธิภาพ 85.00/ 82.43 และเร่ือง กราฟิกเพื่อการศึกษา ประสิทธิภาพ 83.31/ 82.25  
ผู้เรียนมีความพึงพอใจต่อบทเรียนเท่ากับ 4.41 ซึ่งอยู่ในระดับมาก สรุปได้ว่า บทเรียนมีความเหมาะสม 
จะน าไปใช้ในการเรียนการสอนต่อไป 
 จากรายงานการวิจัย ผู้วิจัยจึงได้ท าการวิจัยเร่ืองการพัฒนาบทเรียนอิเล็กทรอนิกส์ 
เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม  
เพื่อเป็นสื่อในการฝึกอบรม ของครูโรงเรียนอ่างศิลาพิทยาคม  จะได้น าความรู้ไปใช้ให้เกิด 
ประโยชนม์ากขึ้น  
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บทที ่3 
วิธีด าเนินการวิจัย 

 
 การด าเนินการวิจัยการพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้าง
หนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม คร้ังนี้  ผู้วิจัยได้ก าหนดหัวข้อที่ส าคัญ
เพื่อให้เป็นไปตามวัตถุประสงค์ที่ก าหนดไว้  ผู้วิจัยจะเสนอวิธีด าเนินการวิจัย ดังต่อไปนี้ 
 1.  ประชากรและกลุ่มตัวอย่าง 
 2.  เคร่ืองมือที่ใช้ในการวิจัย 
 3.  วิธีสร้างและหาคุณภาพของเคร่ืองมือที่ใช้ในวิจัย 
 4.  วิธีด าเนินการทดลอง 
 5.  การวิเคราะห์ข้อมูลและสถิติที่ใช้ในการวิเคราะห์ข้อมูล 
 

ประชากรและกลุ่มตัวอย่าง 
 ประชากร  
 ประชากร ได้แก่ ประชากรที่ใช้ในการวิจัยครั้งนี้เป็นครูโรงเรียนอ่างศิลาพิทยาคม 
จ านวนครูทั้งหมด 55 คน 
 กลุ่มตัวอย่าง 
 กลุ่มตัวอย่างที่ใช้ในการวิจัยคร้ังนี้ ได้แก่ ครูโรงเรียนอ่างศิลาพิทยาคม รวม 32 คน 
ได้มาจากการเลือกแบบเจาะจง (Purposive sampling) โดยจงเจาะเลือกครูจาก 8 กลุ่มสาระวิชา  
กลุ่มสาระวิชาละ 4 คน 
 

เครื่องมือที่ใช้ในการวิจัย 
 เคร่ืองมือที่ใช้ในการศึกษาคร้ังนี้มี 3 ประเภท คือ 
 1.  บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์
ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม  
 2.  แบบทดสอบวัดผลสัมฤทธิ์การอบรม แบบปรนัย ชนิดเลือกตอบ 4 ตัวเลือก จ านวน  
25 ข้อ ที่ใช้วัดความรู้ก่อนและหลังอบรม ด้วยบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง 
การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม  
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 3.  แบบสอบถามความพึงพอใจ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม ที่มีต่อการเรียน 
ด้วยบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครู 
โรงเรียนอ่างศิลาพิทยาคม จ านวน 15 ข้อ 
 

วิธีสร้างและหาคุณภาพของเครื่องมือที่ใช้ในการวิจัย 
 เคร่ืองมือที่ใช้ในการวิจัยทดลองครั้งนี้ มีวิธีสร้างและหาคุณภาพเคร่ืองมือแต่ละชนิด  
ดังนี้ 
 1.  บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์  
ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม มีขั้นตอนการสร้างและหาคุณภาพดังนี้ 
  1.1  ศึกษาการพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสือ
อิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม 
  1.2  ศึกษาข้อมูลทางวิชาการที่เกี่ยวข้องจาก หนังสือ เอกสาร งานวิจัย  
และอินเตอร์เน็ต ที่เกี่ยวข้องเพื่อรวบรวมเป็นข้อมูลในการเรียบเรียงเน้ือหา 
  1.3  ศึกษารายละเอียดเกี่ยวกับหลักการ และวิธีการสร้างบทเรียนอิเล็กทรอนิกส์  
จากเอกสาร ต ารา และงานวิจัย เพื่อเป็นแนวทางการจัดเน้ือหาในหนังสืออ่านเพิ่มเติม 
  1.4  วางแผนการพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้าง 
หนังสืออิเล็กทรอนิกส์ ดังนี้ 
   1.4.1  ก าหนดรูปแบบการสร้างบทเรียนอิเล็กทรอนิกส์ 
   1.4.2  ก าหนดจุดประสงค์ของบทเรียนอิเล็กทรอนิกส์ 
   1.4.3  ก าหนดระดับกลุ่มตัวอย่าง เพื่อใช้เป็นแนวทางในการสร้างบทเรียน 
ให้ตรงกับกลุ่มตัวอย่างซึ่งเป็นครูโรงเรียนอ่างศิลาพิทยาคม 
   1.4.4  ก าหนดเนื้อหา โครงสร้างเนื้อหา และหัวเร่ืองรวมทั้งก าหนดชื่อเร่ือง 
ให้สอดคล้องกัน เพื่อง่ายต่อการท าความเข้าใจ 
  1.5  เรียบเรียงเน้ือหาตามเร่ืองที่ก าหนด พร้อมทั้งจัดหาภาพประกอบให้สอดคล้องกับ
เน้ือหา และมีแบบทดสอบก่อนเรียนและหลังเรียน  
  1.6  น าการพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสือ
อิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม ที่พัฒนาขึ้นเสนอต่อ ผู้ทรงคุณวุฒิ 5 ท่าน  
เพื่อตรวจสอบความสมบูรณ์ ความถูกต้องของบทเรียน และความถูกต้องตามรูปแบบบทเรียน 
อิเล็กทรอนิกส์ พิจารณาความสอดคล้องของเน้ือหาและจุดประสงค์ด้วยค่าดัชนี ความสอดคล้อง  
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(IOC) และแก้ไขปรับปรุงตามข้อเสนอแนะ ค่าความสอดคล้อง (IOC) ก าหนดระดับความคิดเห็น  
ในการพิจารณา ดังนี้ 
  +1 หมายถึง แน่ใจว่าสอดคล้อง 
    0 หมายถึง ไม่แน่ใจว่าสอดคล้อง 
   -1 หมายถึง แน่ใจว่าไม่สอดคล้อง 
  1.7  ค านวณค่าดัชนีความสอดคล้อง (IOC) ของผู้เชี่ยวชาญแต่ละท่าน หาค่าเฉลี่ย 
โดยยึดเกณฑ์การตัดสิน .50 ขึ้นไป  จึงจะถือว่าเป็นบทเรียนที่ใช้ได้ ผลการประเมิน การพัฒนา 
บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียน 
อ่างศิลาพิทยาคม ปรากฏว่าได้ค่าเฉลี่ย IOC เท่ากับ 1.00 
  1.8  การทดลองแบบหนึ่งต่อหนึ่ง  (One to one testing)  คือ  ครูโรงเรียน 
อ่างศิลาพิทยาคม จ านวน  3  คน  ที่ไม่ใช่กลุ่มตัวอย่าง  โดยคัดเลือกครูที่มีทักษะด้านคอมพิวเตอร์ 
เก่ง ปานกลาง  พอใช้  ระดับละ  1  คน ผู้วิจัยได้ท าการสังเกตและสอบถามข้อมูลจากครูและ 
จดบันทึกข้อบกพร่องของบทเรียนอิเล็กทรอนิกส์ พบว่า ตัวอักษรไม่ชัดเจน  และมีขนาดเล็ก   
ผู้วิจัยได้ปรับปรุงแก้ไขตามผลการทดลองดังกล่าว  ก่อนจะด าเนินการขั้นต่อไป 
  1.9  การทดลองแบบกลุ่มเล็ก (Small group testing) คือ ครูโรงเรียนอ่างศิลาพิทยาคม  
จ านวน 9 คน ที่ไม่ใช่กลุ่มตัวอย่าง ผู้วิจัยได้ท าการเก็บข้อมูลเพื่อตรวจสอบหาประสิทธิภาพของ
บทเรียนอิเล็กทรอนิกส์ โดยให้ครู ศึกษาจากบทเรียน ทดสอบแบบย่อย และทดสอบหลังอบรม  
น าคะแนนจากการทดสอบไปหาประสิทธิภาพของบทเรียนอิเล็กทรอนิกส์ พบว่า บทเรียน 
อิเล็กทรอนิกส์  มีประสิทธิภาพเท่ากับ 75.11/ 79.11 ศึกษาหาข้อบกพร่อง ผู้วิจัยจึงน าข้อบกพร่อง 
เหล่านั้นไปปรับปรุงแก้ไข หลังจากแก้ไขแล้วน าบทเรียนอิเล็กทรอนิกส์ น าเสนอผู้เชี่ยวชาญ  
ตรวจสอบความถูกต้องอีกคร้ังก่อนน าไปใช้ในการทดลองจริงกับกลุ่มทดลองภาคสนาม (Field   
testing) ต่อไป 
 2.  แบบทดสอบวัดผลสัมฤทธิ์ มีขั้นตอนการสร้างและหาคุณภาพ ดังนี้ 
  2.1  ศึกษาวิธีการและหลักเกณฑ์ในการออกข้อสอบแบบปรนัยชนิดเลือกตอบจาก 
หนังสือการวัดผลและประเมินผลต่าง ๆ 
  2.2  ศึกษาเน้ือหา เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์  
  2.3  วิเคราะห์เน้ือหาเพื่อใช้ในการก าหนดความส าคัญของเน้ือหาที่ต้องการวัด  
น ามาก าหนดน้ าหนักของข้อสอบ 
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  2.4  สร้างแบบทดสอบวัดผลสัมฤทธิ์ เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ เป็นแบบ 
ปรนัยชนิด 4 ตัวเลือก จ านวน 40 ข้อ เพื่อคัดเลือกไว้ใช้จริง จ านวน 25 ข้อ ซึ่งครอบคลุมเนื้อหา 
สาระทั้งหมด 
  2.5  น าต้นฉบับของแบบทดสอบวัดผลสัมฤทธิ์ เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์  
ที่สร้างขึ้นเสนอต่อผู้ทรงคุณวุฒิ 5 ท่าน ชุดเดิม เพื่อตรวจสอบโดยใช้ค่าดัชนีความสอดคล้อง (IOC) 
ระหว่าง ข้อค าถามของแบบทดสอบกับจุดประสงค์การเรียนรู้ ดังนี้ 
  + 1 หมายถึง แน่ใจว่าข้อค าถามสอดคล้องกับจุดประสงค์ 
     0 หมายถึง ไม่แน่ใจว่าข้อค าถามสอดคล้องกับจุดประสงค์ 
    -1 หมายถึง แน่ใจว่าข้อค าถามไม่สอดคล้องกับจุดประสงค์  
  2.6  หาค่าดัชนีความสอดคล้อง (IOC) ของผู้ทรงคุณวุฒิ พิจารณาลงความเห็นว่า 
แบบทดสอบวัดผลสัมฤทธิ์แต่ละข้อ ค าถามสอดคล้องกับจุดประสงค์การเรียนรู้มีค่า .50 ขึ้นไป 
  2.7  น าแบบทดสอบไปทดลองใช้กับตัวแทนที่ไม่ใช่กลุ่มตัวอย่าง ที่มีลักษณะ
คล้ายคลึงกับกลุ่มตัวอย่าง จ านวน 30 คน ซึ่งไม่ใช่กลุ่มตัวอย่างประชากร จากนั้นน าคะแนนที่ได้ 
มาวิเคราะห์ข้อมูลเพื่อหาค่าความเที่ยง (Reliability) ของแบบวัดโดยใช้สูตร KR-20 ของคูเดอร์- 
ริชาร์ดสัน ซึ่งมีเกณฑ์ว่า ค่าความเที่ยงต้องมีค่าตั้งแต่ .60 ขึ้นไป รวมทั้งหาค่าความยาก (Difficulty)  
และค่าอ านาจจ าแนก (Discrimination) ขอแบบทดสอบผลสัมฤทธิก์ารอบรม โดยมีเกณฑ์ 
ค่าความยาก (p) ต้องอยู่ระหว่าง .20-.80 และค่าอ านาจจ าแนก (r)  มีค่า .20 ขึ้นไป  ซึ่งได้ผล 
การวิเคราะห์คุณภาพดังนี้ 
  ค่าความเที่ยง  มีค่า .77 
  ค่าความยากง่าย  มีค่า .24-.80 
  ค่าอ านาจจ าแนก  มีค่า .27-.68 
  2.8  น าผลทดสอบมาวิเคราะห์ เป็นรายข้อของแบรนแนน (Brennan) หาค่าความยากง่าย  
(p) ค่าอ านาจจ าแนก (r) คัดเลือกข้อค าถามที่มีค่าความยากง่าย (p) ระหว่าง .20-.80 ค่าอ านาจจ าแนก (r)  
ตั้งแต่ .20 ขึ้นไป เก็บไว้ใช้จริง จ านวน 25 ข้อ โดยมีค่าความยากง่าย (p) อยู่ระหว่าง .45-.78  
ค่าอ านาจจ าแนก (r) อยู่ระหว่าง .22-.73 หาค่าความเชื่อมั่น ได้ค่าความเชื่อมั่นของแบบทดสอบ 
วัดผลสัมฤทธิ์ทั้งฉบับเท่ากับ .82 
  2.9  จัดพิมพ์เป็นแบบทดสอบวัดผลสัมฤทธิ์ฉบับสมบูรณ์ 
 3.  แบบสอบถามความพึงพอใจของครูโรงเรียนอ่างศิลาพิทยาคม ที่มีต่อการฝึกอบรม 
ด้วยบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ มีขั้นตอน 
การสร้างและหาคุณภาพ ดังนี ้
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  3.1  ศึกษาเอกสาร ทฤษฎี หลักการ และงานวิจัยที่เกี่ยวข้องกับการสร้างแบบสอบถาม 
  3.2  สร้างแบบสอบถามความพึงพอใจของครูโรงเรียนอ่างศิลาพิทยาคม ที่มีต่อ
บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียน
อ่างศิลาพิทยาคม  ซึ่งเป็นแบบสอบถามแบบมาตราส่วนประมาณค่า (Rating scale)  5  ระดับ  
จ านวน 15 ข้อ โดยก าหนดการให้ค่าคะแนน ดังนี้ 
  คะแนน  5  คะแนน หมายถึง มีความพึงพอใจมากที่สุด 
  คะแนน  4  คะแนน หมายถึง มีความพึงพอใจมาก 
  คะแนน  3  คะแนน หมายถึง มีความพึงพอใจปานกลาง 
  คะแนน  2  คะแนน หมายถึง มีความพึงพอใจน้อย 
  คะแนน  1  คะแนน หมายถึง มีความพึงพอใจน้อยที่สุด 
  3.3  น าต้นฉบับของแบบสอบถามความพึงพอใจของครูโรงเรียนอ่างศิลาพิทยาคม 
ที่มีต่อการเรียนด้วยบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์  
ที่สร้างขึ้น เสนอต่อผู้ทรงคุณวุฒิ ชุดเดิม 5 ท่าน เพื่อพิจารณาตรวจสอบ ด้วยค่าดัชนีความสอดคล้อง  
(IOC) ผลการประเมินได้ค่าเฉลี่ยเท่ากับ 1 และปรับปรุงตามข้อเสนอแนะ 
  3.4  น าแบบสอบถามความพึงพอใจของครูโรงเรียนอ่างศิลาพิทยาคม ที่มีต่อการเรียน 
ด้วยบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ที่สร้างขึ้นเสนอ 
ผู้เชี่ยวชาญชุดเดิมพิจารณาตรวจสอบความถูกต้อง ความเที่ยงตรงของข้อค าถามแต่ละข้อ (IOC)  
คัดเลือกไว้ใช้จริง 15 ข้อ มีค่าอยู่ระหว่าง .70 ถึง 1.00 ซึ่งอยู่ในเกณฑ์ที่ใช้ได้ 
  3.5  พิมพ์แบบสอบถามความพึงพอใจของครูโรงเรียนอ่างศิลาพิทยาคม ที่มีต่อ 
การเรียนด้วยบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์  
ฉบับจริงเพื่อน าไปเก็บข้อมูลต่อไป 
 

วิธีด าเนินการทดลอง 
 ผู้วิจัยได้เลือกครูโรงเรียนอ่างศิลาพิทยาคม ที่ยัง ไม่เคยเข้ารับการฝึกอบรม เร่ือง บทเรียน 
อิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ซึ่งเป็นกลุ่มตัวอย่างจ านวน  
32 คน ด าเนินการตามขั้นตอน ดังนี้ 
 1.  จัดเตรียมบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสือ 
อิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม ที่สร้างขึ้นบนเคร่ืองคอมพิวเตอร์ที่ท าหน้าที่ 
เป็นเซิร์ฟเวอร์ (Web server) โดยผ่านระบบเครือข่ายอินทราเน็ต (Intranet) ภายในห้องปฏิบัติการ 
คอมพิวเตอร์ 
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 2.  ชี้แจงให้ผู้เข้ารับการอบรมทราบถึงวัตถุประสงค์ของการทดลอง และความร่วมมือ 
ในการทดลอง เพื่อให้ได้ผลตามสภาพความเป็นจริง จากนั้นอธิบายถึงวิธีการเรียกใช้งานบทเรียน 
ตลอดจนค าแนะน าต่าง ๆ ในการใช้งานโปรแกรม 
 4.  เมื่อผู้เข้ารับการฝึกอบรมได้ฝึกอบรมตามบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม  
เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม เรียนตามบทเรียนได้
น าเสนอเร่ิมตั้งแต่ ศึกษาวัตถุประสงค์ เรียนตามเนื้อหาในหน่วยต่าง ๆ และแบบฝึกหัดระหว่าง 
การฝึกอบรม 
 5.  เมื่อผู้เข้ารับการอบรม เรียนครบทุกหน่วยการเรียนแล้ว ให้ผู้เรียนท าแบบทดสอบ 
หลังการฝึกอบรม 
 
ตารางที่ 1 ขั้นตอนการอบรมด้วยบทเรียนอิเล็กทรอนิกส์ เร่ืองการสร้างหนังสืออิเล็กทรอนิกส์ 
 
ขั้นตอน

ท่ี 
แผนการสอนท่ี/ เนื้อหา 

จ านวน
ชั่วโมง 

1 ท าแบบทดสอบก่อนอบรม 1 

2 ชี้แจงวัตถุประสงค์การอบรม,การใช้บทเรียนอิเล็กทรอนิกส์ 
ในการอบรม 

1 

3 ผู้เข้าอบรมศึกษาเน้ือหาและท าแบบฝึก เน้ือหาประกอบด้วย 2 

เร่ืองที่ 1 การสร้างบทเรียนอิเล็กทรอนิกส์ 

เร่ืองที่ 2 การจัดรูปแบบหนังสือ 

เร่ืองที่ 3 การแทรกไฟล์ภาพและไฟล์มลัติมีเดีย 

เร่ืองที่ 4 การปรับแต่งหนังสือ 

เร่ืองที่ 5 การสร้างแผ่นซีดีเพื่อเผยแพร่ผลงาน 

4 ผู้เข้าอบรมฝึกสร้างหนังสืออิเล็กทรอนิกส์ 1 

5 ท าแบบทดสอบหลังอบรม 1 

6 ท าแบบทดสอบความพึงพอใจของบทเรียนอิเล็กทรอนิกส์ 1 

รวม 7 
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 6.  สอบถามความพึงพอใจของผู้เข้ารับการฝึกอบรมที่เข้ารับการฝึกอบรมหลังจาก 
จบบทเรียนพร้อมกับท าแบบทดสอบหลังบทเรียนเรียบร้อยแล้ว โดยให้ผู้เข้ารับการฝึกอบรม 
ที่เข้ารับการฝึกอบรมบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ 
ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม กรอกแบบสอบถามความพึงพอใจ 
 

การวิเคราะห์ข้อมูลและสถิติที่ใช้ในการวิเคราะห์ข้อมูล 
 การวิเคราะห์ข้อมูล ผู้วิจัยใช้สถิตเพื่อการวิเคราะห์ ดังนี้  
 1.  สูตรที่ใช้ในการค านวณ 
 

 สูตรที่ 1   E1 =       100



A
N

X
 

 
 E1  คือ  ค่าประสิทธิภาพของกระบวนการเรียนรู้ 
  X คือ  ผลรวมของคะแนนกิจกรรมระหว่างเรียนของผู้เรียนทุกคน (N คน) 
 N  คือ  จ านวนผู้เรียนที่ใช้ในการประเมิน 
 A  คือ  คะแนนเต็มของกิจกรรมระหว่างเรียน 
 

 สูตรที่ 2   E2 =       100



B
N

F
 

 
 E2  คือ  ค่าประสิทธิภาพของผลลัพธ์การเรียนรู้ 
 F  คือ  ผลรวมของคะแนนที่ได้จากแบบทดสอบหลังเรียนของผู้เรียนทุกคน (N คน) 
 N  คือ  จ านวนผู้เรียนที่ใช้ในการประเมิน 
 B  คือ  คะแนนเต็มของแบบทดสอบหลังเรียน  
 
 2.  การทดสอบที (t-test)  
 

     t    =     

1
 



n
D)(Dn

D
22

   เมื่อ   df  =  n - 1 
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 3.  ค่าเฉลี่ย  ( X )  โดยใช้สูตร  
 

  สูตร  X      =       
N

X    

 
 X  คือ  ค่าเฉลี่ย 
 X คือ  ผลรวมของข้อมูลทั้งหมด 
 N คือ  กลุ่มตัวอย่าง 
 
 4.  ค่าเบี่ยงเบนมาตรฐาน (บุญชุม  ศรีสะอาด, 2545, หน้า 101-103) 
 

  สูตร  SD      =     1)N(N
X)(XN 22



   

 
 เมือ่ SD คือ  ค่าเบี่ยงเบนมาตรฐาน 
   X คือ  ข้อมูลแต่ละตัว 
   N คือ  กลุ่มตัวอย่าง 
    คือ  ผลรวม 
 
 5.  สถิติที่ใช้ในการหาคุณภาพของเคร่ืองมือ 
  5.1  หาค่าดัชนีความสอดคล้อง IOC ใช้สูตร (ล้วน  สายยศ และอังคณา  สายยศ, 2545, 
หน้า 249) 

  สูตร  IOC      =      
N

R  

 
  IOC คือ  ดัชนีความสอดคล้อง 
  R คือ  ผลรวมของคะแนนความคิดเห็นของผู้เชี่ยวชาญ 
  N คือ  จ านวนผู้เชี่ยวชาญ 
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  5.2  หาค่าความยาก-ง่ายของแบบทดสอบ แทนด้วย (p) และค่าอ านาจจ าแนกของ
แบบทดสอบ แทนด้วย (r) โดยค านวณค่าจากสูตร (ยุทธ  ไกยวรรณ์, 2550, หน้า 96-97) 
 

  สูตร  p     =     
2N

LH   

 
  p คือ  ค่าความยาก-ง่ายของแบบทดสอบ 
  H คือ  จ านวนคนตอบถูกในกลุ่มคะแนนสูง 
  L คือ  จ านวนคนตอบถูกในกลุ่มคะแนนต่ า 
  N คือ  จ านวนคนกลุ่มสูงหรือกลุ่มต่ า 
 

  สูตร  r       =      N
LH 

 
 
  r คือ  ค่าอ านาจจ าแนก 
  H คือ  จ านวนคนตอบถูกในกลุ่มคะแนนสูง 
  L คือ  จ านวนคนตอบถูกในกลุ่มคะแนนต่ า 
  N คือ  จ านวนคนกลุ่มสูงหรือกลุ่มต่ า 
 
  5.3  หาค่าความเชื่อมั่นของคูเดอร์ ริชาร์ดสัน (Kuder-Richardson) ใช้สูตร KR-20  
(ยุทธ  ไกยวรรณ์, 2550, หน้า 79) 
 

  สูตร  rtt       =    










 


 2S
pq1

1k
k  

 
  rtt คือ  ค่าความเชื่อถือได้ 
  k คือ  จ านวนข้อ 
  p คือ  สัดส่วนของคนที่ท าถูกแต่ละข้อ 
  q คือ  สัดส่วนของคนที่ท าผิดในแต่ละข้อ =  1 - p 
  S2 คือ  ความแปรปรวนของคะแนนทั้งฉบับ 
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  5.4   หาค่าสัมประสิทธิอัลฟาของครอนบาค (Cronbach’s alpha coefficient)    
(ยุทธ  ไกยวรรณ์, 2550, หน้า 84)  
 

  สูตร       =      






 


2
t

2
l

S
S1

1k
k  

 
   คือ  ค่าความเชื่อมั่น 
  k คือ  จ านวนข้อ 
  2

lS  คือ  ค่าความแปรปรวนของคะแนนของข้อสอบแต่ละข้อ 
  2

tS  คือ  ความแปรปรวนของคะแนนทั้งฉบับ 
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บทที ่4 
ผลการวิจัย 

 
การน าเสนอผลการวิจัย 
 การวิเคราะห์ผลข้อมูลงานวิจัยการพัฒนาบทเรียนอิเล็กทรอนิกส์ เร่ือง บทเรียน
อิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียน 
อ่างศิลาพิทยาคม ผู้วิจัยได้น าเสนอผลการวิจัยตามล าดับ ดังนี ้
 ตอนที่ 1  ผลการพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสือ 
อิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม  
 ตอนที่ 2  ผลการทดสอบประสิทธิภาพการพัฒนาบทเรียนอิเล็กทรอนิกส์ 
เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม 
 ตอนที่ 3  ผลการเปรียบเทียบผลสัมฤทธิ์ก่อนการอบรมและหลังอบรมด้วยบทเรียน 
อิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ 
 ตอนที่ 4  ผลการศึกษาความพึงพอใจของครูโรงเรียนอ่างศิลาพิทยาคมที่มีต่อบทเรียน 
อิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์  
 

สัญลักษณ์ที่ใช้ในการวิเคราะห์ข้อมูล 
 X  แทน ค่าเฉลี่ย 
 SD แทน ความเบี่ยงเบนมาตรฐาน 
 n แทน จ านวนกลุ่มตัวอย่าง 
 t แทน ค่าสถิติการแจกแจง t 
 * แทน นัยส าคัญทางสถิติที่ระดับ .05 
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ผลการวิเคราะห์ข้อมูล 
 ตอนท่ี 1  ผลการพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสือ
อิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม เนื้อหา จ านวน 5 เร่ือง ได้แก่ 
 เร่ืองที่ 1 การสร้างบทเรียนอิเล็กทรอนิกส์ 
 เร่ืองที่ 2 การจัดรูปแบบหนังสือ 
 เร่ืองที่ 3 การแทรกไฟล์ภาพและไฟล์มลัติมีเดีย 
 เร่ืองที่ 4 การปรับแต่งหนังสือ 
 เร่ืองที่ 5 การสร้างแผ่นซีดีเพื่อเผยแพร่ผลงาน 
 โดยเนื้อหา น าเสนอผ่านโปรแกรมจัดการเรียนการสอนออนไลน์ Moodle (รายละเอียด 
การเรียนตามภาคผนวก ค) บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เป็นการอบรมที่สอดคล้องกับ
ทฤษฎีความแตกต่างระหว่างบุคคล  ซึ่งผู้อบรมแต่ละคนมีความสามารถในการเรียนรู้ช้าเร็ว 
แตกต่างกัน  ดังนั้นบทเรียนนี้ช่วยให้ผู้อบรมรู้สึกพอใจและไม่เกิดความกดดันในขณะอบรม  
เมื่อผู้อบรมเรียนรู้ไม่ทันผู้อ่ืน  ท าให้ไม่รู้สึกเครียดในระหว่างการอบรม พบว่า บทเรียนอิเล็กทรอนิกส์ 
เพื่อการฝึกอบรม  ท าให้ผู้อบรมสนใจและกระตือรือร้นที่จะเรียนรู้ในบทเรียนมากยิ่งขึ้น  เน่ืองจาก 
บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม มีข้อความ ภาพ  ส่งผลให้บทเรียนน่าสนใจและช่วยกระตุ้น 
ให้ผู้อบรมสนใจบทเรียนมากยิ่งขึ้น 
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ตารางที่ 2 ผลการหาคุณภาพของพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง  
 การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม ทดลองครั้งที่ 2   
 จ านวน 9 คน 
 

คนที่ 
คะแนนระหว่างอบรม รวมคะแนน  รวมคะแนน  

เร่ืองท่ี 1 เร่ืองท่ี 2 เร่ืองท่ี 3 เร่ืองท่ี 4 เร่ืองท่ี 5 
25 คะแนน  

(E1) 

25 คะแนน  

(E2) 

1 4 5 5 4 5 23 22 

2 4 3 3 4 4 18 20 

3 4 4 5 4 4 21 21 

4 3 4 3 4 3 17 16 

5 3 4 3 4 3 17 20 

6 3 4 4 3 4 18 22 

7 4 3 3 4 3 17 19 
8 4 4 3 3 3 17 18 
9 5 4 5 4 3 21 20 

รวม 34 35 34 34 32 169 178 

เฉลี่ย 3.78 3.89 3.78 3.78 3.56 18.78 19.78 

ร้อยละ 75.11 79.11 
 
 จากตารางที่ 2  ผลจากการทดลองคะแนนเฉลี่ยก่อนอบรมเท่ากับ 18.78 จากคะแนนเต็ม  
25 คะแนน คะแนนเฉลี่ยหลังอบรมเท่ากับ 19.78 จากคะแนนเต็ม 25 คะแนน ประสิทธิภาพของ 
การทดสอบกลุ่มย่อยเท่ากับ 75.11/ 79.11 
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 ตอนท่ี 2  ผลการทดสอบประสิทธิภาพบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง   
การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม  
 
ตารางที่ 3 ผลการทดสอบประสิทธิภาพ (E1) ของบทเรียนอิเล็กทรอนิกส์ ตามเกณฑ์ 80 ตัวแรก 
 

บทเรียนอิเล็กทรอนิกส์ n คะแนนเต็ม 

คะแนนระหว่าง 
การฝึกอบรม 

X  SD 
เร่ืองที่ 1 การสร้างหนังสืออิเล็กทรอนิกส์ 32 5 4.06 0.62 
เร่ืองที่ 2 การจัดรูปแบบหนังสือ 32 5 4.00 0.76 
เร่ืองที่ 3 การแทรกไฟล์ภาพและไฟล์มลัติมีเดีย 32 5 4.03 0.78 
เร่ืองที่ 4 การปรับแต่งหนังสือ 32 5 4.06 0.84 
เร่ืองที่ 5 การสร้างแผ่นซีดีเพื่อเผยแพร่ผลงาน 32 5 3.91 0.82 

รวมเฉลี่ย ( X )  25 20.06 1.64 
ประสิทธิภาพ (E1) คิดเป็นร้อยละ 80.25 

 
 จากตารางที่ 3 พบว่า คะแนนระหว่างฝึกอบรมจากการท าแบบทดสอบด้วยบทเรียน 
อิเล็กทรอนิกส์ เร่ือง การพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสือ 
อิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม ตามเกณฑ์ 80 ตัวแรก ในภาพรวมมีค่าเฉลี่ย 
( X ) = 20.06  มีค่าส่วนเบี่ยงเบนมาตรฐาน (SD) = 1.64 ประสิทธิภาพ (E1) คิดเป็นร้อยละ 80.25 
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ตารางที่ 4 การวิเคราะห์หาประสิทธิภาพ (E2) ของบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม  
 เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม  
 ตามเกณฑ์ 80 ตัวหลัง 
 

หนังสืออ่านเพิ่มเติม n คะแนนเต็ม 

คะแนน 
หลังฝึกอบรม 

X  SD 
แบบทดสอบหลังการฝึกอบรม 
ประสิทธิภาพ (E2) คิดเป็นร้อยละ 84.63 

32 25 21.16 1.81 

 
 จากตารางที่ 4 พบว่า คะแนนจากการท าแบบทดสอบหลังฝึกอบรมด้วยบทเรียน 
อิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียน 
อ่างศิลาพิทยาคม ตามเกณฑ์ 80 ตัวหลังในภาพรวม มีค่าเฉลี่ย ( X ) = 21.16  มีค่าส่วนเบี่ยงเบน 
มาตรฐาน (SD) = 1.81 ประสิทธิภาพ (E2) คิดเป็นร้อยละ 84.63 
 จากการวิเคราะห์ข้อมูลข้างต้น ประสิทธิภาพ (E1) คะแนนระหว่างฝึกอบรมจากการท า
แบบทดสอบ ในภาพรวมคิดเป็นร้อยละ 80.25  และประสทิธิภาพ (E2)  จากการท าแบบทดสอบ 
หลังการฝึกอบรมคิดเป็นร้อยละ 84.6 3  ดังนั้นบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง  
การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม มีประสิทธิภาพ (E1/ E2) = 
80.25/ 84.63  ซึ่งสูงกว่าเกณฑ์ 80/ 80 ที่ก าหนดไว้ แสดงว่าบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม  
เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม มีประสิทธิภาพ 
ตามเกณฑ์ ซึ่งเป็นไปตามสมมติฐานที่ตั้งไว้ 
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 ตอนท่ี 3  ผลการเปรียบเทียบผลสัมฤทธิ์ก่อนการอบรมและหลังอบรมด้วยบทเรียน 
อิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ 
 
ตารางที่ 5 ผลการเปรียบเทียบคะแนนก่อนฝึกอบรมและหลังฝึกอบรมด้วยบทเรียนอิเล็กทรอนิกส์   
 

 
Mean SD 

ค่าเฉลี่ย 
ของผลต่าง 

SD 
ค่าเฉลี่ย 
ผลต่าง 

t df 
Sig. (1-
tailed) 

ก่อนอบรม 19.34 2.509 
1.81 2.546 4.028 * 31 0.000 

หลังอบรม 21.16 1.798 
 
 จากตารางที่ 5 พบว่า ผลการทดสอบคะแนนของผู้อบรม มีคะแนนก่อนอบรมเฉลี่ย  
เท่ากับ 19.34 คะแนน และมีคะแนนหลังอบรมเฉลี่ย เท่ากับ 21.16 คะแนน  เมื่อเปรียบเทียบระหว่าง 
คะแนนอบรมทั้งสองคร้ัง พบว่า คะแนนสอบหลังอบรม สูงกว่าก่อนอบรมอย่างมีนัยส าคัญทางสถิติ 
ที่ระดับ .05 
 
 ตอนท่ี 4  ผลการศึกษาความพึงพอใจของครูโรงเรียนอ่างศิลาพิทยาคมที่มีต่อบทเรียน 
อิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ 
 
ตารางที่ 6 ค่าเฉลี่ย ค่าส่วนเบี่ยงเบนมาตรฐาน อันดับและระดับ ความพึงพอใจของครูโรงเรียน  
 อ่างศิลาพิทยาคม ที่มีต่อบทเรียนอิเล็กทรอนิกส์  
 

รายการประเมิน 
n = 32 

ระดับ 
X  SD 

ด้านรูปแบบการน าเสนอ 
1.  ค าชี้แจงใช้บทเรียนชัดเจน 4.41 0.80 มาก 
2.  บทเรียนมีภาพประกอบที่สอดคล้องกับเนื้อหา 4.56 0.56 มากที่สุด 
3.  ความสัมพันธ์ระหว่างภาพกับค าอธิบายสอดคล้องกัน 4.47 0.67 มาก 
4.  รูปภาพที่ใช้ประกอบบทเรียนชัดเจนเหมาะสมต่อการเรียนรู้ 4.38 0.79 มาก 
5. บทเรียนท าเป็นขั้นตอนการเรียนง่ายและสะดวกขึ้น 4.59 0.61 มากที่สุด 
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ตารางที่ 6 (ต่อ) 
 

รายการประเมิน 
n = 32 

ระดับ 
X  SD 

ด้านเน้ือหา 
6.  จัดล าดับเน้ือหาในแต่ละหน้าจากง่ายไปยาก 4.56 0.67 มากที่สุด 
7.  แบบทดสอบก่อนหลังเรียนมีความสอดคล้องกับจุดประสงค์ 4.56 0.67 มากที่สุด 
8.  เน้ือหาเร่ืองที่เรียนมีความชัดเจนเข้าใจง่าย 4.44 0.80 มาก 
9.  บทเรียนมีการน าเสนอที่น่าสนใจน่าติดตาม 4.59 0.50 มากที่สุด 
10.  การเรียนรู้ผ่านภาพท าให้อยากเรียนมากขึ้น 4.44 0.80 มาก 
ด้านกิจกรรมการเรียน 
11.  ช่วยให้ผู้เรียนได้เรียนตามความเหมาะสมของตน 4.56 0.56 มากที่สุด 
12.  ช่วยให้ผู้เรียนกระตือรือร้นในการเรียนมากขึ้น 4.53 0.67 มากที่สุด 
13.  ช่วยให้ผู้เรียนได้รับประสบการณ์ใหม่ ๆ ที่เป็นประโยชน์ 4.41 0.80 มาก 
14.  ผู้เรียนได้รับความรู้จากใช้บทเรียน 4.53 0.62 มากที่สุด 
15.  บทเรียนใช้ง่ายและสะดวกต่อการเรียนรู้ 4.50 0.67 มาก 

รวม 4.50 0.35 มาก 
 
 จากตารางที่ 6 พบว่า ระดับความพึงพอใจของครูโรงเรียนอ่างศิลาพิทยาคม ที่มีบทเรียน 
อิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ โดยภาพรวมอยู่ในระดับมาก 
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บทที ่5 
สรุปผล อภิปรายผล และข้อเสนอแนะ 

 
 การวิจัยครั้งนี้มุ่งศึกษาการพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้าง
หนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม  ซึ่งสามารถสรุปผล อภิปรายผล 
และมีข้อเสนอแนะ ดังนี้ 
 1.  วัตถุประสงค์การวิจัย 
 2.  ประชากรและกลุ่มตัวอย่าง 
 3.  สมมติฐานการวิจัย 
 4.  สรุปผลการวิจัย 
 5.  อภิปรายผล 
 6.  ข้อเสนอแนะ 
 

วัตถุประสงค์การวิจัย 
 1.  เพื่อพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสือ 
อิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคมให้มีประสิทธิภาพตามเกณฑ์ E1/ E2 (80/ 80) 
 2.  เพื่อเปรียบเทียบผลสัมฤทธิ์ก่อนการอบรมและหลังการอบรม จากการอบรมบทเรียน 
อิเล็กทรอนิกส์เพื่อการฝึกอบรมเร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลา
พิทยาคม 
 3.  เพื่อศึกษาความพึงพอใจของครูที่มีต่อบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง  
การสร้างหนังสืออิเล็กทรอนิกส์  
 

ประชากรและกลุ่มตัวอย่าง 
 ประชากร 
 ประชากรที่ใช้ในการวิจัยคร้ังนี้เป็นครูโรงเรียนอ่างศิลาพิทยาคม จ านวนครู ทั้งหมด 55 คน 
 กลุ่มตัวอย่าง 
 กลุ่มตัวอย่างที่ใช้ในการวิจัยคร้ังนี้ ได้แก่ ครูโรงเรียนอ่างศิลาพิทยาคม รวม 32 คน 
ได้มาจากการเลือกแบบเจาะจง (Purposive sampling) โดยจงเจาะเลือกครูจาก 8 กลุ่มสาระวิชา  
กลุ่มสาระวิชาละ 4 คน 
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สมมติฐานการวิจัย 
 1.  บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์  
ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม มีประสิทธิภาพตามเกณฑ์ E1/ E2 เท่ากับ 80/ 80 
 2.  ผลสัมฤทธิ์หลังอบรมสูงกว่าก่อนอบรมอย่างมีนัยส าคัญทางสถิติที่ระดับ .05 
 3.  ความพึงพอใจของครูที่มีต่อบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้าง
หนังสืออิเล็กทรอนิกส์ มีความพึงพอใจในระดับดีมาก 
 

สรุปผลการวิจัย 
 1.  ผลการพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสือ
อิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม เนื้อหา จ านวน 5 เร่ือง ได้แก่ 
 เร่ืองที่ 1  การสร้างบทเรียนอิเล็กทรอนิกส์ 
 เร่ืองที่ 2  การจัดรูปแบบหนังสือ 
 เร่ืองที่ 3  การแทรกไฟล์ภาพและไฟล์มัลติมีเดีย 
 เร่ืองที่ 4  การปรับแต่งหนังสือ 
 เร่ืองที่ 5  การสร้างแผ่นซีดีเพื่อเผยแพร่ผลงาน 
 โดยเนื้อหาน าเสนอผ่านโปรแกรมจัดการเรียนการสอนออนไลน์ Moodle (รายละเอียด 
การเรียนตามภาคผนวก ค)  บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เป็นการอบรมที่สอดคล้องกับ 
ทฤษฎีความแตกต่างระหว่างบุคคล  ซึ่งผู้อบรมแต่ละคนมีความสามารถในการเรียนรู้ช้าเร็วแตกต่างกัน  
ดังนั้นบทเรียนนี้ช่วยให้ผู้อบรมรู้สึกพอใจและไม่เกิดความกดดันในขณะอบรม เมื่อผู้อบรมเรียนรู้ 
ไม่ทันผู้อ่ืน ท าให้ไม่รู้สึกเครียดในระหว่างการอบรม พบว่า บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม  
ท าให้ผู้อบรมสนใจ และกระตืนรือร้นที่จะเรียนรู้ในบทเรียนมากยิ่งขึ้น  เน่ืองจากบทเรียน 
อิเล็กทรอนิกส์เพื่อการฝึกอบรม มีข้อความ ภาพ ส่งผลให้บทเรียนน่าสนใจและช่วยกระตุ้นให้ 
ผู้อบรมสนใจบทเรียนมากยิ่งขึ้น 
 2.  บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ 
ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม ที่สร้างขึ้นมีประสิทธิภาพ 80.25/ 84.63 ซึ่งสูงกว่าเกณฑ์ 
ที่ตั้งไว้ในสมมติฐาน คือ 80/ 80 
 3.  ผลการเปรียบเทียบผลสัมฤทธิ์การทดสอบคะแนนของผู้อบรม มีคะแนนก่อนอบรม  
เฉลี่ย เท่ากับ 19.34 คะแนน และมีคะแนนหลังอบรม เฉลี่ย เท่ากับ 21.16 คะแนน เมื่อเปรียบเทียบ
ระหว่างคะแนนอบรมทั้งสองครั้ง พบว่า คะแนนสอบหลังอบรม สูงกว่าก่อนอบรมอย่างมีนัยส าคัญ 
ทางสถิติที่ระดับ .05 
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 4.  ความพึงพอใจของครูที่มีต่อบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้าง 
หนังสืออิเล็กทรอนิกส์ มีความพึงพอใจในระดับดีมาก มีค่าเฉลี่ย 4.50 
 

อภิปรายผล 
 การวิจัย เร่ืองบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสือ
อิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม สามารถอภิปรายผลได้ดังต่อไปนี้ 
 1.  บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ 
ที่ผู้วิจัยสร้างขึ้นนั้น  ผู้วิจัยได้ศึกษาและออกแบบบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม  
ให้มีคุณภาพอยู่ในระดับที่ดี  โดยการศึกษาองค์ประกอบหลักในการสร้างบทเรียนอิเล็กทรอนิกส์ 
รวมทั้งเทคนิควิธีการ ได้แก่ โปรแกรมที่ใช้ในการผลิต การออกแบบตัวอักษร ภาพนิ่ง 
ภาพเคลื่อนไหว การใช้สี กราฟิก เสียง เพื่อน ามาผสมผสานกันในการน าเสนอข้อมูลและ สร้าง 
บทเรียนอิเล็กทรอนิกส์ เพื่อดึงดูดความสนใจของผู้อบรม และต้องศึกษาหลักการทฤษฎที่เกี่ยวข้อง 
ทางด้านจิตวิทยาและการพัฒนาบทเรียนให้มีความน่าสนใจ มีแรงกระตุ้นให้ผู้อบรมเกิดการเรียนรู้ 
ด้วยตนเอง และมีพัฒนาการทางการเรียนรู้ที่ดีขึ้น นอกจากนี้แล้วผู้วิจัยต้องวางแผนขั้นตอน 
ในการด าเนินการและพัฒนาบทเรียนอิเล็กทรอนิกส์อย่างเป็นระบบ  โดยมีการตรวจสอบและ 
ประเมิน  เพื่อปรับปรุง แก้ไขทุกขั้นตอนตามค าแนะน าจากอาจารย์ที่ปรึกษา  ผู้เชี่ยวชาญด้านเน้ือหา 
และด้านสื่อแล้วน าไปทดลองตามกระบวนการของการวิจัยและพัฒนา  จึงท าให้บทเรียนมีคุณภาพ 
อยู่นระดับดีและเป็นไปตามเกณฑ์ที่ก าหนด 
 2.  ในการศึกษางานวิจัยครั้งนี้เป็นการพัฒนาบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม  
เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม  ผลการวิเคราะห์ 
หาประสิทธิภาพของบทเรียนอิเล็กทรอนิกส์ เพื่อการฝึกอบรมมีประสิทธิภาพ เท่ากับ  80.25/ 84.63  
จากการหาประสิทธิภาพ จะเห็นได้ว่า บทเรียนของบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม  
มีประสิทธิภาพเป็นไปตามเกณฑ์ที่ก าหนดไว้ที่ 80/ 80  เน่ืองมาจากบทเรียนมีการพัฒนา 
อย่างเป็นระบบ คือ มีการศึกษาเน้ือหาและวิเคราะห์เน้ือหา มีการสร้างบทเรียนที่น่าสนใจ เนื่องจาก 
การจัดองค์ประกอบของหน้าจอ  การใช้ภาพ กราฟิก สี เสียง และตัวอักษรเพื่อน าเสนอเน้ือหา 
ที่สอดคล้องกับทฤษฏีการเรียนรู้  รวมถึงได้มีการด าเนินการทดลองตามกระบวนการวิจัย 
และผู้อบรมยังสามารถใช้บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรมนี้ ทบทวนหลังการอบรม  
ได้อย่างไม่จ ากัดเวลา และสถานที่ ท าให้ผู้อบรมมีความรู้ความเข้าใจมากขึ้น ซึ่งผลการวิจัยได้
สอดคล้องกับชัยวัฒน์  จิวพานิชย์ (2550) ได้ท าวิจัยเร่ือง การสร้างบทเรียนคอมพิวเตอร์ช่วยสอน 
เพื่อการฝึกอบรม เร่ือง การออกแบบและสร้างบทเรียนบนเว็บ ผลการวิจัยพบว่า ประสิทธิภาพ 
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บทเรียนคอมพิวเตอร์ช่วยสอนเพื่อการฝึกอบรมเป็น 85.06/ 84.88 ซึ่งสูงกว่าเกณฑ์ 80/ 80 ที่ตั้งไว้  
และถนอม  เลาหจรัสแสง (2545, หน้า 18-19) ที่ได้กล่าวถึงประโยชน์ของสื่อบทเรียนอิเล็กทรอนิกส์ 
ไว้ว่า สื่อบทเรียนอิเล็กทรอนิกส์  ช่วยให้การจัดการเรียนการสอนมีประสิทธิภาพมากยิง่ขึ้น  
เพราะการถ่ายทอดเน้ือหาผ่านทางมัลติมีเดีย สามารถท าให้เกิดการเรียนรู้ได้ดีกว่าการเรียนจาก 
สื่อข้อความเพียงอย่างเดียว หรือจากการสอนภายในห้องเรียนของผู้สอนซึ่งเน้นการบรรยาย 
ในลักษณะ Chalk and talk โดยเมื่อเปรียบเทียบกับ อิเล็กทรอนิกส์ ที่ได้รับการออกแบบและผลิต 
มาอย่างมีระบบ จะช่วยท าให้ผู้เรียนเกิดการเรียนรู้ได้อย่างมีประสิทธิภาพมากกว่าในเวลาที่เร็วกว่า  
นอกจากนี้ยังสอดคล้องกับแนวคิดของการเรียนรู้ด้วยการน าตนเอง 
 3.  ผลการศึกษาการเปรียบเทียบผลสัมฤทธิ์ทางการเรียนหลังจากเรียนด้วยบทเรียน 
อิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับครูโรงเรียนอ่างศิลา 
พิทยาคม ปรากฏว่า ผลสัมฤทธิ์การอบรมหลังได้รับการจัดการเรียนรู้ด้วยบทเรียนอิเล็กทรอนิกส์ 
สูงกว่าก่อนได้รับการอบรมด้วยบทเรียนอิเล็กทรอนิกส์  แสดงว่า บทเรียนอิเล็กทรอนิกส์ที่ผู้วิจัย 
สร้างขึ้นสามารถพัฒนาการเรียนรู้ของผู้อบรมได้อย่างมีประสิทธิภาพเป็นไปตามสมมติฐาน  
สอดคล้องกับงานวิจัยของยุทธนา  อาจหาญ (2551, หน้า 111) ที่ได้ท าการวิจัยเร่ือง การพัฒนา
บทเรียนอีเลิร์นนิ่ง (e-Learning) วิชาฟิสิกส์ เร่ือง แสงและการมองเห็น ชั้นมัธยมศึกษาปีที่ 5  
ผลการวิจัยพบว่า ผลสัมฤทธิท์างการเรียนหลังได้รับการจัดการเรียนรู้โดยใช้บทเรียนอีเลิร์นนิ่ง 
สูงกว่าก่อนได้รับการจัดการเรียนรู้อย่างมีนัยส าคัญทางสถิติที่ระดับ .01  ทั้งนี้อาจเน่ืองมาจาก  
บทเรียน e-Learning ที่ผู้วิจัยสร้างขึ้นเป็นบทเรียนประเภทเนื้อหา  ซึ่งผู้วิจัยได้ออกแบบและเสนอ 
เน้ือหาเป็นหน่วยย่อย ๆ ในปริมาณที่เหมาะสมกับความยากง่ายของบทเรียน  และในการน าเสนอ 
เน้ือหายังมีลักษณะเป็นข้อมูลสารสนเทศที่ผ่านกระบวนการวิเคราะห์เนื้อหา และเรียบเรียงมาแล้ว 
เป็นอย่างดี  ไม่ใช่เป็นเพียงการน าเสนอเนื้อหาผ่านหน้าจอคอมพิวเตอร์เท่านั้น  และบทเรียน  
e-Learning ยังออกแบบให้มีการโต้ตอบกับผู้เรียนอย่างเหมาะสม สอดคล้องกับหลัก 4 Is (มนต์ชัย  
เทียนทอง, 2548, หน้า 351) ได้แก่ Information, interactive, individual และ Immediate feedback 
หมายถึง ความเป็นสารสนเทศของเนื้อหาที่ผ่านกระบวนการออกแบบ ไม่ใช่ข้อมูลดิบเหมือนข้อมูล 
ที่บรรจุไว้ในหนังสือหรือต าราทั่วไปนอกจากนี้ยังส่งเสริมการปฏิสัมพันธ์แบบ 2 ทาง (Two-way 
communication) ในกระบวนการเรียนรู้ที่เน้นการเรียนรู้รายบุคคล โดยมีการป้อนกลับโดยทันที 
ที่ผู้เรียนมีปฏิสัมพันธ์ ท าให้การเรียนรู้เกิดความต่อเนื่องและรวดเร็ว 
 4.  ความพึงพอใจของครูโรงเรียนอ่างศิลาพิทยาคม ที่มีต่อการฝึกอบรมด้วยบทเรียน 
อิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ โดยภาพรวมอยู่ในระดับมาก 
ซึ่งสอดคล้องกับแนวคิดของเอลิส (Ellis, 2009) ที่กล่าวถึงประโยชน์ของสื่อบทเรียนอิเล็กทรอนิกส์  
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ท าให้การเรียนการสอนมีความน่าสนใจ ดึงดูดใจผู้เรียนมาขึ้น เนื่องจากความสามารถของโปรแกรม 
คอมพิวเตอร์ที่พัฒนารูปแบบการน าเสนอให้เป็นน่าสนใจ เสริมช่องทางของสื่อหลายอย่างเข้าไป 
ในระบบสื่อการเรียนการสอน เช่น การมีข้อความ รูปภาพ กราฟิก เสียงประกอบ ภาพแสดง 
การเคลื่อนไหว  ซึ่งการเรียนรู้ผ่านสื่อบทเรียนอิเล็กทรอนิกส์  มีประโยชน์ต่อทักษะการคิด 
อย่างเป็นระบบ  โดยเฉพาะทักษะการวิเคราะห์สืบค้น การคิดเชิงวิเคราะห์ การวิเคราะห์ข้อมูล  
การแก้ปัญหา และการคิดอย่างอิสระ  
 

ข้อเสนอแนะ 
 ข้อเสนอแนะท่ัวไป 
 ในการสร้างบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม ผู้วิจัยควรมีความรู้ความเข้าใจ 
ในเน้ือหาโปรแกรมและทฤษฎีการออกแบบ  และทฤษฎกีารเรียนรู้และกระบวนการสร้างบทเรียน
อิเล็กทรอนิกส์  เพื่อการฝึกอบรมเป็นอย่างดี  และต้องศึกษาโปรแกรมใหม่ ๆ ที่เกี่ยวข้อง  
เพราะเทคโนโลยีมีการพัฒนาอย่างรวดเร็ว  จึงจ าเป็นที่ต้องเลือกใช้โปรแกรมที่ทันสมัยเพื่อรองรับ
เทคโนโลยีเครือข่ายที่มีการพัฒนาอย่างรวดเร็ว 
 ข้อเสนอแนะส าหรับงานวิจัยครั้งต่อไป 
 ควรมีการวิจัยและพัฒนาเนื้อหาในส่วนโปรแกรม บทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม 
ผ่านทางระบบโทรศัพท์เคลื่อนที่  เพราะปัจจุบันระบบโทรศัพท์เคลื่อนที่มีบทบาทส าคัญมาก 
ในการใช้ชีวิตประจ าวันและอุปกรณ์ยังสามารถจัดหาได้ง่ายและมีแนวโน้มที่ทันสมัยมากขึ้น  
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ภาคผนวก  ก 
1.  รายนามผู้เชี่ยวชาญตรวจสอบเคร่ืองมือที่ใช้ในการวิจัย 
2.  หนังสือขอความอนุเคราะห์เป็นผู้เชี่ยวชาญตรวจความถูกต้องของเคร่ืองมือที่ใช้ในการวิจัย 
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1.  ดร.ภูเบศ  เลื่อมใส  หัวหน้าภาควิชานวัตกรรมและเทคโนโลยีการศึกษา 
 คณะศึกษาศาสตร์ มหาวิทยาลัยบูรพา     
 
2.  ดร.เอกวิทย์  โทปุรินทร์  อาจารย์ประจ าภาควิชานวัตกรรมและเทคโนโลยีการศึกษา  
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 คณะศึกษาศาสตร์ มหาวิทยาลัยบูรพา 
 
4.  ดร.ดวงพร  ธรรมะ อาจารย์ประจ าภาควิชานวัตกรรมและเทคโนโลยีการศึกษา  
 คณะศึกษาศาสตร์ มหาวิทยาลัยบูรพา 
 
5.  ดร.ธนะวัฒน์ วรรณประภา อาจารย์ประจ าภาควิชานวัตกรรมและเทคโนโลยีการศึกษา  
 คณะศึกษาศาสตร์ มหาวิทยาลัยบูรพา 
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ภาคผนวก  ข 
การประเมินคุณภาพบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรมด้านสื่อการสอน 
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การประเมินคุณภาพบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรมด้านเนื้อหาจากผู้เชี่ยวชาญ 
 
ตารางที่ 7 การประเมินคุณภาพบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรมด้านสื่อการสอน 
 

รายการประเมิน 
ระดับการประเมินความเหมาะสม 

X  SD แปลผล 

ด้านคุณภาพเนื้อหา 
1.  เน้ือหามีความสอดคล้องกับจุดประสงค์ 4.40 0.55 มาก 
2.  ล าดับขั้นในการน าเสนอเนื้อหา 4.20 0.45 มาก 
3.  การใช้รูปภาพประกอบการน าเสนอเนื้อหา 4.00 0.71 มาก 
4.  ความเหมาะสมของเนื้อหากับระดับของผู้เรียน 4.20 0.45 มาก 
5. ความชัดเจนในการอธิบายเน้ือหา 4.40 0.55 มาก 
ด้านคุณภาพ ภาพและเสียง 
6.  สีสันของภาพ 4.20 0.45 มาก 
7.  ความชัดเจนของภาพ 4.20 0.45 มาก 
8.  ความสัมพันธ์ระหว่างรูปภาพกับค าบรรยาย 4.40 0.55 มากที่สุด 
9.  ความสมดุลของการจัดวางรูปภาพกับหน้าจอ 4.40 0.55 มากที่สุด 
10.  ความชัดเจนชองเสียงบรรยาย 4.40 0.55 มากที่สุด 
ด้านคุณภาพตัวอักษรและการใช้สี 
11.  ความเหมาะสมขนาดของตัวอักษรกับหน้าจอ 4.40 0.55 มากที่สุด 
12.  รูปแบบของตัวอักษรมีความสวยงามอ่านง่าย 
       และชัดเจน 

4.40 0.89 มาก 

13.  ความเหมาะสมของสีตัวอักษรและสีพื้น 4.40 0.55 มากที่สุด 
14.  ความเด่นชัดของหัวข้อหรือส่วนที่เน้นความส าคัญ 4.40 0.55 มากที่สุด 
15.  ความเด่นชัดของหัวข้อหรือส่วนที่เน้นความส าคัญ 4.00 0.71 มากที่สุด 
ด้านคุณภาพการจัดการบทเรียน 
16.  ความสมบูรณ์ของจุดประสงค์การเรียน 4.40 0.55 มาก 
17.  ค าอธิบายการใช้บทเรียน 4.20 0.45 มากที่สุด 
18.  ความสมบูรณ์ของการเชื่อมโยง (Links)  
       ไปยังหัวข้อต่าง ๆ 

4.40 0.55 มากที่สุด 
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ตารางที่ 7 (ต่อ) 
 

รายการประเมิน 
ระดับการประเมินความเหมาะสม 

X  SD แปลผล 

คุณภาพด้านการประเมิน 
19.  ความสอดคล้องของแบบฝึกหัดระหว่างเรียนกับ 
       จุดประสงค์ 

4.20 0.45 มากที่สุด 

20.  ความสอดคล้องของแบบฝึกหัดระหว่างเรียนกับ 
       เน้ือหา 

4.40 0.55 มากที่สุด 

21.  ความสอดคล้องแบบทดสอบวัดผลสัมฤทธิ์กับ 
       จุดประสงค์ 

4.00 0.71 มาก 

22.  ความสอดคล้องแบบทดสอบวัดผลสัมฤทธิ์กับเน้ือหา 4.20 0.45 มาก 
รวม 4.28 0.22 มาก 
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ภาคผนวก  ค 
ตัวอย่างบทเรียนอิเล็กทรอนิกส์เพื่อการฝึกอบรม เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์  

ส าหรับครูโรงเรียนอ่างศิลาพิทยาคม 
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ตัวอย่างบทเรียนบทเรียนอิเล็กทรอนิกส์ 
เร่ือง การสร้างหนังสืออิเล็กทรอนิกส์ 

 
 
 
 
 
 
 
 
 
 
 
 
 
ภาพที่ 2  หน้าหลักโปรแกรม 

 
 
 
 
 
 
 
 
 
 

 
 

ภาพที่ 3  ผู้เข้ารับการอบรม ล็อคอิน 
 



82 

 
 

 
 
 
 
 

 
 
 
 

 
ภาพที่ 4  วัตถุประสงค์ 
 
 

 
 
 
 
 
 
 
 
 

ภาพที่ 5  วัตถุประสงค์ที่ 1  
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ภาพที่ 6 วัตถุประสงค์ที่ 2  

 
 

 
 
ภาพที่ 7  วัตถุประสงค์ที่ 3 

 
 



84 

 
 

ภาพที่ 8  วัตถุประสงค์ที่ 4 
 
 

 
 

ภาพที่ 9  วัตถุประสงค์ที่ 5 
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ภาพที่ 10  ปกหน้าเนื้อหา 
 
 

 
 
ภาพที่ 11  หน้าเนื้อหาบทเรียน 
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ภาพที่ 12  หน้าเนื้อหาบทเรียนเร่ืองที่ 1 
 
 

 
 
 
 
 
  
 
 
 

 
ภาพที่ 13  ขั้นตอนการเข้าโปรแกรม Flip Album 
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ภาพที่ 14  หน้าเนื้อหาบทเรียนเร่ืองที่ 2 
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ภาพที่ 15  หน้าเนื้อหาบทเรียนเร่ืองที่ 3 
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ภาพที่ 16  หน้าเนื้อหาบทเรียนเร่ืองที่ 4 
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ภาพที่ 17  หน้าเนื้อหาบทเรียนเร่ืองที่ 5 
 
 
 
 
 
 



91 

 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 18  หน้าเนื้อหาแบบทดสอบ 
 
 
 
 
 
 



92 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 19  ตัวอย่างแบบทดสอบ 
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ภาพที่ 20  ผลรวมทดสอบ 
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ภาคผนวก ง 
 -  แบบทดสอบ 
 -  วัตถุประสงค์การเรียนรู้ 
 -  เน้ือหาวิชาโดยย่อ 
 -  แบบทดสอบผลสัมฤทธิ์ 
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แบบทดสอบ 
 

เร่ืองท่ี 1 การสร้างหนังสืออิเล็กทรอนิกส์ (E-Book) 
1. ข้อใดให้ความหมายของหนังสืออิเล็กทรอนิกส์ได้ถูกต้องที่สุด 

a. หนังสือที่สร้างด้วยโปรแกรมคอมพิวเตอร์และเปิดอ่านได้เหมือนหนังสือจริง 
b. หนังสือที่ประกอบไปด้วยข้อความ ภาพและเสียง 
c. หนังสือที่สามารถสั่งพิมพ์ทางเคร่ืองพิมพ์ได้ 
d. หนังสือที่สามารถเปิดอ่านได้ในเคร่ืองคอมพิวเตอร์ 

2. e-Book ย่อมาจากค าในภาษาอังกฤษในข้อใด 
a. Electron Book 
b. E learning Book 
c. Electronic Book 
d. Electrolux Book 

3. ข้อใดเป็นความสามารถของหนังสืออิเล็กทรอนิกส์ที่มีเหมือนกับหนังสือจริง 
a. น าเสนอการเชื่อมโยงไปยังข้อมูลหน้าอื่นๆ ได้ 
b. น าเสนอข้อมูลภาพเคลื่อนไหว หรือภาพวิดีโอได้ 
c. น าเสนอข้อมูลแบบข้อความและรูปภาพได้ 
d. น าเสนอข้อมูลเสียงได้ 

4. ซอฟต์แวร์ Reader จะเกี่ยวข้องกับหนังสืออิเล็กทรอนิกส์อย่างไร 
a. ซอฟต์แวร์ส าหรับการออกแบบ 
b. ซอฟต์แวร์ส าหรับการเขียน 
c. ซอฟต์แวร์ส าหรับการถอดรหัส 
d. ซอฟต์แวร์ส าหรับการอ่าน 

5. ข้อใดเป็นการเตรียมงานเบื้องต้นก่อนการสร้างหนังสืออิเล็กทรอนิกส์ 
a. ก าหนดการเชื่อมโยงเพื่อไม่ให้มีปัญหาในการน าเสนอผ่านเว็บไซต์ 
b. ย่อไฟล์ภาพให้มีขนาดเหมาะสมก่อนน าไปใช้งาน 
c. สร้างโฟลเดอร์ส าหรับหนังสืออิเล็กเล็กทรอนิกส์ 1 โฟลเดอร์ ต่อ หนังสือ 1 เล่ม 
d. เตรียมไฟล์ประกอบโดยตั้งชื่อเป็นภาษาอังกฤษหรือผสมตัวเลขและห้ามเว้นวรรค 
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เร่ืองท่ี 2 การจัดรูปแบบหนังสือ 
1. ข้อใดเป็นขั้นตอนการออกแบบก่อนการสร้างหนังสืออิเล็กทรอนิกส์ 

a. สร้างโฟลเดอร์ส าหรับหนังสืออิเล็กเล็กทรอนิกส์ 
b. ก าหนดการเชื่อมโยงเพื่อไม่ให้มีปัญหาในการน าเสนอผ่านเว็บไซต์ 
c. เตรียมไฟล์ประกอบโดยตั้งชื่อเป็นภาษาอังกฤษหรือผสมตัวเลขและห้ามเว้นวรรค 
d. ย่อไฟล์ภาพให้มีขนาดเหมาะสมก่อนน าไปใช้งาน 

2. โปรแกรมจะแสดงชื่อหนังสือที่สร้างขึ้นที่ส่วนใด 
a. แถบเมนู 
b. แถบสถานะ 
c. แถบหัวเร่ือง 
d. แถบเคร่ืองมือ 

3. การสร้างหนังสือเล่มใหม่ ต้องคลิกค าสั่งใด 
a. Edit 
b. New 
c. Save 
d. Open 

4. ถ้าต้องการเพิ่มหน้ากระดาษ ต้องคลิกปุ่มใด 
a. Delete page 
b. Insert page 
c. New page 
d. Copy page 

5. ถ้าต้องการลบหน้ากระดาษ ต้องคลิกปุ่มใด 
a. Copy page 
b. New page 
c. Insert page 
d. Delete page 
 
 
 
 



97 

เร่ืองท่ี 3 การแทรกไฟล์ภาพและไฟล์มัลติมีเดีย 
1. การใส่สีให้กับหน้ากระดาษมีขั้นตอนอย่างไร 

a. Edit > Insert page 
b. Edit > Insert Clip Art 
c. Edit > Page Properties 
d. Edit > Muti Media Object 

2. ข้อใดคือขั้นตอนการใส่ภาพกราฟิก 
a. Edit > Insert Clip Art 
b. Edit > Insert page 
c. Edit > Page Properties 
d. Edit > Muti Media Object 

3. ข้อใดคือขั้นตอนการใส่เสียง 
a. Edit > Insert page 
b. Edit > Muti Media Object 
c. Edit > Insert Clip Art 
d. Edit > Page Properties 

4. ข้อใดให้ความหมายของค าว่ามัลติมิเดียได้ถูกต้อง 
a. มัลติมีเดียเป็นการน าองค์ประกอบต่าง ๆ เช่น ตัวอักษร รูปภาพ เสียง ภาพเคลื่อนไหว  
    เข้าด้วยกัน 
b. มัลติเดียเป็นสื่อที่ใช้ในการน าเสนอผลงานในรูปแบบต่าง ๆ 
c. มัลติมีเดียหมายถึงโปรแกรมหนังสืออิเล็กทรอนิกส์เท่านั้น 
d. ถูกทุกข้อ 

5. การแทรกไฟล์วิดีโอลงในหนังสืออิเล็กทรอนิกส์ ต้องปฏิบัติตามข้อใด 
a. Insert > Anotations Incorrect 
b. Insert > Clip Art 
c. Insert > Muti Media Object 
d. Insert > Bookmarks 
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เร่ืองท่ี 4 การปรับแต่งหนังสือ 
1. ข้อใดคือค าสั่งการจัดท าปกแบบเข้าห่วง 

a. Book Binder 
b. Set Book Options 
c. Page Porperties 
d. Set Theme 

2. Centerfold Page คือค าสั่งใด 
a. การลบหน้ากระดาษ 
b. การสร้างหน้ากระดาษ 
c. การสร้างหนังสือแบบหน้าคู่ 
d. การแทรกภาพเคลื่อนไหว 

3. Customize Contents คือค าสั่งใด 
a. การสร้างหน้าสารบัญ 
b. การเปลี่ยน Contents เป็นภาษาไทย 
c. การตกแต่งหน้าสารบัญ 
d. การใส่สีให้สารบัญ 

4. ข้อความที่สร้างลิ้งค์เชื่อมโยงแล้ว เมื่อใช้ค าสั่งเพื่อดูผลงานจะมีลักษณะอย่างไร 
a. มีกรอบสามเหลี่ยมยุบลง 
b. มีเส้นใต้ข้อความ 
c. มีกรอบสี่เหลี่ยมยุบลง 
d. มีกรอบสี่เหลี่ยมนูนขึ้นมา 

5. ค าสั่งใดที่ใช้ออกแบบปกหนังสืออัตโนมัติ 
a. Page Porperties 
b. Set Book Options 
c. Set Theme 
d. Book Binder 
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เร่ืองท่ี 5 การสร้างแผ่นซีดีเพื่อเผยแพร่ผลงาน 
1. ข้อใดคือค าสั่งในการพิมพ์ข้อความ 

a. Insert > Muti Media Object 
b. Insert > Clip Art 
c. Insert > Anotations 
d. Insert > Bookmarks 

2. แฟ้มเสียงที่สามารถน ามาใช้ประกอบหนังสืออิเล็กทรอนิกส์ได้แก่แฟ้มนามสกุลใด 
a. mp3 
b. ถูกทุกข้อ 
c. wav 
d. wma 

3. การน าแฟ้มงานขึ้นไปไว้บนเคร่ืองแม่ข่ายหรือเซิร์ฟเวอร์เรียกกว่าอะไร 
a. Download 
b. Upload 
c. Publish 
d. Package 

4. เมื่อสร้างหนังสือเสร็จแล้วต้องบันทึกหนังสือด้วยค าสั่งใด 
a. CD Maker > Create Album CD 
b. CD Maker > Export Album TV Viewing 
c. Customize Contents 
d. File > Save As 

5. การบันทึกหนังสืออิเล็กทรอนิกส์เพื่อเล่นกับเคร่ืองเล่น DVD 
a. CD Maker  Create Album CD 
b. File > Save As 
c. Customize Contents 
d. CD Maker > Export Album TV Viewing 
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เฉลย 
เร่ืองที่ 1 เร่ืองที่ 2 เร่ืองที่ 3 เร่ืองที่ 4 เร่ืองที่ 5 
1.  A 1.  A 1.  D 1.  A 1.  A 
2.  C 2.  C 2.  D 2.  C 2.  B 
3.  A 3.  B 3.  B 3.  B   3.  B 
4.  D 4.  B 4.  B 4.  B 4.  D 
5.  C 5.  D 5.  C 5.  B 5.  A 
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วัตถุประสงค์การเรียนรู้ 
 

เร่ืองที่ 1 การสร้างบทเรียนอิเล็กทรอนิกส์ (E-Book) 
1. เพื่อให้ผู้เข้าอบรมได้รับความรู้เกี่ยวการสร้างหนังสืออิเล็กทรอนิกส์ (E-Book) 
2. เพื่อให้ผู้เข้าอบรมเข้าใจความส าคัญของการสร้างหนังสืออิเล็กทรอนิกส์ (E-Book) 
3. เพื่อให้ผู้เข้าอบรมสามารถน าความรู้ไปปฏิบัติงานได้ 

เร่ืองที่ 2 การจัดรูปแบบหนังสือ 
1. เพื่อให้ผู้เข้าอบรมเพิ่มพูนทักษะเกี่ยวกับการจัดรูปแบบหนังสือ 
2. เพื่อให้ผู้เข้าอบรมเข้าใจสามารถการจัดรูปแบบหนังสือ 
3. เพื่อให้ผู้เข้าอบรมสามารถน าความรู้ไปปฏิบัติงานได้ 

เร่ืองที่ 3 การแทรกไฟล์ภาพและไฟล์มลัติมีเดีย 
1. เพื่อให้ผู้เข้าอบรมเพิ่มพูนทักษะการแทรกไฟล์ภาพและไฟล์มัลติมีเดีย 
2. เพื่อให้ผู้เข้าอบรมเข้าใจสามารถแทรกไฟล์ภาพและไฟล์มัลติมีเดีย 
3. เพื่อให้ผู้เข้าอบรมสามารถน าความรู้ไปปฏิบัติงานได้ 

เร่ืองที่ 4 การปรับแต่งหนังสือ 
1. เพื่อให้ผู้เข้าอบรมเพิ่มพูนทักษะการปรับแต่งหนังสือ 
2. เพื่อให้ผู้เข้าอบรมเข้าใจสามารถปรับแต่งหนังสือ 
3. เพื่อให้ผู้เข้าอบรมสามารถน าความรู้ไปปฏิบัติงานได้ 

หน่วยที่ 5 การสร้างแผ่นซีดีเพื่อเผยแพร่ผลงาน 
1. เพื่อให้ผู้เข้าอบรมเพิ่มพูนทักษะการสร้างแผ่นซีดีเพื่อเผยแพร่ผลงาน 
2. เพื่อให้ผู้เข้าอบรมเข้าใจสามารถสร้างแผ่นซีดีเพื่อเผยแพร่ผลงาน 
3. เพื่อให้ผู้เข้าอบรมสามารถน าความรู้ไปปฏิบัติงานได้ 
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เนื้อหาวิชาโดยย่อ 
เนื้อหาเร่ือง การสร้างบทเรียนอิเล็กทรอนิกส์ (E-Book) ด้วยโปรแกรม Flip Album 6.0 Pro 

 
เร่ืองท่ี 1 การสร้างบทเรียนอิเล็กทรอนิกส์ (E-Book) 
 ความหมายของหนังสืออิเล็กทรอนิกส์ หนังสืออิเล็กทรอนิกส์ หรือ E-Book ย่อมาจาก 
ค าว่า electronic book หมายถึง หนังสือที่สร้างขึ้นด้วยโปรแกรมคอมพิวเตอร์มีลักษณะ 
คล้ายหนังสือจริง สามารถเปิดอ่านได้ในเคร่ืองคอมพิวเตอร์ และ มีลักษณะพิเศษคือ 
สามารถสื่อสารกับผู้อ่านในลักษณะของมัลติมีเดียได้ ได้แก่ ข้อความ ภาพนิ่ง ภาพเคลื่อนไหว  
และเสียง แต่ยังคงรักษารูปแบบความเป็นหนังสือไว้ไม่ว่าจะเป็นรูปร่าง หรือลักษณะ การเปิดอ่าน 
 การพัฒนา Multimedia e-Book  มีซอฟต์แวร์ช่วยหลายตัว โดยซอฟต์แวร์ที่โดดเด่นตัว
หนึ่งคือ FlipAlbum ซึ่งปัจจุบันได้พัฒนามาเป็น FlipAlbum 6.0 โดยความสามารถของโปรแกรมที่
ท าให้การน าเสนอสื่อออกมาในรูปแบบ 3D Page-Flipping interface และมีชื่อเรียกเฉพาะว่า 
FlipBook ผลงานที่ได้นี้สามารถน าเสนอได้ทั้งแบบ Offline ด้วยความสามารถ AutoRun อัตโนมัติ 
และ Online ผ่านโปรแกรมแสดงผลเฉพาะ FlipViewer 
 
เร่ืองท่ี 2 การจัดรูปแบบหนังสือ 
 การเพิ่มหน้าเอกสาร 
 1.  คลิกเมนู Edit 
 2.  เลือกค าสั่ง Insert page 
  - เลือก Left Page ถ้าต้องการเพิ่มหน้ากระดาษทางด้านซ้ายมือ 
  - เลือก Right Page ถ้าต้องการเพิ่มหน้ากระดาษทางด้านขวามือ 
  - เลือก Multiple Page ถ้าต้องการเพิ่มที่ละหลาย ๆ หน้าพร้อมกัน 
 การลบหน้าเอกสาร 
 1.  คลิกเมนู Edit 
 2.  เลือกค าสั่ง Delete page 
  - เลือก Left Page ถ้าต้องการลบหน้ากระดาษทางด้านซ้ายมือ 
  - เลือก Right Page ถ้าต้องการลบหน้ากระดาษทางด้านขวามือ 
 การพิมพ์ข้อความ 
 1.  คลิกเมนู Edit 
 2.  เลือกค าสั่ง Insert Annotation 
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 3.  เลือกหน้าที่ต้องการพิมพ์ว่าจะพิมพ์หน้าด้านขวาหรือด้านซ้าย 
 4.  พิมพ์ข้อความและตกแต่งตามความเหมาะสม 
 
เร่ืองท่ี 3 การแทรกไฟล์ภาพและไฟล์มัลติมีเดีย 
 การแทรกไฟล์ Multimedia 
 1.  เปิดไปที่หน้าที่ต้องการแทรกรูปภาพ/ ภาพวิดีโอ หลังจากนั้นให้เลือกเมนูค าสั่ง  
Edit-&gt; Insert Multi-edia Object 
 2.  เปิดไปที่หน้าที่ต้องการแทรกรูปภาพ/ ภาพวิดีโอ คลิกเลือกสัญลักษณ์ + ที่ล้อมรอบ 
ด้วยวงกลมสีเหลืองบนแถบเคร่ืองมือ 
 3.  คลิกขวาบนหน้าที่ต้องการแทรกแล้วเลือกค าสั่ง Insert Multi-Media Object…  
หลังจากที่เลือกการแทรกรูปภาพ/ ภาพวิดีโอ โดยใช้วิธีใดวิธีหนึ่ง   
 การแทรกไฟล์เสียงลงในหน้าเอกสาร 
 สามารถท าแบบเดียวกับการแทรกรูปภาพ/ ภาพวิดีโอ คือ 
 - เปิดไปที่หน้าที่ต้องการแทรกเสียง 
 - คลิกเลือกสัญลักษณ์ + ที่ล้อมรอบด้วยวงกลมสีเหลือง บนแถบเคร่ืองมือ 
 - คลิกเลือกไฟล์เสียงที่ต้องการ แล้วลากไปไว้บนหน้ากระดาษที่ต้องการจะปรากฏเป็น 
สัญลักษณ์รูปตัวโน๊ต 
 การปรับแต่งรูปภาพ 
 การแก้ไขรูปภาพ ให้คลิกขวาที่รูปภาพที่ต้องการแก้ไขเลือกค าสั่ง Edit จะปรากฎ 
โปรแกรม Flip Album Editor สามารถเลือกใช้แถบเคร่ืองมือด้านล่างเพื่อปรับแต่งรูปภาพได้  
หากต้องการออกจากโปรแกรมนี้ให้คลิกปุ่ม y มุมขวาบนของโปรแกรม Flip Album Image Editor 
 
เร่ืองท่ี 4 การปรับแต่งหนังสือ 
 การปรับแต่งหน้าเอกสาร  
 วิธีที่ 1  เปิดหน้าเอกสารที่ต้องการปรับแต่ง เลือกเมนูค าสั่ง Edit-&gt; Page Properties 
 วิธีที่ 2  คลิกขวาบนหน้าเอกสารที่ต้องการปรับแต่ง เลือกค าสั่ง  Page properties  
จะปรากฏหน้าต่าง Set Page Properties 
 การก าหนดพื้นที่ในการปรับแต่งหน้าเอกสาร สามารถก าหนดได้ 4 ลักษณะ ดังนี้ 
Centerfold  หมายถึง การท างานเฉพาะหน้าหนังสือที่เป็นสองหน้าติดกันเท่านั้น 
 - Always on the left หมายถึง การท างานเฉพาะหน้าซ้ายของหนังสือเท่านั้น 
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 - Always on the right หมายถึง การท างานเฉพาะหน้าขวาของหนังสือเท่านั้น 
 - No Fixed side หมายถึง การท างานทั้งสองหน้าของหนังสือ ซึ่งเป็นค่าปกติของเอกสาร 
 การเลือกสีพื้นหลัง 
 หลังจากที่เลือก Color และคลิกที่ปุ่ม Choose Color จะปรากฏหน้าต่าง Color ให้เลือกสี 
หากสีที่มีให้เลือกไม่เป็นที่พอใจ ให้คลิกที่ปุ่ม Define Custom Color เพื่อเลือกสีใหม่ โดยใช้เมาส์ 
คลิกเลือกต าแหน่งสี และปรับระดับความเข้มอ่อนของสีจากช่องทางด้านขวาสุดจนได้สีตาม 
ความพอใจ แล้วจึงคลิกที่ปุ่ม OK 
 การเลือกภาพพื้นหลัง 
 หลังจากที่เลือก Texture และคลิกที่ปุ่ม Browser จะปรากฏหน้าต่าง Open ให้เลือก 
รูปภาพจากต าแหน่งที่ได้จัดเตรียมไว้ โดยการ Double Click ที่ชื่อไฟล์รูปภาพนั้น ๆ หากต้องการ 
ยกเลิกให้คลิกที่ปุ่ม Cancel 
 การเลือกเสียงเพลงของหน้าเอกสาร  
 หลังจากที่เลือก File และคลิกที่ปุ่ม Browse จะปรากฏหน้าต่าง Open ให้เลือกเพลงจาก 
ต าแหน่งที่ได้จัดเตรียมไว้โดยการดับเบิ้ลคลิกที่ชื่อไฟล์เพลงนั้น ๆ หากต้องการยกเลิกให้คลิกปุ่ม  
Cancel  
 การปรับแต่งปกหน้า/ ปกหลังของหนังสือ  
 เลือกมนู Option-&gt; Set Book Option-&gt; เลือกรายการ Book Cover 
 Book Cover เป็นการก าหนดรูปแบบของปกหน้า (Front Cover) และปกหลัง (Back 
Cover) ของหนังสือ โดยสามารถเลือกว่า จะใช้สีเป็นพื้นหลัง (Color) หรือใช้รูปภาพ (Texture)  
เป็นพื้นหลัง 
 การปรับแต่งหน้ากระดาษของหนังสือ 
 เลือกเมนู  Options-&gt; Set Book Option-&gt;  เลือกรายการ Page Background 
 Page Background เป็นการก าหนดรูปแบบให้กับพื้นหลังของหน้ากระดาษที่อยู่ภายใน 
หน้าหนังสือทั้งหมด ซึ่งจะแตกต่างจากค าสั่ง Page Properties ที่จะมีผลเฉพาะหน้าที่เลือกเท่านั้น 
โดยสามารถเลือกว่า จะปรับแต่งที่หน้ากระดาษที่อยู่ด้านซ้ายทั้งหมด (Left Page), หน้ากระดาษ 
ที่อยู่ด้านขวาทั้งหมด Right Page) หรือเฉพาะหน้ากระดาษที่มีสองหน้าติดกัน (Centerfold Page)  
จากนั้นสามารถเลือกว่า จะใช้สีเป็นพื้นหลัง (Color) หรือใช้รูปภาพ (Texture) เป็นพื้นหลัง 
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หน่วยท่ี 5 การสร้างแผ่นซีดีเพื่อเผยแพร่ผลงาน 
 การบันทึกหนังสือที่สร้าง/ แก้ไขเรียบร้อยแล้ว 
 1.  คลิกที่เมนู File เลือกค าสั่ง Save As 
 2.  เลือกต าแหน่งที่ใช้ในการเก็บข้อมูลในช่อง Save As 
 3.  พิมพ์ชื่อไฟล์ลงไปในช่อง File Name  
 4.  คลิกที่ปุ่ม Save เพื่อบันทึก  
  - ค าสั่ง Save As ใช้ในกรณีที่บันทึกไฟล์ใหม่ 
  - ค าสั่ง Save ใช้ในกรณีที่บันทึกทับไฟล์เดิม 
 หลังจากที่บันทึกไฟล์จากโปรแกรม Flip Album 6.0 Pro 
 จะปรากฏไฟล์ข้อมูล 1 ไฟล์ (นามสกุล opf) และโฟลเดอร์ที่จัดเก็บวัตถุต่าง ๆ  
ที่ใช้ในหนังสือ อีก 1 โฟลเดอร์ (ชื่อไฟล์ opf files) ซึ่งหากผู้สร้างต้องการย้าย/ คัดลอกไฟล ์
ไปท างานในที่อ่ืน ๆ ต้องน า ไฟล์ข้อมูลและโฟลเดอร์ไปด้วยกัน 
 การเปิดหนังสือที่เคยบันทึกไว้มาแก้ไข  
 1.  คลิกที่เมนู File-&gt; Open Book 
 2.  คลิกเลือกปุ่ม Browse เพือ่ค้นหาต าแหน่งที่เก็บหนังสือ 
 3.  เลือกต าแหน่งที่บันทึกหนังสือในช่อง Look in: 
 4.  Double Click เลือกไฟล์หนังสือที่ต้องการเปิด 
 การสร้างแผ่นซีดีเพื่อน าเสนอข้อมูล (CD Maker) 
 1.  ตรวจสอบความถูกต้องและบันทึกไฟล์ข้อมูลให้เรียบร้อยก่อน (เลือกเมนู File-&gt; 
Save) 
 2.  เลือกเมนู CD Maker แล้วเลือกค าสั่ง Create Album CD จะปรากฏ หน้าต่าง Create 
Album CD ดังรูปด้านล่าง 
 3.  คลิกเลือก Create a New Album CD และเลือกการสร้างแบบ Single Album on CD  
เป็นการสร้างชุดน าเสนอ 1 แผ่นซีดี ต่อหนังสืออิเล็กทรอนิกส์ 1 เร่ือง คลิกที่ปุ่ม OK จะปรากฏ
หน้าต่างดังรูปด้านล่าง 
 4.  เลือกแหล่งเก็บข้อมูล  
 5.  ตั้งชื่อโฟลเดอร์ หรือชื่อห้องส าหรับเก็บชุดน าเสนอในช่อง Album CD Folder Name 
(ซึ่งโดยปกติ โปรแกรม จะตั้งชื่อว่า Album CD ทั้งนี้จะท าการแก้ไข หรือไม่ก็ได้แต่ข้อส าคัญจะต้อง
จ าชื่อโฟลเดอร์และแหล่งเก็บข้อมูลให้ได้ว่าอยู่ ณ ต าแหน่งใด) 
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 6.  คลิกที่ปุ่ม Create จากนั้นโปรแกรมจะท าการคัดลอกไฟล์ข้อมูล และจัดเตรียมระบบ 
จะปรากฏหน้าต่าง Album CD Options Menu 
 7.  คลิกเลือกเมนู Set Album Options จะปรากฏหน้าต่าง Set Album CD Options 
 8.  ในรายการ Setting ให้คลิก  þ ในช่อง Start with no window frame เพื่อก าหนดว่าให้ 
แสดงหนังสืออิเล็กทรอนิกส์ โดยไม่ปรากฏกรอบหน้าต่างใด ๆ และ User will be allowed to switch 
to window frame mode เพื่อก าหนดว่า ผู้ใช้สามารถ คลิกปุ่มที่ย่อ/ขยาย ปิดหน้าต่างได้เท่านั้น เมื่อ
ก าหนด เรียบร้อยแล้วให้คลิกที่ปุ่ม OK -- &gt; Next 
 9.  จะปรากฏหน้าต่าง Burn CD Informationในส่วนน้ี หากเคร่ืองคอมพิวเตอร์นั้นติดต้ัง
ซีดีรอมแบบเขียนข้อมูลได้ให้ใส่แผ่นซีดีเปล่าแล้วคลิกเลือกที่ปุ่ม Burn To CD เพื่อเขียนหรือบันทึก
ข้อมูลลงแผ่นซีดี ได้โดยทันที แต่ถ้าหากต้องการเขียนหรือบันทึกข้อมูลลงแผ่นซีดี ในภายหลัง  
ให้คลิกที่ปุ่ม OK 
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แบบทดสอบวัดผลสัมฤทธิ์ 
 

1. ข้อใดให้ความหมายของหนังสืออิเล็กทรอนิกส์ได้ถูกต้องที่สุด 
a. หนังสือที่สร้างด้วยโปรแกรมคอมพิวเตอร์และเปิดอ่านได้เหมือนหนังสือจริง 
b. หนังสือที่ประกอบไปด้วยข้อความ ภาพและเสียง 
c. หนังสือที่สามารถสั่งพิมพ์ทางเคร่ืองพิมพ์ได้ 
d. หนังสือที่สามารถเปิดอ่านได้ในเคร่ืองคอมพิวเตอร์ 

2. e-Book ย่อมาจากค าในภาษาอังกฤษในข้อใด 
a. Electronic Book 
b. Electron Book 
c. E learning Book 
d. Electrolux Book 

3. ข้อใดเป็นความสามารถของหนังสืออิเล็กทรอนิกส์ที่มีเหมือนกับหนังสือจริง 
a. น าเสนอข้อมูลแบบข้อความและรูปภาพได้ 
b. น าเสนอข้อมูลภาพเคลื่อนไหว หรือภาพวิดีโอได้ 
c. น าเสนอการเชื่อมโยงไปยังข้อมูลหน้าอื่น ๆ ได้ 
d. น าเสนอข้อมูลเสียงได้ 

4. ซอฟต์แวร์ Reader จะเกี่ยวข้องกับหนังสืออิเล็กทรอนิกส์อย่างไร 
a. ซอฟต์แวร์ส าหรับการออกแบบ 
b. ซอฟต์แวร์ส าหรับการเขียน 
c. ซอฟต์แวร์ส าหรับการอ่าน 
d. ซอฟต์แวร์ส าหรับการถอดรหัส 

5. ข้อใดเป็นการเตรียมงานเบื้องต้นก่อนการสร้างหนังสืออิเล็กทรอนิกส์ 
a. เตรียมไฟล์ประกอบโดยตั้งชื่อเป็นภาษาอังกฤษหรือผสมตัวเลขและห้ามเว้นวรรค 
b. ก าหนดการเชื่อมโยงเพื่อไม่ให้มีปัญหาในการน าเสนอผ่านเว็บไซต์ 
c. ย่อไฟล์ภาพให้มีขนาดเหมาะสมก่อนน าไปใช้งาน 
d. สร้างโฟลเดอร์ส าหรับหนังสืออิเล็กเล็กทรอนิกส์ 1 โฟลเดอร์ ต่อ หนังสือ 1 เล่ม 
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6. ข้อใดเป็นขั้นตอนการออกแบบก่อนการสร้างหนังสืออิเล็กทรอนิกส์ 
a. ย่อไฟล์ภาพให้มีขนาดเหมาะสมก่อนน าไปใช้งาน 
b. ก าหนดการเชื่อมโยงเพื่อไม่ให้มีปัญหาในการน าเสนอผ่านเว็บไซต์ 
c. เตรียมไฟล์ประกอบโดยตั้งชื่อเป็นภาษาอังกฤษหรือผสมตัวเลขและห้ามเว้นวรรค 
d. สร้างโฟลเดอร์ส าหรับหนังสืออิเล็กเล็กทรอนิกส์ 

7. โปรแกรมจะแสดงชื่อหนังสือที่สร้างขึ้นที่ส่วนใด 
a. แถบหัวเร่ือง 
b. แถบสถานะ 
c. แถบเมนู 
d. แถบเคร่ืองมือ 

8. การสร้างหนังสือเล่มใหม่ ต้องคลิกค าสั่งใด 
a. New 
b. Edit 
c. Save 
d. Open 

9. ถ้าต้องการเพิ่มหน้ากระดาษ ต้องคลิกปุ่มใด 
a. New page 
b. Insert page 
c. Copy page 
d. Delete page 

10. ถ้าต้องการลบหน้ากระดาษ ต้องคลิกปุ่มใด 
a. New page 
b. Delete page 
c. Insert page 
d. Copy page 

11. การใส่สีให้กับหน้ากระดาษมีขั้นตอนอย่างไร 
a. Edit > Muti Media Object 
b. Edit > Insert page 
c. Edit > Insert Clip Art 
d. Edit > Page Properties 
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12. ข้อใดคือขั้นตอนการใส่ภาพกราฟิก 
a. Edit > Page Properties 
b. Edit > Insert page 
c. Edit > Insert Clip Art 
d. Edit > Muti Media Object 

13. ข้อใดคือขั้นตอนการใส่เสียง 
a. Edit > Muti Media Object 
b. Edit > Page Properties 
c. Edit > Insert Clip Art 
d. Edit > Insert page 

14. ข้อใดให้ความหมายของค าว่ามัลติมิเดียได้ถูกต้อง 
a. มัลติมีเดียเป็นการน าองค์ประกอบต่าง ๆ เช่น ตัวอักษร รูปภาพ เสียง ภาพเคลื่อนไหว  
    เข้าด้วยกัน 
b. มัลติมีเดียหมายถึงโปรแกรมหนังสืออิเล็กทรอนิกส์เท่านั้น 
c. มัลติเดียเป็นสื่อที่ใช้ในการน าเสนอผลงานในรูปแบบต่าง ๆ  
d. ถูกทุกข้อ 

15. การแทรกไฟล์วิดีโอลงในหนังสืออิเล็กทรอนิกส์ ต้องปฏิบัติตามข้อใด 
a. Insert > Clip Art 
b. Insert > Muti Media Object 
c. Insert > Bookmarks 
d. Insert > Anotations 

16. ข้อใดคือค าสั่งการจัดท าปกแบบเข้าห่วง 
a. Set Book Options 
b. Page Porperties 
c. Set Theme 
d. Book Binder 
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17. Centerfold Page คือค าสั่งใด 
a. การสร้างหน้ากระดาษ 
b. การลบหน้ากระดาษ 
c. การแทรกภาพเคลื่อนไหว 
d. การสร้างหนังสือแบบหน้าคู่ 

18. Customize Contents คือค าสั่งใด 
a. การตกแต่งหน้าสารบัญ 
b. การใส่สีให้สารบัญ 
c. การเปลี่ยน Contents เป็นภาษาไทย 
d. การสร้างหน้าสารบัญ 

19. ข้อความที่สร้างลิ้งค์เชื่อมโยงแล้ว เมื่อใช้ค าสั่งเพื่อดูผลงานจะมีลักษณะอย่างไร 
a. มีเส้นใต้ข้อความ 
b. มีกรอบสามเหลี่ยมยุบลง 
c. มีกรอบสี่เหลี่ยมนูนขึ้นมา 
d. มีกรอบสี่เหลี่ยมยุบลง 

20. ค าสั่งใดที่ใช้ออกแบบปกหนังสืออัตโนมัติ 
a. Book Binder 
b. Page Porperties 
c. Set Book Options 
d. Set Theme 

21. ข้อใดคือค าสั่งในการพิมพ์ข้อความ 
a. Insert > Clip Art 
b. Insert > Anotations 
c. Insert > Muti Media Object 
d. Insert > Bookmarks 

22. แฟ้มเสียงที่สามารถน ามาใช้ประกอบหนังสืออิเล็กทรอนิกส์ได้แก่แฟ้มนามสกุลใด 
a. wma 
b. ถูกทุกข้อ 
c. wav 
d. mp3 
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23. การน าแฟ้มงานขึ้นไปไว้บนเคร่ืองแม่ข่ายหรือเซิร์ฟเวอร์เรียกกว่าอะไร 
a. Upload 
b. Download 
c. Package 
d. Publish 

24. เมื่อสร้างหนังสือเสร็จแล้วต้องบันทึกหนังสือด้วยค าสั่งใด 
a. CD Maker > Create Album CD 
b. CD Maker > Export Album TV Viewing 
c. File > Save As 
d. Customize Contents 

25. การบันทึกหนังสืออิเล็กทรอนิกส์เพื่อเล่นกับเคร่ืองเล่น DVD 
a. File > Save As 
b. CD Maker > Create Album CD 
c. Customize Contents 
d. CD Maker > Export Album TV Viewing 

 
 
 
เฉลย 
1.  D 6.  D 11.  A 16.  D 21.  A 
2.  A 7.  A 12.  D 17.  D 22.  B 
3.  C 8.  A 13.  A 18.  C 23.  A 
4.  C 9.  B 14.  C 19.  A 24.  C 
5.   D 10.  B 15.   B 20.   C 25.   B 
 
 
 
 
 
 




